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TV Tour
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Ultra HD TV

This TV has an Ultra HD display. Its resolution is four
times as much as normal HD displays. Ultra HD
means 8 million pixels for the most refined and lifelike
picture on TV.

On top, the new Ultra Pixel HD Engine continuously
converts any incoming TV signal into Ultra HD
resolution. SO you can enjoy this stunning picture
quality the moment you switch on the TV. Or you can
watch native Ultra HD videos through an HDMI
connection. Ultra HD offers TV viewing that is crisp
and sharp even on a big screen.
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Philips Android TV™

This a Philips Android TV™ with UHD.

Android TV offers thousands of movies, shows and
games from Google Play, YouTube and your favourite
apps.*

Personalised recommendations mean more time
being entertained and less time hunting for
something good. With Google Cast built in, you can
easily cast movies, shows and photos from your
Chromebook or Android device to your TV.**

With the Philips TV Remote App on your
smartphone or tablet, you have your TV channels at
your fingertips. Send a photo to the large TV screen or
follow your favourite cooking show on your tablet in
the kitchen. From now on your TV is part of your
mobile household.

Connect the TV to your home network and the
Internet.

* The TV must be connected to the
Internet. Subscriptions might be required for certain
content providers.

** Casting optimized for selected services only.
Streaming quality for other content might vary.
Supported operating systems and devices: Android
2.3 and higher, i0S® 7 and higher, Windows® 7 and
higher, Mac OS® 10.7 and higher and Chrome OS
(version 38 or higher).

Google, Android, Google Play and other marks are
trademarks of Google Inc. The Android robot is
reproduced or modified from work created and
shared by Google and used according to terms
described in the Creative Commons 3.0 Attribution
License.

http.//creativecommons.org/licenses/by/3.0/legalco
de
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Using Apps

To get you started, some practical Apps are pre-
installed on your TV.

The Apps pages show the collection of Apps
(Applications) on your TV. Like Apps on your
smartphone or tablet, the Apps on your TV offer
specific functions for an enriched TV experience.
Apps like TV games or weather forecasts (a.0.). Or
start an Internet Browser App to surf the Internet.

For more information, press == Keywords and look
up Apps.
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Playing Games

This TV is your big screen for gaming. Big enough for
two.

You can play a game from a connected Game
Console, a game from an installed App or simply an
online game on a website. You can set the TV to the
ideal settings for gaming, to allow quick and
responsive action. If you play a multi-player game
with split screens, you can set the TV to show each
screen as a full screen simultaneously. Each player
can focus on his own game to play.

15
Movies and missed

programmes

To get a rental video, you don't need to leave the
house.

Open Video on Demand and get that latest movie
streamed to your TV directly. Open the video store
App, create your personal account, select the movie
and press play.

Video on Demand is available in selected countries.

For more information, press == Keywords and look
up Video on Demand.


http://creativecommons.org/licenses/by/3.0/legalcode
http://creativecommons.org/licenses/by/3.0/legalcode
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Pause TV and Recordings

If you connecta USB Hard Drive, you can pause and
record a broadcast from a digital TV channel.

Pause your TV and answer that urgent phone call or
simply take a break during a sports match, while the
TV stores the broadcast on the USB Hard Drive. You
can watch it again later.

With a USB Hard Drive connected, you can also
record digital broadcasts. You can record while you
are watching a programme or schedule a recording of
an upcoming programme.

1.7
Social Networks

No need to get up to check your friend's messages on
your computer.

On this TV you get the messages from your social
network on your TV screen. You can send a return
message from your couch.

1.8

3D

Yournew TVisa 3D TV.

Enjoy the immersive experience of watching a movie
in 3D. Play a movie in 3D on your Blu-ray Player or
rent a 3D movie from a Video Store from the Home
menu, Video on Demand.

The TV uses the Active 3D technology to watch 3D in
its full resolution.

1.9

Ambilight

Ambilight is the most elegant and exclusive feature
of your new Philips TV.

A subtle glow of coloured light that shines from
behind the screen - expanding your visual
experience. With Ambilight your eyes relax but your
mind is fully taken up by what you see.

With Ambilight+hue you even expand Ambilight
further. Bringing in the wireless controlled bulbs
of Philips Hue*. All of them setup to fill your room
with colours that fit what's on TV.

You will miss Ambilight when you switch it off.

* Separately available.

110

Ambilight + Hue

Your Ambilight TV

Philips' unigue Ambilight technology goes beyond
the ordinary. It not only makes your screen seem
much wider, it also makes your viewing experience
more immersive by projecting an extra-wide glow
from the sides of your TV screen onto the surrounding
wall. Colour, vibrancy and excitement move beyond
the screen and into your living room, bringing with
them a more thrilling, intense and immersive viewing
experience.

Ambilight + Hue

Fill your space and your life with the wonder of
Ambilight. Ambilight + hue* allows you to extend the
Ambilight experience throughout your room.

With Ambilight+hue you even expand Ambilight
further. Bringing in the wireless controlled bulbs
of Philips Hue*. All of them setup to fill your room
with colours that fit what's on TV.

Your Ambilight TV and hue bulbs ‘talk’ wirelessly to
each other, surrounding you in the emotion, power
and colour of Ambilight.

*Hue kit available separately.



Setting Up

2.1

Read Safety

Read the safety instructions first before you use the
TV.

To read the instructions, press the colour

key == Keywords and look up Safety instructions.

2.2

TV Stand and Wall Mounting

TV Stand

You can find the instructions for mounting the TV

stand in the Quick Start Guide that came with the TV.

In case you lost this guide, you can download it
from www.philips.com.

Use the product type number of the TV to look for
the Quick Start Guide to download.

Wall Mounting

Your TV is also prepared for a VESA-compliant wall
mount bracket (sold separately).
Use the following VESA code when purchasing the

wall mount . ..

- 43PUx7100, 43PUx7150

VESA MIS-F 300x200, M6

- 49PUx7100, 49PUx7150, 49PUx7170, 49PUx7180
VESA MIS-F 300x300, M6

- 55PUx7100, 55PUx7150, 55PUx7170, 55PUx7180
VESA MIS-F 300x300, M6

- 65PUx7120

VESA MIS-F 400x400, M6

Preparation

First remove the 4 plastic screw caps out of the
threaded bushes on the back of the TV.

Make sure that the metal screws, to mount the TV to

the VESA-compliant bracket, go about 10mm deep
inside the threaded bushes of the TV.

Caution

Wall mounting the TV requires special skills and
should only be performed by qualified personnel. The
TV wall mounting should meet safety standards
according to the TVs weight. Also read the safety
precautions before positioning the TV.

TP Vision Europe B.V. bears no responsibility for
improper mounting or any mounting that results in
accident or injury.
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Tips on Placement

- Position the TV where light does not shine directly
on the screen.

- Dim lighting conditions in the room for best
Ambilight effect.

- Position the TV up to 15 cm away from the wall.

- The ideal distance to watch TV is 3 times its diagonal
screen size. When seated, your eyes should be level
with the centre of the screen.

I max. 15 cm

2.4
Power Cable

- Insert the power cable into the POWER connector
on the back of the TV.

- Make sure the power cable is securely inserted in
the connector.

- Make sure that the power plug, in the wall socket, is
accessible at all times.

- When you unplug the power cable, always pull the
plug, never pull the cable.

r T
)

Although this TV has a very low standby power
consumption, unplug the power cable to save energy
if you do not use the TV for a long period of time.

Press the colour key == Keywords and look
up Switching On for more information on switching
the TV on or off.


http://www.philips.com
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Antenna Cable

Insert the antenna plug firmly into
the Antenna socket at the back of the TV.

You can connect your own antenna or an antenna
signal from an antenna distribution system. Use an
|[EC Coax 75 Ohm RF antenna connector.

Use this antenna connection for DVB-T and DVB-C
input signals.

~a s B

J
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Satellite Dish

Attach the satellite F-type connector to the satellite
connection SAT at the back of the TV.

~a&: i

-
~—




3

Network

3.1
Smart TV and Internet

No Smart TV without the Internet.

This Smart TV is no smart TV without being connected
to your home network and the Internet. We
recommend to connect to the Internet the moment
you start using your new Smart TV. Benefits are
countless.

You can connect your TV wirelessly or wired to your
network router.

3.2
Connect to Network

Wireless Connection

What You Need

To connect the TV to the Internet wirelessly, you need
a Wi-Fi router with a connection to the Internet.

Use a high-speed (broadband) connection to the

A4

Internet.

Bl

Make the Connection

Wireless

To make a wireless connection...

1- Press %, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> Connectto

Network and press OK.

4 - Select Wireless and press OK.

5 - Inthe list of found networks, select on your
wireless network. If your network is not in the list
because the network name is hidden (you switched
off the SSID broadcast of the router), select Add New
Network to enter the network name yourself.

6 - Depending on the type of router, enter your
encryption key - WEP, WPA or WPA2. If you entered
the encryption key for this network before, you can
select OK to make the connection immediately.

7 - A message will be shown when the connection is
successful.

WPS

If your router has WPS, you can directly connect to
the router without scanning for networks. If you have
devices in your wireless network that use the WEP
security encryption system, you cannot use WPS.

1- Press {%, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> Connectto

Network and press OK.

4 - Select WPS then press OK.

5 - Go to the router, press the WPS button and return
to the TV within 2 minutes.

6 - Select Connect to make the connection.

7 - A message will be shown when the connection is
successful.

WPS with PIN Code

If your router has WPS with a PIN code, you can
directly connect to the router without scanning for
networks. If you have devices in your wireless
network that use the WEP security encryption system,
you cannot use WPS.

1- Press {%, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> Connectto

Network and press OK.

4 - Select WPS with PIN code and press OK.

5 - Write down the 8-digit PIN code shown on
screen and enter it in the router software on your PC.
Consult the router manual on where to enter the PIN
code in the router software.

6 - Select Connect to make the connection.

7 - A message will be shown when the connection is
successful.

Problems

Wireless network not found or distorted

- Microwave ovens, DECT phones or other Wi-Fi
802.11b/g/n devices in your proximity might disturb
the wireless network.

- Make sure that the firewalls in your network allow
access to the TV's wireless connection.

- If the wireless network does not work properly in
your home, try the wired network installation.



Internet does not work
- If the connection to the router is OK, check the
router connection to the Internet.

The PC and Internet connection are slow

- Look in your wireless router's user manual for
information on indoor range, transfer rate and other
factors of signal quality.

- Use a high-speed (broadband) Internet connection
for your router.

DHCP

- If the connection fails, you can check the DHCP
(Dynamic Host Configuration Protocol) setting of the
router. DHCP should be switched on.

Wired Connection

What You Need

To connect the TV to the Internet, you need a
network router with a connection to the

Internet. Use a high-speed (broadband) connection
to the Internet.

—
—
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Make the Connection

To make a wired connection...

1- Connect the router to the TV with a network cable
(Ethernet cable**).

2 - Make sure that the router is switched on.

3 - Press {%, select All Settings and press OK.

4 - Select Wireless and Networks and

press p (right) to enter the menu.

5 - Select Wired or Wi-Fi> Connectto

Network and press OK.

6 - Select Wired and press OK. The TV constantly
searches for the network connection.

7 - A message will be shown when the connection is
successful.

If the connection fails, you can check the DHCP
setting of the router. DHCP should be switched on.

**To fulfill EMC regulations, use a shielded FTP Cat.
5E Ethernet cable.
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Network Settings

View Network Settings

You can view all current network settings here. The
IP and MAC address, signal strength, speed,
encryption method, etc.

To view the current network settings...

1- Press ¢, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> View Network
Settings OK.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Network Configuration

If you are an advanced user and want to install your
network with Static IP addressing, set the TV to Static
IP.

To set the TV to Static IP...

1- Press £, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> Network
Configuration and press OK.

4 - Select Static IP and press OK to enable Static
IP Configuration.

5- Select Static IP Configuration and configure the
connection.

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

Switch on with network

You can switch this TV on from your smartphone or
tablet if the TV is in Standby. The setting Switch On
with Wi-Fi (WoWLAN) must be switched on.

To switch on WoWLAN...

1- Press £, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi > Switch On with Wi-Fi
(WoWLAN) and press OK.

4 - Select Onand press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.



Switch on Wi-Fi connection

You can switch on or off Wi-Fi connection on your
TV.

To switch on Wi-Fi..

1- Press %, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> Wi-Fi On/Off and
press OK.

4 - Select On and press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Digital Media Renderer - DMR

If your media files do not play on your TV, make sure
that the Digitial Media Renderer is switched on. As a
factory setting, DMR is switched on.

To switch on DMR...

1- Press %, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> Digital Media Renderer
- DMR and press OK.

4 - Select Onand press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Wi-Fi Smart Screen

To watch digital TV channels on your smartphone or
tablet with the Philips TV Remote App, you must
switch on Wi-Fi Smart Screen. Some scrambled
channels might not be available on your mobile
device.

To switch on Wi-Fi Smart Screen...

1- Press {%, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi > Wi-Fi Smart

Screen and press OK.

4 - Select Onand press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.
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TV Network Name

If you have more than one TV in your home network,
you can give the TV a unigue name.

To change the TV name..

1- Press £, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> TV Network Name and
press OK.

4 - Enter the name with the on-screen keyboard or
the remote control keyboard (if available).

5 - Select + to confirm the change.

6 - Press ( (left) repeatedly if necessary, to close
the menu.

Clear Internet Memory

With Clear Internet Memory you clear all Internet files
stored on your TV. You clear your Philips Smart TV
registration and parental rating settings, your video
store app logins, all Smart TV app favourites, Internet
bookmarks and history. Interactive MHEG
applications can also save so-called 'cookies’, on
your TV. These files will also be cleared.

To clear the Internet memory...

1- Press {¢, select All Settings and press OK.

2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Wired or Wi-Fi> Clear Internet
Memory and press OK.

4 - Select OK to confirm.

5- Press 4 (left) repeatedly if necessary, to close
the menu.
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Network Devices

The TV can connect to other devices in your wireless
network, like your computer or smartphone. You can
use a computer with Microsoft Windows or Apple OS
X.

35

File Sharing

On this TV, you can open photos, music and videos
stored on your computer.
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Connections

41
Tips on Connections

Connectivity Guide

Always connect a device to the TV with the highest
quality connection available. Also, use good quality
cables to ensure a good transfer of picture and
sound.

When you connect a device, the TV recognizes its
type and gives each device a correct type name. You
can change the type name if you wish. If a correct
type name for a device is set, the TV automatically
switches to the ideal TV settings when you switch to
this device in the Sources menu.

If you need help to connect several devices to the TV,
you can visit the Philips TV connectivity guide. The
guide offers information on how to connect and
which cables to use.

Go to www.connectivityguide.philips.com

Antenna port

If you have a Set-top box (a digital receiver) or
Recorder, connect the antenna cables to run the
antenna signal through the Set-top box and/or
Recorder first before it enters the TV. In this way, the
antenna and the Set-top box can send possible
additional channels to the Recorder to record.

i Digital Receiver Recorder
E s
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than 5 m.

5 DEFINITION MAULTIMEOLA INTERFACE

Copy protection

HDMI cables support HDCP (High-bandwidth Digital
Content Protection). HDCP is a copy protection signal
that prevents copying content from a DVD disc or Blu-
ray Disc. Also referred to as DRM (Digital Rights
Management).

HDMI ARC

All of the HDMI connections on the TV have HDMI
ARC (Audio Return Channel).

If the device, typically a Home Theatre System (HTS),
also has the HDMI ARC connection, connect it to any
of the HDMI connections on this TV. With the HDMI
ARC connection, you do not need to connect the
extra audio cable that sends the sound of the TV
picture to the HTS. The HDMI ARC connection
combines both signals.

You can use any HDMI connection on this TV to
connect the HTS but ARC is only available for 1
device/connection at a time.

HDMI Ultra HD

You can watch videos filmed or made in 'native’ Ultra
HD resolution - 3840x2160 pixels - on this TV.

Connect a Blu-ray Disc player, game console or
computer that plays Ultra HD videos to one of
HDMI connections. Use a High speed HDMI cable to
connect. The HDMI UHD connections have ARC
(Audio Return Channel).

HDMI CEC - EasyLink

HDMI ports

HDMI Quality

An HDMI connection has the best picture and sound
quality. One HDMI cable combines video and audio
signals. Use an HDMI cable for High Definition (HD) or
Ultra HD (UHD) TV signals.

For best signal quality transfer, use a High speed
HDMI cable and do not use an HDMI cable longer

11

EasyLink

An HDMI connection has the best picture and sound
quality. One HDMI cable combines video and audio
signals. Use an HDMI cable for High Definition (HD) or
Ultra HD (UHD) TV signals. For best signal quality
transfer, use a High speed HDMI cable and do not use
an HDMI cable longer than 5 m.
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EasyLink HDMI CEC

If your devices are connected with HDMI and have
Easylink, you can operate them with the TV remote
control. EasyLink HDMI CEC must be switched On on
the TV and the connected device.

With EasyLink you can operate a connected device
with the TV remote control. EasyLink uses HDMI CEC
(Consumer Electronics Control) to communicate with
the connected devices. Devices must support HDMI
CEC and must be connected with an HDMI
connection.

EasyLink setup

The TV comes with EasyLink switched on. Make sure
that all HDMI CEC settings are properly set up on the
connected EasyLink devices. EasyLink might not work
with devices from other brands.

HDMI CEC on other brands

The HDMI CEC functionality has different names on
different brands. Some examples are: Anynet, Aquos
Link, Bravia Theatre Sync, Kuro Link, Simplink and
Viera Link. Not all brands are fully compatible with
EasyLink.

Example HDMI CEC branding names are property of
their respective owners.

For more information on using EasyLink, press the
colour key == Keywords and look up EasyLink
HDMI CEC.

Operate Devices

To operate a device connected to HDMI and set up
with EasyLink, select the device or its activity in the
list of TV connections. Press == SOURCES |, select a
device connected to an HDMI connection and

press OK.

Once the device is selected, the TV remote control
can control the device. However the

keys @ HOME and == OPTIONS and some other
TV keys, like @ Ambilight , are not forwarded to the
device.

If the key you need is not on the TV remote control,
you can select the key in the Options menu.

Press == OPTIONS and select Controls in the
menu bar. On the screen, select the device key you
need and press OK.
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Some very specific device keys might not be available
in the Controls menu.

Only devices that support EasylLink Remote
Control function will respond to the TV remote
control.

EasyLink Settings

The TV comes with the Easylink settings switched
on.

EasyLink
To switch off EasyLink completely..

1- Press ¢, select All Settings and press OK.

2 - Select TV Settings and press p (right) to enter
the menu.

3 - Select Easylink, press p (right) and

select EasyLink one step further.

4 - Select Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

EasyLink Remote Control

If you want devices to communicate but you don't
want to operate them with the TV remote control, you
can switch off EasyLink remote control separately.

In the EasyLink settings menu, select EasyLink
Remote Control and select Off.

DVI to HDMI

If you still own a device that only has a DVI
connection, you can connect the device to any of
the HDMI connection with a DVI to HDMI adapter.

Use a DVI to HDMI adapter if your device only has a
DVI connection. Use one of the HDMI connections
and add an Audio L/R cable (mini-jack 3.5mm) to
Audio In for sound, on the back of the TV.

AUDIO L/R

-
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Copy protection

DVI and HDMI cables support HDCP (High-bandwidth
Digital Content Protection). HDCP is a copy protection
signal that prevents copying content from a DVD disc
or Blu-ray Disc. Also referred to as DRM (Digital
Rights Management).

Y Pb Pr - Component

Y Pb Pr - Component Video is a high quality
connection.

The YPbPr connection can be used for High Definition
(HD) TV signals. Next to the Y, Pb and Pr signals add
the Audio Left and Right signals for sound.

Match the YPbPr (green, blue, red) connector colours
with the cable plugs when you connect.

Use an Audio L/R cinch cable if your device also has
sound.

VOO OO

vuw vy
AUDIO L/R

SCART

SCART is a good quality connection.

The SCART connection can be used for CVBS and
RGB video signals but cannot be used for High
Definition (HD) TV signals. The SCART connection
combines video and audio signals. The SCART
connection also supports NTSC playback.

=
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Audio Out - Optical

Audio Out - Optical is a high quality sound
connection.

This optical connection can carry 5.1 audio channels.
If your device, typically a Home Theatre System
(HTS), has no HDMI ARC connection, you can use this
connection with the Audio In - Optical connection on
the HTS. The Audio Out - Optical connection sends
the sound from the TV to the HTS.

You can set the type of the audio out signal to fit the
audio capabilities of your Home Theatre System.
For more information, press == Keywords and look
up Audio Out Settings.

If the sound does not match the video on screen, you
can adjust the audio to video synchronisation.

For more information, press == Keywords and look
up Audio to Video Sync.

=

4.2

Cl+ CAM with Smart Card

Cl+

This TV is ready for the Cl+ Conditional Access.

With Cl+ you can watch premium HD programmes,
like movies and sports, offered by digital TV operators
in your region. These programmes are scrambled by
the TV operator and descrambled with a prepaid Cl+
module.

Digital TV operators provide a Cl+ module
(Conditional Access Module - CAM) and an
accompanying smart card, when you subscribe to
their premium programmes. These programmes have
a high level of copy protection.

Contact a digital TV operator for more information on
terms & conditions.

Ci+




One Smart Card

Digital TV operators provide a Cl+ module
(Conditional Access Module - CAM) and an
accompanying smart card, when you subscribe to
their premium programmes.

Insert the smart card into the CAM module. See the
instruction you received from the operator.

To insert the CAM in the TV...

1- Look on the CAM for the correct method of
insertion. Incorrect insertion can damage the CAM
and TV.

2 - While looking at the back of the TV, with the front
of the CAM facing towards you, gently insert the CAM
into the slot COMMON INTERFACE.

3 - Push the CAMin as far as it will go. Leave it in the
slot permanently.

When you switch on the TV, it may take a few minutes
before the CAM is activated. If a CAM is inserted and
subscription fees are paid (subscription methods can
differ), you can watch the scrambled channels
supported by the CAM smart card.

The CAM and smart card are exclusively for your TV. If
you remove the CAM, you will no longer be able to
watch the scrambled channels supported by the

CAM.
) E

COMMON INTERFACE

Passwords or PIN codes

For some CAMs, you must enter a PIN code to watch
its channels. When you set the PIN code for the CAM,
we recommend you to use the same code you are
using to unlock the TV.

To set the PIN code for the CAM...

1- Press == SOURCES .

2 - Select the channel type you are using the CAM
for.

3 - Press == OPTIONS and select Common
Interface.

4 - Select the TV operator of the CAM. The following
screens come from the TV operator. Follow the on-
screen instruction to look up the PIN code setting.
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Receiver - Set-Top Box

Cable Box

Use 2 antenna cables to connect the antenna to the
Set-top box (a digital receiver) and the TV.

Digital Receiver
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Next to the antenna connections, add an HDMI cable
to connect the Set-top box to the TV.

Alternatively, you can use a SCART cable if the Set-
top box has no HDMI connection.

~a o B

Digital Receiver
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Switch off this automatic timer, if you only use the
remote control of the Set-top box. Switch this timer
off to prevent the TV from switching off automatically
after a 4 hour period without a key press on the
remote control of the TV.

Switch Off Timer

In Help, press the colour key == Keywords and
look up Switch Off Timer for more information.

Satellite Tuner

Connect the dish antenna cable to the Satellite
receiver.

Next to the antenna connection, add an HDMI cable
to connect the device to the TV.

Alternatively, you can use a SCART cable if the device
has no HDMI connection.



Satellite Receiver
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Switch off this automatic timer, if you only use the
remote control of the Set-top box. Switch this timer
off to prevent the TV from switching off automatically
after a 4 hour period without a key press on the
remote control of the TV.

Switch Off Timer

In Help, press the colour key «= Keywords and
look up Switch Off Timer for more information.

4.4

Home Theatre System - HTS

Connect with HDMI ARC

Use an HDMI cable to connect a Home Theatre
System (HTS) to the TV. You can connect a Philips
Soundbar or an HTS with a built-in disc player.

HDMI ARC

If your Home Theatre System has an HDMI ARC
connection, you can use any HDMI connection on the
TV to connect. With HDMI ARC, you do not need to
connect the extra audio cable. The HDMI ARC
connection combines both signals.

All HDMI connections on the TV can offer the Audio
Return Channel (ARC) signal. But once you have
connected the Home Theatre System, the TV can
only send the ARC signal to this HDMI connection.

Home Theatre System

oM ]

—

Audio to video synchronisation (sync)

If the sound does not match the video on screen, you
can set a delay on most Home Theatre Systems with
a disc player to match the sound with the video.

For more information, press the colour
key «= Keywords and look up Audio to Video
Sync.
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Connect with HDMI

Use an HDMI cable to connect a Home Theatre
System (HTS) to the TV. You can connect a Philips
Soundbar or an HTS with a built-in disc player.

If the Home Theatre System has no HDMI ARC
connection, add an optical audio cable (Toslink) to
send the sound of the TV picture to the Home Theatre
System.

AUDIO OUT

HDMI

Home Theatre System
- . ]

— —
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Audio to video synchronisation (sync)

If the sound does not match the video on screen, you
can set a delay on most Home Theatre Systems with
a disc player to match the sound with the video.

For more information, press the colour
key == Keywords and look up Audio to Video
Sync.

Audio Out Settings

Audio Out Format

If you have a Home Theatre System (HTS)

with multichannel sound processing capabilities like
Dolby Digital, DTS® or similar, set the Audio Out
Format to Multichannel. With Multichannel, the TV
can send the compressed multichannel sound signal
from a TV channel or connected player to the Home
Theatre System. If you have a Home Theatre System
without multichannel sound processing, select Stereo.

To set Audio Out Format...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced >
press OK.

4 - Select Multichannel or Stereo, then press OK.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

Audio Out Format and

Audio Out Levelling

Use the Audio Out Levelling setting to level the
volume (loudness) of the TV and the Home Theatre
System when you switch over from one to another.



Volume differences can be caused by differences in
sound processing.

To level the difference in volume...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced > Audio Out Levelling and
press OK.

4 - Select More, Medium, or Less, then press OK.

5 - If the volume difference is large, select More. If
the volume difference is small, select Less.

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

Audio Out Levelling affects both the Audio Out -
Optical and HDMI ARC sound signals.

Audio Out Delay

With a Home Theatre System (HTS) connected to the
TV, the picture on TV and the sound from the HTS
should be synchronised.

Automatic audio to video sync

With recent Philips Home Theatre Systems, the audio
to video sync is done automatically and always
correct.

Audio sync delay

For some Home Theatre Systems you might need to
adjust the audio sync delay to synchronise the audio
to the video. On the HTS, increase the delay value
until there is a match between picture and sound. A
delay value of 180ms may be required. Read the user
manual of the HTS. With a delay value set up on the
HTS, you need to switch off Audio Out Delay on the
TV.

To switch off Audio Out Delay...

1- Press £, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced > Audio Out Delay and
press OK.

4 - Select Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Audio Out Offset

If you cannot set a delay on the Home Theatre
System, you can set the TV to sync the sound. You
can set an offset that compensates for the time
necessary for the Home Theatre System to process
the sound of the TV picture. You can set the value in
steps of bms. Maximum setting is -60ms.

16

The Audio Out Delay setting should be switched on.
To synchronise the sound on the TV...

1- Press £, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced > Audio Out Offset and
press OK.

4 - Use the slider bar to set the sound offset and
press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Problems with HTS sound

Sound with loud noise

If you watch a video from a plugged in USB flash drive
or connected computer, the sound from your Home
Theatre System might be distorted. This noise is heard
when the audio or video file has DTS sound but the
Home Theatre System has no DTS sound processing.
You can fix this by setting the Audio Out Format of
the TV to Stereo.

Press & for Al
Settings > Sound > Advanced > Audio Out
Format.

No sound

If you cannot hear the sound from the TV on your
Home Theatre System, check if you connected the
HDMI cable to an HDMI ARC connection on the
Home Theatre System. All HDMI connections on the
TV are HDMI ARC connections.

45

Blu-ray Disc Player

Use a High speed HDMI cable to connect the Blu-
ray Disc player to the TV.

Blu-ray Disc Player

=D Ll

If the Blu-ray Disc player has EasyLink HDMI CEC,
you can operate the player with the TV remote
control.

In Help, press the colour key == Keywords and look
up EasyLink HDMI CEC for more information.



4.6

DVD Player

Use an HDMI cable to connect the DVD player to the

TV.
Alternatively, you can use a SCART cable, if the
device has no HDMI connection.

DVD Player
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If the DVD player is connected with HDMI and has

EasyLink CEC, you can operate the player with the TV

remote control.

For more information on EasyLink, press the colour

key == Keywords and look up EasyLink HDMI CEC.

47
Headphones

You can connect a set of headphones to
the () connection on the back of the TV. The

connection is a mini-jack 3.5mm. You can adjust the
volume of the headphones separately.

‘

To adjust the volume...

1- Press ¢, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Headphone Volume and press OK.

4 - Press the arrows A (up) or
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

v (down) to adjust
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Game Consoles

HDMI

For best quality, connect the game console with a
High speed HDMI cable to the TV.

Game Console
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Connect the game console with a component video
cable (Y Pb Pr) and an audio L/R cable to the TV.

Game Console
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Video-Audio LR / Scart

Connect the game console to the TV with a
composite cable (CVBS) and an audio L/R cable to
the TV.

If your game console only has Video (CVBS) and
Audio L/R output, use a Video Audio L/R to SCART
adapter (sold separately) to connect to the SCART
connection.

Game Console
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Gamepad

Connect a Gamepad

To play games from the Internet on this TV, you can
connect a selected range of wireless Gamepads.
When you connect the Gamepad, you can use it
immediately.

To connect a Gamepad..

1- Plugin the small nano receiver in one of the USB
connections on the side of the TV. The wireless nano
receiver comes with the Gamepad.

2 - If the Gamepad is switched on, you can use the
Gamepad.

You can connect a second Gamepad in the second
USB connection on the side of the TV.

Suitable Gamepads

A selected range of wireless Gamepads are suited
and tested for use on this TV. Other Gamepads might
not be fully compatible.

The suited Gamepads are...

- Logitech F710

- Logitech F510

- Xbox 360 Wireless Controller for Windows
- Speedlink Strike FX Wireless Gamepad

Trouble with Interference

To solve possible interference with other wireless
deviceson TV...

- Use a USB extension cord and move the nano
receiver about 1 meter away from the TV.

- Alternatively, you can use a powered USB hub
connected to the TV and plug in the nano receivers in
the USB hub.

410

USB Hard Drive

What You Need

If you connect a USB Hard Drive, you can pause or
record a TV broadcast. The TV broadcast must be a
digital broadcast (DVB broadcast or similar).

To Pause

To pause a broadcast, you need a USB 2.0
compatible Hard Drive with a minimum of 4GB disk
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space.

To Record

To pause and record a broadcast, you need a
minimum of 250GB disk space. If you want to record
a broadcast with TV guide data from the Internet, you
need to have the Internet connection installed on
your TV before you install the USB Hard Drive.

For more information on how to install a USB Hard
Drive, press the colour key «= Keywords and look
up USB Hard Drive, Installation.

Installation

Before you can pause or record a broadcast, you
must connect and format a USB Hard Drive.
Formatting removes all files from the USB Hard Drive.

1- Connect the USB Hard Drive to one of

the USB connections on the TV. Do not connect
another USB device to the other USB ports when
formatting.

2 - Switch on the USB Hard Drive and the TV.

3 - When the TV is tuned to a digital TV channel,
press 1 (Pause). Trying to pause will start the
formatting.

Follow the instructions on screen.

When the USB Hard Drive is formatted, leave it
connected permanently.

USB Hard Drive

oy .
Cpuse
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The USB Hard Drive is formatted exclusively for this
TV, you cannot use the stored recordings on another
TV or PC. Do not copy or change recording files on
the USB Hard Drive with any PC application. This will
corrupt your recordings. When you format another
USB Hard Drive, the content on the former will be lost.
A USB Hard Drive installed on your TV will need
reformatting for use with a computer.

Warning



4.1

USB Keyboard

Connect

Connect a USB keyboard (USB-HID type) to enter text
on your TV.

You can connect a keyboard and a mouse to the TV.
Use one of the USB connections to connect.

EE

Install and configure the Keyboard

To install the USB keyboard, switch on the TV and
connect the USB keyboard to one of

the USB connections on the TV. When the TV
detects the keyboard for the first time, you can select
your keyboard lay-out and test your selection. If you
select a Cyrillic or Greek keyboard layout first, you
can select a secondary Latin keyboard layout.

To change the keyboard layout setting when a layout
was selected..

1- Press {%, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select USB Keyboard Settings, and press OK to
start the keyboard setup.

Special Keys

Keys for entering text

- Enter key = OK

- Backspace = delete character before cursor

- Arrow keys = navigate within a text field

- To switch between keyboard layouts, if a secondary
layout is set, press the Ctrl + Spacebar keys
simultaneously.

Keys for Smart TV Apps and Internet pages
- Tab and Shift + Tab = Next and Previous

- Home = scroll to the top of the page

- End = scroll to the bottom of the page

- Page Up = jump one page up

- Page Down = jump one page down

-+ =zoom in one step

+ - =zoom out one step

- * = fit the web page to the screen width
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USB Flash Drive

You can view photos or play your music and videos
from a connected USB flash drive.

Insert a USB flash drive in one of
the USB connections on the TV while the TV is
switched on.

The TV detects the flash drive and opens a list
showing its content.

If the contents list does not appear automatically,
press == SOURCES and select USB.

To stop watching the USB flash drive content,
press EXIT or select another activity.

To disconnect the USB flash drive, you can pull out
the flash drive anytime.

Ultra HD on USB

You can view photos in Ultra HD resolution from a
connected USB device or flash drive. The TV will
downscale the resolution to Ultra HD if the resolution
of the photo is higher.

413
Photo Camera

To view photos stored on your digital photo camera,
you can connect the camera directly to the TV.

Use one of the USB connections on the TV to
connect. Switch on the camera after you made the
connection.

If the contents list does not appear automatically,
press == SOURCES , and select USB.

Your camera might need to be set to transfer its
content with PTP (Picture Transfer Protocol). Read
the user manual of the digital photo camera.

Ultra HD on USB

You can view photos in Ultra HD resolution from a
connected USB device or flash drive. The TV will
downscale the resolution to Ultra HD if the resolution
of the photo is higher. You cannot play a native Ultra
HD video on any of the USB connections.



4.4
Camcorder

HDMI

For best quality, use an HDMI cable to connect the
camcorder to the TV.

Camcorder
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Video-Audio LR / Scart

You can use an HDMI, YPbPr or SCART connection to
connect your camcorder. If your camcorder only has
Video (CVBS) and Audio L/R output, use a Video
Audio L/R to SCART adapter (sold separately) to
connect to the SCART connection.

Game Console
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Computer

Connect

You can connect your computer to the TV and use
the TV as a PC monitor.

With HDMI

Use an HDMI cable to connect the computer to the
TV.
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With DVI to HDMI

Alternatively, you can use a DVI to HDMI adapter
(sold separately) to connect the PC to HDMI and an
audio L/R cable (mini-jack 3.5mm) to AUDIO IN L/R
on the back of the TV.
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Settings

If your computer is added as a Computer type of
device in the Source menu (the list of connections),
the TV is set to the ideal Computer setting
automatically.

If you use your computer to watch movies or use it to
play games, you might want to set the TV back to the
ideal TV watching or gaming setting.

To set the TV to the ideal setting manually...

1- Press {%, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Game or Computer, and
press OK.

4 - Select Game (for gaming) or

select Computer (for watching a movie).

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Remember to set Game or Computer setting
to Off when you stop playing the game.



Switching On and
Off

5.1

On or standby

Before you switch on the TV, make sure you plugged
in the mains power in the POWER connector on the
back of the TV.

To put the TV in Standby when the indicator light is

off, press the small joystick key on the back of the TV.

The indicator will light up.

With the TV in Standby, press ® on the remote
control to switch the TV on. Alternatively,
press A HOME .

Switch back to Standby

To switch the TV to Standby, press ¢ on the remote
control.

To switch off the TV completely, disconnect the
power plug.

When disconnecting the power plug, always pull the
power plug, never the cord. Ensure that you have full
access to the power plug, power cord and outlet
socket at all times.
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Philips Logo Brightness

You can switch off or adjust the brightness of the
Philips logo on the front of the TV.

To adjust or switch off...

1- Press f#, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Philips Logo Brightness, and

press p (right) to enter the menu.

4 - Select Minimum, Medium, Maximum,

or Off to switch off the lighting of the logo, then
press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.
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Keyson TV

If you lost the remote control or its batteries are
empty, you can still do some basic TV operations.

To open the basic menu..

1- With the TV switched on, press the joystick key on
the back of the TV to bring up the basic menu.

2 - Press left or right to

select Volume, Channelor Sources.

3 - Press up or down to adjust the volume or tune to
the next or previous channel. Press up or down to go
through the list of sources, including the tuner
selection. Press the joystick key to slide out the
camera.

4 - The menu will disappear automatically.

To switch the TV on standby, select @ and press the
joystick key.
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Sleep Timer

With the Sleep Timer, you can set the TV to switch to
Standby automatically after a preset time.

To set the Sleep Timer...

1- Press {£¢, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Sleep Timer and press p (right). With
the slider bar you can set the time to up to 180
minutes in increments of 5 minutes. If setto O
minutes, the Sleep Timer is switched off. You can
always switch off your TV earlier or reset the time
during the countdown.

4 - Press o (left) repeatedly if necessary, to close
the menu.
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Switch Off Timer

If the TV receives a TV signal but you don't press a
key on the remote control during a 4 hour period, the
TV switches off automatically to save energy. Also, if
the TV does not receive a TV signal nor a remote
control command for 10 minutes, the TV switches off
automatically.

If you use the TV as a monitor or use a digital receiver
to watch TV (a Set-Top Box - STB) and you do not
use the remote control of the TV, you should
deactivate this automatic switch off.

To deactivate the Switch Off Timer ...

1- Press f£¢, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Switch Off Timer and press OK.

4 - Press the arrows 4 (up) or w (down) to adjust
the value. The value 0 deactivates the automatic
switch off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

For more information on environmentally friendly TV
settings, press the colour key == Keywords and
look up Eco Settings.
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6

Remote Control

6.1
Key overview

Top

TV GUIDE LIST

TOP PICKS

1- @ Standby/ On
To switch the TV on or back to Standby.

2 - Playback and Record

- Play p, to playback.

- Pause 1, to pause playback

- Stop m, to stop playback

- Rewind <4, to rewind

- Fast forward »», to go fast forward
- Record e, to start recording

3- @ Ambilight

To select one of the Ambilight style.
4 - =TV GUIDE

To open or close the TV Guide.

5 - NETFLIX

To open the Netflix App directly (if available). With the
TV switched on or from standby.

6 - & Settings
To open the Settings menu.
7- =3 TOP PICKS

To get your favourite TV programmes, the newest
movies or most used Online TV channels presented
as top suggestions.

8- =LIST
To open or close the channel list.

Middle
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OPTIONS

- @
To open TV menus.

2 - == SOURCES
To open the Sources menu.

= Colour keys
Direct selection of options. Blue key ==, 0pens Help.

3———

4- @ INFO
To open or close programme info.
5- ¢« BACK

To switch back to the previous channel you selected.
To close a menu without changing a setting.
To go back to the previous App/Internet page.

6 - - EXIT
To switch back to watching TV. To leave an interactive
TV application.

7 - == OPTIONS
To open or close the Options menul.

8 - OKkey
To confirm a selection or setting.

9 - Arrow / navigation keys
To navigate up, down, left or right.

10 - O HOME
To open the Home menu.

Bottom



MULTIVIEW

(8]

1- Z3MULTIVIEW
To open an extra small screen.

2 - o) Volume
To adjust the volume level.

3 - Number keys
To select a channel directly.

4 - SUBTITLE
To switch Subtitles on, off or on during mute.
5- = Channel

To switch to the next or previous channel in the
channel list. To open the next or previous page in
Text/Teletext. To start the next or previous chapter on
a disc.

6 - «x Mute
To mute the sound or to restore it.
7 - TEXT

To open or close Text/Teletext.

6.2

Keyboard

Overview

Qwerty and Azerty

Overview of a Qwerty/Azerty keyboard.*

1- Azerty character
Character position if the keyboard layout is set to
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Azerty.

2 - tAa Shift
To type uppercase characters.

3 - [ Special characters
To open the onscreen keyboard to select accented
characters or symbols.

4 - Fn key
To type a number or punctuation character.

5- ., Spacebar
6 - Navigationand OK

7 - « Share this
To share online what you are watching at the
moment.

* Your remote control has a Qwerty / Azerty or a
Qwerty / Cyrillic keyboard, depending on your region.

Qwerty and Cyrillic

Overview of a Qwerty/Cyrillic keyboard.*
1

EXMR*ATERYY

ull I"Sodpr 282 R@"

DE FA G" HP JD Kﬂ Lﬂ ;)K :3 -—
CE VM BM NT

[} —

]
w
B
Ul
2}
~J

1- Cyrillic characters
Characters available when the keyboard is switched
to Cyrillic.

2 - &g Cyrillic keyboard switch
To switch the keyboard to the Cyrillic characters or
back to Qwerty.

3 - tAa Shift
To type uppercase characters.

4 - [ Special characters
To open the onscreen keyboard to select accented
characters or symbols.

5- Fnkey
To type a number or punctuation character

6 - . Spacebar

7 - «& Share this
To share online what you are watching at the
moment.

8 - Navigationand OK

* Your remote control has a Qwerty/Azerty or a
Qwerty/Cyrillic keyboard, depending on your region.



Writing Text

With the keyboard on the back of the remote control,
you can write text in any text field on screen. Turn the
keyboard facing upwards to activate the keyboard
keys. Hold the remote control with two hands and
type with both thumbs.

| £

Enter text

To enter text in a text field on screen, select the text
field and start typing.
Press OK to confirm the text.

Uppercase and Lowercase

To type an uppercase character, press the tAa (Shift)
key just before you type the character.

To type several uppercase characters consecutively,
press and hold the tAa key while typing.

To type uppercase constantly, press the ¢Aa key for
2 seconds to switch the keyboard in uppercase mode.
To switch out of uppercase mode, press the tAa key
again. If no keys are pressed for 20 seconds, the
uppercase mode switches off automatically. Also, if
you press another modifier key, like Fnor §, you
switch out of uppercase mode.

Numbers and Punctuation Characters

To type a number or punctuation character, press

the Fn key just before you type the number or
punctuation character you need. You can switch the
Fn mode on or off as you do for the uppercase mode.

Internet

You can use the Fn key to enter www. or .com.

Accented Letters and Symbols

Accented characters and symbols are not directly
available on the Remote Control Keyboard.

To type such a character, you can open the onscreen
keyboard.

To open the onscreen keyboard, press K. In the
onscreen keyboard, you can navigate to the character
you need. Switch the keyboard layout with the colour
keys. Press OK to enter a character. The onscreen
keyboard disappears when you press a character on
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the Remote Control Keyboard.

Qwerty, Azerty and Cyrillic keyboard

The standard layout of the Remote Control Keyboard
is Qwerty.

Azerty keyboard

Depending on your region, the Remote Control
Keyboard can be set to Azerty. The Azerty characters
are shown at the top right of the relevant keys.

To set the keyboard layout to Azerty...

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Remote Control Keyboard and

press OK.

4 - Select AZERTY or QWERTY and press OK.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

Cyrillic keyboard
Depending on your region, the Remote Control
Keyboard can be switched to Cyrillic characters.

The Cyrillic characters are shown at the top right of
the keyboard keys.

To write Cyrillic characters...

1- Press &g on the remote control.
2 - Press &g again to switch back to Qwerty.

6.3

Link up with the TV

Pairing

This remote control uses radio frequency (RF) to send
its commands to the TV. Contrary to remote controls
using infrared signals, with this remote control you
can send commands without pointing at the TV.

For the remote control to communicate with the TV,
both TV and remote control should be paired (linked)
with each other. Once paired, you cannot use the
remote control to control another TV.

When you started the initial TV installation, the TV
invited you to press the OK key, and by doing so,

the pairing was done. When you switch off the TV, the
pairing is stored. You can pair up to 5 remote controls
with this TV.



Pairing Again

You can pair another remote control with this TV.

The method to pair a remote control is different for a
remote control already paired with another TV
compared with a remote control that is not paired yet.

- The remote control is paired with another TV

To pair, hold the remote control close to the Philips
logo (about 10cm) and press the == Red

and e= Blue key at the same time. A message will
appear if pairing is successful.

- The remote control is not paired yet

To pair, hold the remote control close to the Philips
logo (about 10cm) and press OK. A message will
appear if pairing is successful.

Retail

To pair a new — not yet paired — TV with a remote
control which is already paired with another TV, hold
the remote control close to the Philips logo (about
10cm) and press the == Red and «= Blue key at the
same time.

A message will appear if pairing was successful.

0.4
IR Sensor

The remote control of the TV uses RF (radio
frequency) to send its commands to the TV. With RF,
you do not need to point the remote control at the
TV.

However, the TV can also receive commands from a
remote control that uses IR (infrared) to send
commands. If you use such a remote control, always
make sure you point the remote control at the
infrared sensor on the front of the TV.
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6.5
Batteries

If the TV does not react on a key press on the remote
control, the batteries might be empty.

To replace the batteries, open the battery
compartment on the keyboard side of the remote
control.

1- Slide the battery door in the direction shown by
the arrow.

2 - Replace the old batteries with 2

type AAA-RO3-15V batteries. Make sure the + and
the - ends of the batteries line up correctly.

3 - Reposition the battery door and slide it back until
it clicks.

Remove the batteries if you are not using the remote
control for a long time.

Safely dispose of your old batteries according to the
end of use directions.

For more information, press == Keywords and look
up End of use.

6.6
Cleaning

Your remote control is treated with a scratch-resistant
coating.

To clean the remote control, use a soft damp cloth.
Never use substances such as alcohol, chemicals or
household cleaners on the remote control.



7

Home and TV menu

7.1
Open the Home Menu

About the Home Menu

To enjoy the benefits of your Android TV, connect the
TV to the Internet.

Like on your Android smartphone or tablet, the Home
menu is the centre of your TV. From the Home menu
you can start any application, switch to a TV channel,
rent a movie, open a website or switch to a
connected device. Depending on your TV setup and
your country the Home menu can contain different
items.

When you do not have an Internet connection, you
can use the TV menu to operate the TV.

The Home menu is organised in rows...

The first row suggests popular videos, music videos or
Internet hits. You can set the Privacy settings in Terms
of Use to allow suggestions based on your personal
viewing habits.

& Philips Collection

This row contains suggestions from Apps.

‘m Apps

The row of Apps contain all Apps that come with the
TV and the Apps you download from the Google Play
store yourself. In this row you will also find the Apps
for TV, like Watch TV, Sources, Media and others.
Apps you started recently will appear in front of the
row.

™| Games

From here, you can start a game on TV. If you
download a game, it will appear in this row.
= Sources

From here, you can switch to a selection of TV inputs.
However, to find all inputs, press == to open the
Sources menu.

$¢ Settings

From here, you can open a selection of settings.
However, to find all settings, press £ SETTINGS and
select All Settings. You can also open Help here.

Open the Home Menu
To open the Home menu and open an item..

1- Press & HOME.

2 - Select anitem and press OK to open or start it.

3 - Press & BACK to close the Home menu without
starting anything.
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Channels

8.1
Channel Lists

About Channel Lists

After a channel installation, all channels appear the
channel list. Channels are shown with their name and
logo if this information is available.

For each type of tuner - Antenna/Cable (DVB-T/C) or
Satellite (DVB-S) - there is a channel list with all
installed channels. You can only filter this list to show
TV or only Radio channels. Or when you have several
satellites installed, you can filter the channels per
satellite.

With a channel list selected, you only tune to the
channels in that list when
using = 4 or = -—keys.

Channel icons

After an Automatic Channel Update of the channel
list, newly found channels are marked with

a ¥ (star).

If you lock a channel, it will be marked with

a @ (lock).

The 3 most popular channels being watched by
others at this moment are marked witha 1, 2or 3.

Radio stations

If digital broadcasting is available, digital radio
stations are installed during installation. Switch to a
radio channel just like you switch to a TV channel. A
Cable (DVB-C) channel installation usually places
radio stations from channel number 1001 onwards.

This TV can receive digital television standard DVB .
TV may not work properly with some operators of
digital television , non-compliance with requirements
of the standard in full.

Open a Channel List

Next to the list with all channels for each tuner,
Antenna/Cable or Satellite tuner, you can select a
filtered list or you can select one of the favourite lists
you created.

To open the current channel list...

1- While watching a TV channel, press = LIST to

open the Channel List.
2 - Press & BACK to close the channel list.

To select one of the channel lists..

1- With a channel list open on screen,
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press == OPTIONS.

2 - Select Select Channel List and press OK.
3 - Inthe list menu, select one of the available
channel lists and press OK.

Alternatively, you can select the list name at the top
of the channel list and press OK to open the list
menu.

Tip

You can easily switch between the two tuners in

the Sources menu.

Press == SOURCES and select Watch TV to switch
to the Antenna/Cable tuner. Select Watch

Satellite to switch to the satellite tuner.

The TV will always open the last selected channel list
for the selected tuner.

Filter a Channel List

You can filter a list with all channels. You can set the
channel list to show only TV channels or only Radio
stations. For Antenna/Cable channels you can set the
list to show the Free-to-Air or the Scrambled
channels. When you have several satellites installed,
you can filter the satellite channel list per satellite.

To set a filter on a list with all channels..

1- While watching a TV channel, press = LIST to
open the Channel List.

2 - Press = OPTIONS.

3 - Select Select Channel List and press OK.

4 - Select Filter Antenna Channels, Filter Cable
Channels or Filter Satellite Channels according to
the list you want to filter.

5- Inthe Options menu, select the filter you want
and press OK to activate. The name of the filter
appears as part of the channel list name on top of the
channel list.

6 - Press 4 (left) to go back one step or

press & to close the menu.

Search for a Channel

You can search for a channel to find it in a long list of
channels.

The TV can search for a channel within one of the 3
main channel lists - the Antenna, Cable or Satellite
channel list.

To search for a channel...

1- While watching a TV channel, press = LIST to
open the Channel List.

2 - Press = OPTIONS.

3 - Select Select Channel List and press OK.

4 - Select Filter Antenna Channels or Filter Cable

Channels or Filter Satellite Channels and



press OK.

5 - Select Search Channel and press OK to open
a text field.You can use the remote control keyboard
or the onscreen keyboard to enter text.

6 - Enter a number, a name or part of a name and
select Apply and press OK. The TV will search for
matching channel names in the list you selected.

Search results are listed as a channel list - see the list
name at the top. The search results disappear once
you select another channel list or close the list with
search results.

8.2

Watching Channels

Tune to a Channel

To start watching TV channels, press w@m. The TV
tunes to the channel you last watched.

Switch Channels

To switch channels, press = +or = —.

If you know the channel number, type in the number
with the number keys. Press OK after you entered
the number to switch immediately.

Now and next

While you're watching a TV channel, you can quickly

scroll through the rest of the channels and see what's
on.

Press A (up)or w (down)to open a scrolling list of

channels. If the information is available, the TV shows
the current programme name and details followed by
the next programme name and details.

Previous channel

To switch back to the previously tuned channel,
press & BACK.

Lock a Channel

Lock and Unlock a Channel

To prevent children from watching a channel, you can
lock a channel. To watch a locked channel, you must
enter the 4 digit Child Lock PIN code first. You
cannot lock programmes from connected devices.

To lock a channel..

1- While watching a TV channel, press = LIST to
open the Channel List.

2 - Select the channel you want to lock.

3 - Press = OPTIONS and select Lock

Channel and press OK.

4 - Enter your 4 digit PIN code if the TV asks for it. A

locked channel is marked with a g (lock).
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5- Press 4 (left) to go back one step or
press & to close the menu.

To unlock a channel...

1- Press .

2 - Press OKto open the channel list. If necessary
change the channel list.

3 - Select the channel you want to unlock.

4 - Press == OPTIONS and select Unlock
Channel and press OK.

5 - Enter your 4 digit PIN code if the TV asks for it.
6 - Press 4 (left) to go back one step or

press & to close the menu.

If you lock or unlock channels in a channel list, you
only have to enter the PIN code just once until you
close the channel list.

In Help, press the colour key == Keywords and look
up Child Lock for more information.

Parental Rating

To prevent children from watching a programme not
suitable for their age, you can set an age rating.

Digital channels can have their programmes age
rated. When the age rating of a programme is equal to
or higher than the age you have set as age rating for
your child, the programme will be locked. To watch a
locked programme, you must enter the Child Lock
code first.

To set an age rating...

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Child Lock > Parental Rating and

press OK.

4 - Enter a 4-digit Child lock code. If you did not set
a code yet, select Set Codein Child Lock. Enter a
4-digit Child lock code and confirm. Now you can set
an age rating.

5 - Backin Parental Rating, select the age and
press OK.

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

To switch off the parental age rating, select None.
However, in some countries you must set an age
rating.

For some broadcasters/operators, the TV only locks
programmes with a higher rating. The parental age
rating is set for all channels.



Channel Options

Open Options

While watching a channel, you can set some options.

Depending on the type of channel you are watching
(analogue or digital) or depending on the TV settings
you made, some options are available.

To open the options menu...

1- While watching a channel, press == OPTIONS.

2 - Press = OPTIONS again to close.

Subtitles

Switch On

To switch on Subtitles, press SUBTITLE.

You can switch subtitles On or Off. Alternatively

you can select Automatic.

Automatic

If language information is part of the digital broadcast
and the broadcasted programme is not in your
language (the language set on TV), the TV can show
subtitles automatically in one of your preferred
subtitle languages. One of these subtitle languages
must also be part of the broadcast.

You can select your preferred subtitle languages
in Subtitle Language.

Subtitles from Text

If you tune to an analogue channel, you need to
make the subtitles available for each channel
manually.

1- Switch to a channel and press TEXT to open
Text.

2 - Enter the page number for subtitles, usually 888.
3 - Press TEXT again, to close Text.

If you select On in the Subtitle menu when watching
this analogue channel, subtitles will be shown if
available.

To know if a channel is analogue or digital, switch to
the channel and open Channel
Infoin == OPTIONS.

Subtitle Language

Preferred Subtitle Languages

A digital broadcast can offer several subtitle
languages for a programme. You can set a preferred
primary and secondary subtitle language. If subtitles
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in one of these languages are available, the TV will
show the subtitles you selected.

To set the primary and secondary subtitle language..

1- Press £, select All Settings and press OK.
2 - Select Region and Language and

select Languages > Primary

Subtitles or Secondary Subtitles.

3 - Select the language you need and press OK.
4 - Press o (left) to go back one step or

press & to close the menu.

Select a Subtitle Language

If none of the preferred subtitle languages are
available, you can select another subtitle language if
available. If no subtitle languages are available, you
cannot select this option.

To select a subtitle language when none of your
preferred languages are available..

1- Press == OPTIONS.
2 - Select Subtitle Language and select one of the
languages as subtitles temporarily.

Audio Language

Preferred Language

A digital broadcast can offer several audio languages
(spoken languages) for a programme. You can set a
preferred primary and secondary audio language. If
audio in one of these languages is available, the TV
will switch to the audio language.

To set the primary and secondary audio language...

1- Press £, select All Settings and press OK.
2 - Select Region and Language and

select Languages > Primary

Subtitles or Secondary Subtitles.

3 - Select the language you need and press OK.
4 - Press < (left) to go back one step or

press & to close the menu.

Select a Language

If none of the preferred audio languages are
available, you can select another audio language if
available. If no audio languages are available, you
cannot select this option.

To select an audio language when none of your
preferred languages are available..

1- Press == OPTIONS.
2 - Select Audio Language and select one of the
languages as audio temporarily.



Common Interface

If you installed a CAM in one of the Common
Interface slots, you can view the CAM and operator
information or do some CAM related settings.

To view the CAM information..

1- Press == SOURCES.

2 - Select the channel type you are using the CAM
for, Watch TV or Watch Satellite.

3 - Press == OPTIONS and select Common
Interface.

4 - Select the appropriate Common Interface slot
and press p (right).

5 - Select the TV operator of the CAM and press OK.

The following screens come from the TV operator.

HbbTV on this Channel

If you want to avoid access to HbbTV pages on a
specific channel, you can block the HbbTV pages for
this channel only.

1- Tune to the channel of which you want to block
the HbbTV pages.

2 - Press == OPTIONS and select HbbTV on this
Channel and press p (right).

3 - Select Off and press OK.

4 - Press o (left) to go back one step or

press & BACK to close the menu.

To block HbbTV on TV completely..

1- Press {%, select All Settings and press OK.
2 - Select General Settings > Advanced >
3 - Select Off and press OK.

4 - Press o (left) to go back one step or
press & to close the menu.

HbbTV.

Channel Info

You can view the technical characteristics of a
particular channel, like digital or analogue, sound
type, etc.

To view the technical information on a channel...

1- Tune to the channel.

2 - Press = OPTIONS, select Channel Info and
press OK.

3 - To close this screen, press OK.

Mono / Stereo

You can switch the sound of an analogue channel to
Mono or Stereo.

To switch to Mono or Stereo..

1- Tune to an analoge channel.
2 - Press == OPTIONS, select Mono/Stereo and
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press p (right).

3 - Select Mono or Stereo and press OK.
4 - Press o (left) to go back one step or
press & to close the menu.

Video Selection

Digital TV channels can offer multi video signals (multi-
feed broadcast), different camera viewpoints or

angles of the same event or different programmes on
one TV channel. The TV shows a message if any such
TV channels are available.

Dual -1l

If an audio signal contains two audio languages but
one language or both has no language indication, this
option is available.

Reorder Channels

Only in a Favourites List you can change the
sequence of channels (reorder).

To change the sequence of channels..

1- Open the Favourites List you want to reorder.
2 - Press == OPTIONS, select Reorder
Channels and press OK.

3 - Inthe Favourites List, select the channel you
want to reorder and press OK.

4 - Withthe A (up)or w (down) keys move the
channel where you want it.

5- Press OK to confirm the new location.

6 - You can reorder channels with the same method
until you close the Favourites List with

the & BACK key.
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Favourite Channels

Create a Favourites List

To create a favourite channels list...

1- While watching a TV channel, press = LIST to
open the Channel List.

2 - Press == OPTIONS.

3 - Select Create Favourites List and press OK.

4 - In the list at the left, select a channel you want as
a favourite and press OK. Channels come in the list at
the right in the order you add them. To undo, select
the channel in the list at the left and

press OK again.

5 - If necessary, you can go on selecting and adding
channels as favourites.



6 - To finish adding channels, press & BACK.

The TV will ask to rename the Favourites List. You can
use the on screen keyboard or use the keyboard on
the back of the remote control.

1- Press & BACK to hide the on screen keyboard.
2 - Use the keyboard on the back of the remote
control to delete the current name and enter a new
name.

3 - When done, turn the remote control,

select Close and press OK.

The TV will switch to the newly created Favourites
List.

You can add a range of channels in one go or start a
Favourites List by duplicating the channel list with all
channels and removing the channels you do not
want.

The channels in the Favourites List are renumbered.

Add a Range of Channels

To add a consecutive range of channels to a
Favourites List in one go, you can use Select Range.

To add a range of channels..

1- Open the Favourites List where you want to add a
range of channels.

2 - Press = OPTIONS, select Select Range and
press OK.

3 - Inthe list at the left select the first channel of the
range you want to add and press OK.

4 - Press w (down) to select the last channel of the
range you want to add. The channels are marked at
the left.

5- Press OK to add this range of channels and
confirm.

You can also start creating a Favourites List from
Select Range.

Rename a Favourites List

You can only rename a Favourites List.
To rename a Favourites List...

1- Open the Favourite List you want to rename.

2 - Press == OPTIONS, select Rename Favourites
List and press OK.

3 - Press & BACK to hide the on screen keyboard.
4 - Use the keyboard on the back of the remote
control to delete the current name and enter a new
name.

5 - When done, turn the remote control,

select Close and press OK.

6 - Press & BACK to close the channel list.
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Remove a Favourites List

You can only remove a Favourites List.
To remove a Favourites List...

1- Open the Favourites List you want to remove.

2 - Press == OPTIONS, select Remove Favourites
List and press OK.

3 - Confirm to remove the list.

4 - Press & BACK to close the channel list.

Reorder Channels

Only in a Favourites List you can change the
sequence of channels (reorder).

To change the sequence of channels..

1- Open the Favourites List you want to reorder.

2 - Press = OPTIONS, select Reorder

Channels and press OK.

3 - Inthe Favourites List, select the channel you
want to reorder and press OK.

4 - Withthe A (up)or w(down) keys move the
channel where you want it.

5- Press OK to confirm the new location.

6 - You can reorder channels with the same method
until you close the Favourites List with the & BACK
key.

8.4

TV Guide

What You Need

With the TV Guide you can view a list of the current
and scheduled TV programmes of your channels.
Depending on where the TV guide information (data)
is coming from, analogue and digital channels or only
digital channels are shown. Not all channels offer TV
Guide information.

The TV can collect TV Guide information for the
channels that are installed on the TV. The TV cannot
collect the TV Guide information for channels viewed
from a digital receiver or decoder.

TV Guide Data

The TV Guide receives information (data) from
broadcasters or from the Internet. In some regions
and for some channels, TV Guide information might
not be available. The TV can collect TV Guide
information for the channels that are installed on the
TV. The TV cannot collect the TV Guide information
from channels viewed from a digital receiver or



decoder.

The TV comes with the information set to From the
broadcaster.

If TV Guide information comes from the Internet, the
TV Guide can also list analogue channels next to the
digital channels. The TV Guide menu also shows a
small screen with the current channel.

From the Internet

If the TV is connected to the Internet, you can set the
TV to receive the TV Guide information from the
Internet.

To set the TV Guide information...

1- Press {%, select All Settings and press OK.

2 - Select TV Settings and press p (right) to enter
the menu.

3 - Select TV Guide and select From the Internet.
4 - Press o (left) repeatedly if necessary, to close
the menu.

Missing recordings

When some recordings seem to have disappeared
from the list of recordings, the TV Guide info (data)
might have changed. Recordings made with the
setting From the broadcaster become invisible in
the list if you switch the setting to From the
Internet or vice versa. The TV might have switched
to From the Internet automatically.

To make the recordings available in the list of
recordings, switch to the setting that was selected
when the recordings were made.

Using the TV Guide

Open the TV Guide

To open the TV Guide, press == TV GUIDE .

Press == TV GUIDE again to close.

The first time you open the TV Guide, the TV scans all
TV channels for programme information. This may
take several minutes. TV Guide data is stored in the
TV.

Tune to a Programme

Switch to a programme

From the TV Guide, you can switch to a current
programme.

Select the programme name to select the programme.

Navigate to the right to view programmes scheduled
later that day.

To switch to the programme (channel), select the
programme and press OK.

View programme details
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To call up the details of the selected programme,
press @ INFO .

Change Day

The TV Guide can show scheduled programmes for
the upcoming days (maximum up to 8 days).

If the TV Guide information comes from the
broadcaster, you can press = + to view the
schedule of one of the next days. Press = —to go
back to the previous day.

Alternatively, you can press the colour
key «= Day and select the day you need.

Search by Genre

If the information is available, you can look up
scheduled programmes by genre like movies, sports,
etc.

To search for programmes by genre,

press == OPTIONS and select Search by Genre.
Select a genre and press OK. A list with the found
programmes appears.

Recordings

From the TV Guide, you can instantly record or
schedule a recording of a TV programme. To store the
recordings, connect a USB Hard Drive to the TV.
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Text / Teletext

Text Pages

To open Text/Teletext press TEXT, while you are
watching TV channels.
To close Text, press TEXT again.

Select a Text page
To select a page . ..

1- Enter the page number with the number keys.
2 - Use the arrow keys to navigate.

3 - Press a colour key to select a colour-coded
subject at the bottom of the screen.

Text sub-pages
A Text page number can hold several subpages. The
subpage numbers are shown on a bar next to the

main page number.
To select a subpage, press qor p.

T.O.P. Text pages



Some broadcasters offer T.O.P. Text.
To open T.O.P. Text pages within Text,
press == OPTIONS and select T.O.P. overview.

Favourite pages

The TV makes a list of the last 10 Text pages you
opened. You can easily reopen them again in the
Favourite Text pages column.

1- In Text, select the starin the top left corner of
the screen to show the column of favourite pages.

2 - Press w(down)or A (up)to select a page
number and press OK to open the page.

You can clear the list with the option Clear favourite
pages.

Search Text

You can select a word and scan Text for all
occurences of this word.

1- Open a Text page and press OK.

2 - Select a word or number with the arrow keys.

3 - Press OK again to jump immediately to the next
occurence of this word or number.

4 - Press OK again to jump to the subsequent
occurence.

5 - To stop searching, press A (up) until nothing is
selected.

Text from a connected device

Some devices that receive TV channels can also offer
Text.
To open Text from a connected device . . .

1- Press = SOURCES
press OK.

2 - While watching a channel on the device,

press == OPTIONS , select Show device keys and
select the B3 key and press OK.

3 - Press & BACK to hide the device keys.

4 - To close Text, press & BACK again.

Digital Text (UK only)

select the device and

Some digital broadcasters offer dedicated Digital Text
or interactive TV on their digital TV channels. This
includes normal Text using the number, colour and
arrow keys to select and navigate.

To close Digital Text, press & BACK.

Text Options

In Text/Teletext, press == OPTIONS to select the
following...

- Freeze page

To stop the automatic rotation of subpages.

- Dual screen / Full screen

To show the TV channel and Text alongside each
other.

- T.O.P. overview

To open T.O.P. Text.

34

- Enlarge

To enlarge the Text page for comfortable reading.
- Reveal

To unhide hidden information on a page.

- Cycle subpages

To cycle subpages when these are available.

- Language

To switch the group of characters that Text uses to
display correctly.

- Text 25

To activate the Text 2.5 for more colours and better
graphics.

Text Setup

Text language

Some digital TV broadcasters have several Text
languages available.
To set your primary and secondary Text language . . .

1- Press %

2 - Select TV settings and press p (right) to enter
the menu.

3 - Select Language > Primary Text or
Text and press OK.

4 - Select your preferred Text languages.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

Text 2.5

Secondary

If available, Text 2.5 offers more colours and better
graphics. Text 2.5 is activated as a standard factory
setting.

To switch off Text 2.5...

1- Press TEXT.

2 - With Text/Teletext open on screen,

press == OPTIONS.

3 - Select Text25> Off

4 - Press < (left) repeatedly if necessary, to close
the menu.

8.6
Interactive TV

AboutiTV

With interactive TV, some digital broadcasters
combine their normal TV programme with information
or entertainment pages. On some pages, you can
respond to a programme or vote, do online shopping
or pay for a video-on-demand programme.

HbbTV, MHEG, . ..

Broadcasters use various interactive TV systems :
HbbTV (Hybrid Broadcast Broadband TV) oriTV
(Interactive TV - MHEG). Interactive TV is sometimes



referred to as Digital Text or Red button. But each
system is distinct.

Visit the broadcaster's Internet website for more
information.

What You Need

Interactive TV is only available on digital TV channels.

To enjoy the full benefits of Interactive TV, you need
a high-speed (broadband) Internet connection to the
TV.

HbbTV
If a TV channel offers HbbTV pages, you must first

switch on HbbTV in the TV settings to view the pages.

1- Press £, select All Settings and press OK.

2 - Select TV settings> HbbTV and press OK.

3 - Select On.

4 - Press < (left) repeatedly if necessary, to close
the menu.

If you want to avoid access to HbbTV pages on a
specific channel, you can block the HbbTV pages for
this channel only.

1- Tune to the channel of which you want to block
the HbbTV pages.

2 - Press == OPTIONS and select HbbTV on This
Channel.

3 - Select Off.

Use iTV

OpeniTV pages

Most channels that offer HobTV or iTV invite you to
press the colour key == (red) or OK key to open
their interactive programme.

Navigate iTV pages

You can use the arrow and colour keys, the number
keys and the & BACK key to navigate the iTV
pages.

You can use the p (Play), u(Pause)and m (Stop)
keys to watch videos within iTV pages.

Digital Text (UK only)

To open Digital Text, press TEXT. To close,
press & BACK.

Close iTV pages

MostiTV pages inform you which key to use to close.
To force aniTV page to close, switch to the next TV
channel and press & BACK.
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Top Picks

when Now on TV is available.

The TV does not store former recommendations.

9.1

About Top Picks

With TOP PICKS your TV recommends current TV
programmes, the latest rental videos and Online TV
services for you to watch. Make sure you agree to the
Terms of Use. To enjoy Top Picks connect your TV to
the Internet.

The Top Picks information and services are only
available in selected countries.

Terms of Use

To allow the TV to make these recommendations, you
must agree to the Terms of Use. To get personalised
recommendations based on your viewing habits,
make sure you checked the tick box for Personal
Recommendations Consent.

To agree to the Terms of Use and agree to the
Personal Recommendations Consent...

1- Press w3 TOP PICKS.

2 - Press OPTIONS, select Terms of Use and
press OK.

3 - Select(....) and press OK.

4 - Press & BACK.

—
—-—
—_—

9.2

Now on TV

About Now on TV

With w Now on TV , the TV recommends the 10
most popular programmes to watch at this moment.

The TV recommends programmes on TV now or
starting within 15 minutes. The recommended
programmes are selected from the channels you
installed. The selection is made from channels of your
country. Also, you can let Now on TV do some
personalised recommendations for you, based on
programmes you watch regularly.

To make the Now on TV information available...

- the Now on TV information must be available in your
country.

- the TV must have channels installed.

- the TV must be connected to the Internet.

- the TV Clock must be set to Automatic or Country
Dependent.

- you must accept the Terms of Use (You might have
accepted already when you connected to the
Internet.).

The icon wm will only appear at the top of the screen
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Using Now on TV

To open Now on TV...

1- Press ga3 TOP PICKS to open the Top Picks
menu.

2 - Select @ Nowon TV at the top of the screen
and press OK.

3 - Press & BACKto close.

When you open Now on TV, the TV may need a few
seconds to refresh the page information.

In Now on TV you can..

- select and press OK on a programme icon to tune
to the ongoing programme.

- select and press OK on a scheduled programme
icon to tune to the channel already.

You can use the colour keys on the remote control to
start, stop or clear a scheduled recording. You can
also set or remove a reminder that warns you when a
programme starts.

To leave Now on TV without tuning to another
channel, press & BACK.

93
TV on Demand

About TV on Demand

With @& TV on Demand , you can watch TV
programmes you missed or watch your favourite
programmes whenever it suits you best. This service is
also called Catch Up TV, Replay TV or Online TV.
Programmes available on TV on Demand are free to
watch.

You can let TV on Demand do some personalised
recommendations of programmes, based on the TV
installation and the programmes you watch regularly.

Theicon @ will only appear at the top of the screen
when TV on Demand is available.

Using TV on Demand

To open TV on Demand...

1- Press g3 TOP PICKS to open the Top Picks
menu.

2 - Select y® TV on Demand at the top of the
screen and press OK.

3 - Press w (down) to open the page full screen.
4 - Press & BACK to close.



When you open TV on Demand, the TV may need a
few seconds to refresh the page information.

You can select a specific broadcaster if more than
one is available.
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Video on Demand

About Video on Demand

With gg Video on Demand , you can rent movies
from an online rental video store.

You can let Video on Demand do some personalised
recommendations of movies, based on your country,
the TV installation and the programmes you watch
regularly.

Theicon gg will only appear at the top of the screen
when Video on Demand is available.

Payment

When you rent or buy a movie, you can pay the video
store securely with your credit card. Most video
stores ask you to create a login account the first time
you rent a movie.

Internet Traffic

Streaming a lot of videos may cause you to exceed
your monthly Internet traffic limit.

Using Video on Demand

To open Video on Demand...

1- Press TOP PICKS to open the Top Picks
menu.

2 - Select gg Video on Demand at the top of the
screen and press OK.

3 - Press w (down) to open the page full screen.
4 - Press & BACK to close.

When you open Video on Demand, the TV may need
a few seconds to refresh the page information.

You can select a specific video store if more than one
is available.

To rent a movie..

1- Navigate the highlight on a movie poster. Limited
info will show after some seconds.

2 - Press OKto open the movie page of the video
store for a synopsis of the movie.

3 - Confirm your order.

4 - Make the payment on TV.

5 - Start watching. You can use the p (Play)

and 1 (Pause) keys.
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10

Sources

101
Switch to a device

From the list of Sources, you can switch to a
connected device and watch its programme.

To switch to a connected device..

1- Press == SOURCES to open the Sources menu.
2 - Select one of the item in the source list. The TV
will show the programme or content of the device.

3 - Press & BACK, to watch TV.

To close the Sources menu without switching to a
device, press == SOURCES again.

10.2
Device Detection

When you connect a new device to the TV, the device
is detected and you can assign a device type as an
icon for the new device. If you connect a device with
HDMI CEC, the device gets its icon automatically.

If you want to change the icon assigned to a
connected device...

1- Press == SOURCES to open the Sources menu.
2 - Select a connected device in the Sources menu,
then press p to select  £¢.
3 - Press OK, then you can select a device type that
fits the connected device.

If the name does not fit the device or you want to
give the device a name of your own...

1- Press == SOURCES to open the Sources menu.
2 - Select a connected device in the Sources menu,
then press p to select £

3 - Press OK, then you can use the On-screen
Keyboard or the Remote Control Keyboard (if
available) to enter a new name.

4 - Press « to confirm.

If you want to restore the device icon to its original

name and type icon...

1- Press == SOURCES to open the Sources menu.
2 - Select a connected device in the Sources menu,
then press p to select £¢.

3 - Press OK, then select Reset to restore.

If you want to rescan all TV connections and update

the Sources menu...

1- Press = SOURCES to open the Sources menu.
2 - Press A toselect 3, then press OK.
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10.3

One Touch Play

With the TV in Standby, you can switch on a disc
player with your TV remote control.

Play

To switch on both disc player and TV from Standby
and start playing the disc immediately,

press p (play) on the TV remote control.

The device must be connected with an HDMI cable
and both TV and device must have HDMI| CEC
switched on.



Apps

1M1

About Apps

With g Apps in the Home menu, you open the
Apps pages.

The Apps pages show the collection of Apps
(Applications) on your TV. Like Apps on your
smartphone or tablet, the Apps on your TV offer
specific functions for an enriched TV experience.
Apps like TV games or weather forecasts (a.0.). Or
start an Internet browser App to surf the Internet.

Apps can come from the Philips App Gallery or

the Google Play™ store. To get you started, some
practical Apps are pre-installed on your TV. Some of
the Apps can offer Widgets that appear on the Apps
pages.

To install Apps from the Philips App Gallery or the
Google Play store, the TV must be connected to the
Internet.

1.2

Install an App

You can install an App from the Philips App Gallery or
from the Google Play store.

To install an App...

1- Press @& HOME to open the Home menu.

2 - Select Appstoopen Apps.

3 - Select *m App Gallery icon orthe Google
Play™ store icon.

4 - Select the App you want and select the install
button next to the App.

The TV will install the App.

If you have trouble with installing apps, first check the
settings in the Google Play store.

1.3

Start an App

You can start an App from the Apps pages.
To start an App...

1- Press & HOME to open the Home menu.
2 - Select gy Apps to open Apps.
3 - Select the App icon to start the App.

To stop an App..

Press @& HOME and select another activity or
press EXIT towatch TV.
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12

Videos, Photos and
Music

12.1
From a USB Connection

You can view your photos or play your music and
videos from a connected USB flash drive or USB Hard
Drive.

With the TV switched on, plug in a USB flash drive or a
USB Hard Drive to one of the USB connections. The
TV detects the device and will list your Media files. If
the list of files does not appear automatically,

press == SOURCES and select USB.

You can search a file with the search field or browse
your files in the folder structure you have organised
on the drive.

The TV will also bundle your Media files according to
their type —

@ Videos , @l Photos or sJ Music . The colour
key functions and the options in == OPTIONS are
therefore dedicated for each type.

To stop playing videos, photos and music,
press @ HOME and select another activity.

Warning

If you try to pause or record a programme with a USB
Hard Drive connected, the TV will ask you to format
the USB Hard Drive. This formatting will delete all
current files on the USB Hard Drive.

12.2
From a Computer or NAS

You can view your photos or play your music and
videos from a computer or a NAS (Network Attached
Storage) in your home network.

The TV and computer or NAS must be in the same
home network. On your computer or NAS, you need
to install Media Server Software like Twonky™. Your
Media Server must be set to share your files with the
TV. The TV shows your files and folders as they are
organised by the Media Server or as they are
structured on your computer or NAS. On the TV, the
colour key functions and the options

in == OPTIONS are the same for all types of Media
files.

If the Media Server supports searching for files, a
search field is available.

To browse and play the files on your computer,
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press = SOURCES , select SimplyShare.



3D

13.1

What You Need

This is an active 3D TV. On this TV, you can watch 3D
programmes and movies in full High Definition
resolution.

With this TV you view 3D photos in Ultra HD
resolution, from a USB connection. You cannot watch
3D on native Ultra HD video.

To watch 3D...

- tune to a TV channel that broadcasts programmes in
3D.

- rent a movie in 3D from an online video store.

- play a movie in 3D from a 3D Blu-ray Disc, a USB
device or computer.

Also, to watch 3D on this TV, you will need one of
these types of Philips Active 3D glasses. . .

- PTA507
- PTA508
- PTA509
- PTA517
- PTA518
- PTA519
- PTA529

All types are sold separately. Active 3D glasses from
other brands might not be supported.

13.2

3D Glasses

Overview

1- @, On or Off switch, LED light

2 - Player 1/2, Player 1 or Player 2 selection.
3 - Receiver lens

4 - Battery compartment

When you unpack the 3D glasses, also remove the
small plastic foil from the battery compartment.

Switch On and Off

To switch on the 3D glasses, press ¢ .

The glasses need some seconds to adjust to the 3D
signal from the 3D transmitter on the TV. At first use,
this may take up to 15 seconds.

Battery Level

You can check the battery level when you switch on

the 3D glasses.

- If the LED light blinks green, you can use the glasses
for 4 hours or more.

- If the LED light blinks orange, you can use the
glasses for at least 2 hours but less than 4 hours.

- If the LED light blinks red, the battery is almost
empty and less than 2 hours of 3D watching remain.

Switch Off

To switch off the 3D glasses, press ¢ . The LED light
blinks red 4 times. When the 3D glasses do not
receive 3D signals for 2 minutes, the glasses switch off
automatically.

3D Transmitter

Make sure the receiver lens in the centre of the
glasses can receive the 3D signals.

Also, clear objects away from the 3D transmitter on
the TV.

Split Screen Gaming

You can use these glasses to play split screen games.
Two players can watch the same TV but see two
different screens to play a game.

To switch the glasses to watch the Player 1 or Player 2
screen, switch on the glasses and then press
the Player 1/2 key.

- If the LED light is orange and lits continuously for 2
seconds, the glasses are set for player 1.

- If the LED light is orange and blinks, the glasses are
set for player 2.

For more information, press the colour
key «= Keywords and look up Split Screen
Gaming.

Replacing the Batteries

To replace the battery, press the small knob on the
battery lid and slide the lid up to open. Replace the
battery: type CR2032 (3V). Make sure the + side of the
battery is visible. Replace the lid and slide it down
until it clicks.

Warning

Danger of explosion if the battery is incorrectly
replaced. Replace only with the same or equivalent

type.

Danger

- Do not ingest the battery. Chemical burn hazard.

- This product contains a coin/button cell battery. If
the coin/button cell battery is swallowed, it can cause



severe internal burns in just 2 hours and can lead to
death.

- Keep new and used batteries away from children.

- If the battery compartment does not close securely,
stop using the product and keep it away from
children.

- If you think batteries might have been swallowed or
placed inside any part of the body, seek immediate
medical attention.

13.3

3D Settings

Automatic Switching

The first time a 3D signal is detected, you can set your
preference on how to start 3D in the future. You can
change this setting in the Setup menu later.

- To switch to 3D automatically, select Automatic.
- To show a notification first, select Notification only.
- To never switch to 3D, select Never.

To change this setting...

1- Press f£%, select All Settings and press OK.

2 - Select 3D and press p (right) to enter the
menu.

3 - Select Switchto 3D and

select Automatic, Notification Only or Never.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Stop 3D

To stop watching 3D...

1- Press .
2 - Select 3D Format> 2D, and press OK.

3D is switched to 2D when you switch to another
channel or connected device.

2D to 3D conversion

With 2D to 3D Conversion, you can watch 3D all the
time. The TV creates 3D artificially from a 2D signal.
To watch 3D from a 2D signal...

1- Press .
2 - Select 3D Format> 2D to 3D conversion, then
press OK.

To switch off 2D to 3D conversion...

1- Press 4%
2 - Select 3D Format> 2D, then press OK.
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3D Format

When the TV switches to 3D or when a notification is
shown that 3D is available, put on your 3D glasses.

If the TV cannot detect the 3D signal (the 3D signal
tag is missing), the 3D programme is shown as a
double image on screen.

To select the appropriate setting to get a correct 3D
picture...

1- Press %

2 - Select 3D Format> 3D - Side by Side, 3D -
Top / Bottom, 3D - Side by Side Inverted, or 3D -
Top / Bottom Inverted , then press OK.

13.4

Optimal 3D Viewing

For an optimal 3D viewing experience, we
recommend that you:

- sit at least 3 times the height of the TV screen away
from the TV, but no further than 6 meters away.

- avoid fluorescent lighting (such as TL lighting or
certain energy saving light bullbs which operate on a
low frequency) and direct sunlight as they may
interfere with the 3D experience.

13.5

Care of the 3D Glasses

- Do not use cleaning chemicals containing alcohol,
solvent, surfactant, or wax, benzene, thinner,
mosquito repellent or lubricant. Using these
chemicals can cause discoloration or cracks.

- Do not expose the 3D glasses to direct sunlight,
heat, fire or water. This may result in a product
malfunction or fire.

- Do not drop, bend or apply force to the lenses of
the 3D glasses.

- Use a clean soft cloth (microfiber or cotton flannel)
to clean the lenses to avoid scratching them. Never
spray cleaner directly onto the 3D glasses. This may
damage the electronics (for Active 3D glasses).

- Do not use cleaning chemicals containing alcohol,
solvent, surfactant, or wax, benzene, thinner,
mosquito repellent or lubricant. Using these
chemicals can cause discoloration or cracks.



13.6

Health Warning

- Watching 3D is not recommended for children under
the age of six.

- If you or your family have a history of epilepsy or
photosensitive seizures, consult a medical
professional before exposing yourself to flashing light
sources, rapid image sequences or 3D viewing.

- If you experience any discomfort, stop watching 3D
and do not immediately engage in any potentially
hazardous activity (for example driving a car) until
your symptoms have disappeared. If symptoms
persist, do not resume watching 3D without
consulting a medical professional first.

- To avoid discomfort such as dizziness, headache or
disorientation, we recommend not watching 3D for
extended periods of time.

- Do not use the 3D glasses for any purpose other
than watching 3D TV.

- If you normally wear corrective glasses or use
contact lenses, wear the 3D glasses together with
these glasses or lenses.

- Keep the glasses away from small children to avoid
the swallowing of small parts or batteries.

- Parents should monitor their children during 3D
viewing and ensure they do not experience any
discomfort as mentioned above. Watching 3D is not
recommended for children under six years of age as
their visual system is not fully developed yet.

- Avoid the use of the 3D glasses in case of eye
infection or other diseases transmitted by contact
(e.g. conjunctivitis, head lice, etc.). Only start using the
3D glasses again when the infection has disappeared
completely.
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Multi View

Textand TV

You can watch a TV channel in the small screen of
Multi View when you're watching Text.

To watch a TV channel while watching Text..

1- Press g MULTIVIEW .

2 - Select Multi View: On on screen. The channel
you were watching appears in the small screen.

3- Press = 4 or = -toswitch channelsinthe

small screen

To hide the small screen, press gJ MULTI
VIEW again and select Multi View: Off on screen.

14.2

App Gallery and TV

You can watch a TV channel in the small screen of
Multi View when you're watching an app in App
Gallery.

To watch a TV channel while watching an app in App
Gallery...

1- Press g3 MULTIVIEW .

2 - Select Multi View: On on screen. The channel
you were watching appears in the small screen.

3- Press = 4 or = - toswitch channelsin the
small screen

To hide the small screen, press g3 MULTI
VIEW again and select Multi View: Off on screen.

14.3

HDMI and TV

You can watch a TV channel in the small screen of
Multi View when you're watching video from a
connected HDMI device.

To watch a TV channel while watching video from
connected HDMI device...

1- Press gJMULTIVIEW .

2 - Select Multi View: On on screen. The channel
you were watching appears in the small screen.

3- Press = 4 or = -toswitch channelsinthe

small screen

To hide the small screen, press gJ MULTI
VIEW again and select Multi View: Off on screen.
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Settings

15.1
Picture

1- Press f£#, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Location> Home and press OK.

4 - Press < (left) repeatedly if necessary, to close
the menu.

Picture Style

Picture Settings

Select a Style

For easy picture adjustment, you can select a preset
Picture Style.

1- While watching a TV channel, press .

2 - Select Picture Style, and select one of the styles
in the list.

3 - Press 4 (left) repeatedly if necessary, to close
the menu.

The available styles are...

- Personal - The picture preferences you set during
the first start up.

- Vivid - Ideal for daylight viewing

- Natural - Natural picture settings

- Standard - Most energy conscious setting - Factory
setting

- Movie - Ideal for watching movies

- Photo - Ideal for viewing photos

Restore a Style

With a Picture Style selected, you can adjust any
picture setting in All Settings > Picture..

The selected style will store the changes you made.
We recommend to adjust the picture settings for the
style Personal only. The Picture Style - Personal can
save its settings for each individual connected device
in Sources menu.

To restore the style to its original setting...

1- While watching a TV channel, press .

2 - Select Picture Style, and select the Picture Style
you want to restore.

3 - Press the colour key == Restore Style , and press
OK. The style is restored.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Home or Shop

If the Picture Style is switched back to Vivid every
time you switch on the TV, the TV location is set
to Shop. A setting meant for in-store promotion.

To set the TV for Home use...
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Colour

With Colour, you can adjust the colour saturation of
the picture.

To adjust the colour...

1- Press ¢, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Colour and press p (right).

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Contrast

With Contrast, you can adjust the contrast of the
picture.

To adjust the contrast..

1- Press £, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Contrast and press p (right).

4 - Pressthe arrows A (up)or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Sharpness

With Sharpness, you can adjust the level of
sharpness in fine detail of the picture.

To adjust the sharpness..

1- Press £, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Sharpness and press § (right).

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.



3D Picture Settings

3D Contrast

If you are watching 3D pictures, you can adjust the
contrast of the 3D picture with 3D Contrast .

To adjust the 3D contrast...

1- Press f£#, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select 3D Contrast and press p (right).

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

3D Video Contrast

If you are watching 3D pictures, you can decrease
the range of the video contrast With 3D Video
Contrast. 3D Video Contrast are settings intended for
expert users.

To adjust the level...

1- Press {#, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Contrast> 3D Video
contrast, and press OK.

4 - Press the arrows A (up) or
the value.

5- Press ((left) repeatedly if necessary, to close
the menu.

v (down) to adjust

Advanced Picture Settings

Game or Computer

When you connect a device, the TV recognizes its
type and gives each device a correct type name. You
can change the type name if you wish. If a correct
type name for a device is set, the TV automatically
switches to the ideal TV settings when you switch to
this device in the Sources menu.

If you have a game console with a built-in Blu-ray
Disc player, you might have set the type name to Blu-
ray Disc. With  Game or Computer you can switch to
the ideal settings for gaming manually. Don't forget to
switch the Game or Computer setting off, when you
return to watch TV.

To switch the setting manually...

1- Press £, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Game or Computer, and
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select the device type you want to use. To switch
back to TV, select Off.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Colour Settings

Tint

With Tint, you can adjust the level of tint in fine detail
of the picture.

To adjust the tint...

1- Press ¢, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Colour and press OK.

4 - Select Tint, and press p (right).

5- Pressthe arrows 4 (up)or w (down) to adjust
the value.

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

Colour Enhancement

With Colour Enhancement, you can enhance the
colour intensity and the details in bright colours.

To adjust the level...

1- Press {¢, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Colour> Colour
Enhancement and press OK.

4 - Select Maximum, Medium, Minimum or Off.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

Colour Temperature

With Colour Temperature, you can set the picture to
a preset colour temperature or select Custom to set
a temperature setting yourself with  Custom Colour
Temperature. Colour Temperature and Custom
Colour Temperature are settings intended for expert
users.

To select a preset...

1- Press {¢, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Colour> Colour
Temperature and press OK.

4 - Select Normal, Warm or Cool. Or

select Custom if you want to customise a colour
temperature yourself.

5- Press 4 (left) repeatedly if necessary, to close



the menu.

the menu.

Custom Colour Temperature

With Custom Colour Temperature, you can set a
colour temperature yourself. To set a custom colour
temperature, first select Custom in the Colour
Temperature menu. Custom Colour Temperature is a
setting intended for expert users.

To set a custom colour temperature...

1- Press %, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Colour> Custom Colour
Temperature and press OK.

4 - Press the arrows A (up) or w (down) to adjust
the value. WP is white point and BL is black

level. You can also select one of the presets in this
menu.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Contrast Settings

Contrast Modes

With Contrast Mode, you can set the level at which
power consumption can be reduced by dimming the
intensity of the screen. Choose for the best power

consumption or for the picture with the best intensity.

To adjust the level...

1- Press f£#, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Contrast> Contrast
Mode and press OK.

4 - Select Standard, Best power, Best picture,

or Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Dynamic Contrast

With Dynamic Contrast, you can set the level at
which the TV automatically enhances the details in
the dark, middle and light areas of the picture.

To adjust the level...

1- Press f£#, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Contrast> Dynamic
Contrast and press OK.

4 - Select Maximum, Medium, Minimum or Off.
5- Press 4 (left) repeatedly if necessary, to close
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Brightness

With Brightness, you can set the level of brightness
of the picture signal. Brightness is a setting intended
for expert users. We recommend non-expert users to
adjust the brightness of the picture with

the Contrast setting.

To adjust the level...

1- Press £, select All Settings and press OK.
2 - Select Picture and press p (right) to enter the
menu.

3

- Select Advanced > Contrast> Brightness, and
press OK.

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Video Contrast

With Video Contrast, you can decrease the range of
the video contrast.

To adjust the level...

1- Press £, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced> Contrast> Video
Contrast, and press OK.

4 - Press the arrows A (up) or
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

v (down) to adjust

3D Video Contrast

If you are watching 3D pictures, you can decrease
the range of the video contrast With 3D Video
Contrast. 3D Video Contrast are settings intended for
expert users.

To adjust the level...

1- Press £, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Contrast> 3D Video
Contrast, and press OK.

4 - Press the arrows A (up) or
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

v (down) to adjust



Light Sensor

The Light Sensor adjusts the picture and Ambilight
settings automatically to the lighting conditions of the
room. You can switch Light Sensor on or off.

To switch on or off...

1- Press {%, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Contrast>
Sensor, and press OK.

4 - Select Onor Off.

5- Press 4« (left) repeatedly if necessary, to close
the menu.

Light

Gamma

With Gamma, you can set a non-linear setting for
picture luminance and contrast. Gamma is a setting
intended for expert users.

To adjust the level..

1- Press {%, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Contrast> Gamma, and
press OK.

4 - Press the arrows A (uUp) or
the value.

5- Press 4« (left) repeatedly if necessary, to close
the menu.

v (down) to adjust

Sharpness Settings

Ultra Resolution

With Ultra Resolution, you switch on a superior
sharpness in line edges and contours.

To switch on or off...

1- Press £, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Sharpness >
Resolution, and press OK.

4 - Select Onor Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Ultra

Noise Reduction

With Noise Reduction, you can filter out and reduce
the level of image noise.

To adjust the noise reduction...

1- Press {%, select All Settings and press OK.
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2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Sharpness> Noise
Reduction, and press p (right) to enter the menu.
4 - Select Maximum, Medium, Minimum or Off.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

MPEG Artefact Reduction

With MPEG Artefact Reduction, you can smoothen
the digital transitions in the picture. MPEG artefacts
are mostly visible as small blocks or jagged edges in
images.

To reduce the MPEG artefacts..

1- Press ¢, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Sharpness> MPEG
Artefact Reduction, and press p (right) to enter the
menu.

4 - Select Maximum, Medium, Minimum or Off.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

Motion Settings

Perfect Natural Motion

With Perfect Natural Motion, you can reduce the
motion judder, visible in movies on TV. Perfect Natural
Motion makes any movement smooth and fluent.

To adjust the motion judder...

1- Press {%, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced >
Motion, and press OK.
4 - Select Maximum, Medium, Minimum or Off.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

Motion > Perfect Natural

Picture Format

Basic

If the picture is not filling the whole screen, if black
bars are showing on the top or bottom or at both
sides, you can adjust the picture to fill the screen
completely.

To select one of the basic settings to fill the screen...

1- While watching a TV channel, press .
2 - Select Picture Format > Fill Screen or
Screen, and press OK.

Fit to



3 - Press 4 (left) repeatedly if necessary, to close
the menu.

- Fill Screen — automatically enlarges the picture to
fill the screen. Picture distortion is minimal, subtitles
remain visible. Not suitable for PC input. Some
extreme picture formats can still show black bars.

- Fit to Screen — automatically zooms in the picture
to fill the screen without distortion. Black bars may be
visible. Not suitable for PC input.

Advanced

If the two basic settings are inadequate to format the
picture you want, you can use the advanced settings.
With the advanced settings you manually format the
picture on your screen.

You can zoom, stretch and shift the picture until it
shows what you need — e.g. missing subtitles or
scrolling text banners . If you format the picture for a
specific Source — like a connected game console —
you can return to this setting the next time you use
the game console. The TV stores the last setting you
did for each connection.

To format the picture manually...

1- While watching a TV channel, press .

2 - Select Advanced and press OK.

3 - Use Shift, Zoom, Stretch or Original to adjust
the picture. Select Undo to return to the setting the
picture had when you opened Picture Format.

- Shift — Select on the arrows to shift the picture. You
can only shift the picture when it is zoomed in.

- Zoom — Select on the arrows to zoom in.

- Stretch — Select on the arrows to stretch the
picture vertically or horizontally.

- Undo — Select to return to the picture format you
started with.

- Original — Shows the original format of the
incoming picture. This is a 1:1 pixel on pixel format.
Expert mode for HD and PC input.

Quick Picture Setting

During the first installation, you did some picture
settings in a few easy steps. You can redo these steps
with Quick Picture Setting. To do these steps, make
sure the TV can tune to a TV channel or can show a
programme from a connected device.

To set the picture in a few easy steps..

1- Press {%, select All Settings and press OK.

2 - Select Picture and press p (right) to enter the
menu.

3 - Select Advanced > Quick Picture Setting, and
press OK.

4 - Select Start.

5 - Select the picture setting you prefer and go to the
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next setting.

6 - Finally select Finish.

7 - Press o (left) repeatedly if necessary, to close
the menu.

15.2
Sound

Sound Style

Select a Style

For easy sound adjustment, you can select a preset
setting with Sound Style.

1- While watching a TV channel, press .

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Sound Style, and select one of the styles
in the list.

4 - Press < (left) repeatedly if necessary, to close
the menu.

The available styles are...

- Personal - The sound preferences you set during
the first start up.

- Original - Most neutral sound setting

- Movie - |deal for watching movies

- Music - Ideal for listening to music

- Game - |deal for gaming

- News - Ideal for speech

Restore a Style

With a Sound Style selected, you can adjust any
sound settingin Setup > Sound..

The selected style will store the changes you made.
We recommend to adjust the sound settings for the
style Personal only. The Sound Style - Personal can
save its settings for each individual connected device
in Sources menu.

To restore the style to its original setting...

1- While watching a TV channel, press .

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Sound Style , and select the

Sound Style you want to restore.

4 - Press the colour key == Restore Style . The style
is restored

5- Press 4 (left) repeatedly if necessary, to close
the menu.



Sound Settings

Bass

With Bass, you can adjust the level of low tones in
the sound.

To adjust the level...

1- Press £, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Bass and press p (right).

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Treble

With Treble, you can adjust the level of high tones in
the sound.

To adjust the level...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Treble and press p (right).

4 - Press the arrows A (up) or w (down) to adjust
the value.

5 - Press 4 (left) repeatedly if necessary, to close
the menu.

Surround mode

With Surround Mode, you can set the sound effect of
the TV speakers.

To set the surround mode...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Surround mode and press p (right) to
enter the menu.

4 - Select Stereo or Incredible surround.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Sound Settings for Watching 3D

Incredible surround 3D

With Surround Mode, you can set the sound effect of
the TV speakers. If you select Incredible

Surround for 2D viewing, the TV will switch

to Incredible Surround 3D automatically when you
start watching 3D. If you do not want the TV to switch
automatically, select Offin Auto Surround 3D.

To set the surround mode...

1- Press {£¢, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Surround mode and press OK.

4 - Select Stereo, or Incredible surround 3D.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Auto surround 3D

With Auto Surround 3D, you can prevent the TV to
automatically switch to Incredible Surround 3D when
the TV is switched to 3D.

To switch on or off...

1- Press £, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Auto Surround 3D and press OK.

4 - Select Onor Off

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Advanced Sound Settings

Auto Volume Levelling

With Auto Volume Levelling, you can set the TV to
automatically level out sudden volume differences.
Typically at the beginning of adverts or when you are
switching channels.

To switch on or off...

1- Press #%, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced and press p (right) to enter
the menu.

4 - Select Auto volume levelling and

press p (right) to enter the menu.

5- Select Onor Off

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

Clear Sound

With Clear Sound, you improve the sound for
speech. Ideal for news programmes. You can switch
the speech improvement on or off.

To switch on or off...

1- Press £, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced > Clear sound and press OK.



4 - Select Onor Off, then press OK.
5 - Press 4 (left) repeatedly if necessary, to close
the menu.

Audio Out Format

With Audio Out Format you can set the audio out
signal of the TV to fit the sound processing
capabilities of your Home Theatre System.

To set Audio Out Format...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced >
press OK.

4 - Select Multichannel or Stereo, then press OK.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

Audio Out Format and

Audio Out Levelling

With Audio Out Levelling you can level the sound
volume of the Home Theatre System with the volume
of the TV when you switch over from one to another.

To level the difference in volume...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced > Audio Out Levelling and
press OK.

4 - Select More, Medium, or Less, then press OK.

5 - If the volume difference is large, select More. If
the volume difference is small, select Less.

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

Audio Out Delay

If you set an Audio sync delay on your Home Theatre
System, to synchronise the sound with the picture,
you must switch off Audio Out Delay on the TV,

To switch off Audio Out Delay...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced > Audio Out Delay and
press OK.

4 - Select Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.
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Audio Out Offset

If you cannot set a delay on the Home Theatre
System, you can set a delay on the TV with Audio
Out Offset.

To synchronise the sound on the TV...

1- Press {£¢, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced > Audio Out Offset and
press OK.

4 - Use the slider bar to set the sound offset and
press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Headphone volume

With Headphones Volume, you can set the volume
of a connected headphone separately.

To adjust the volume...

1- Press £, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Headphones Volume and press OK.

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Speakers

TV Speakers

You can send the TV sound to a connected audio
device - a Home Theatre System or audio system.

You can select where you want to hear the TV sound
and how you want to control it.

- If you select TV Speakers Off, you permanently
switch off the TV speakers.

- If you select TV Speakers On, the TV speakers are
always on.

With an audio device connected with HDMI CEC, you
can use one of the EasyLink settings.

- If you select EasyLink, the TV sends the TV sound
to the audio device. The TV will switch off the TV
speakers when the device is playing the sound.

- If you select EasyLink Autostart, the TV will switch
on the audio device, send the TV sound to the device
and switch off the TV speakers.

With EasyLink or EasyLink Autostart selected, you can
still switch to TV speakers if necessary.

To set the TV speakers..



1- Press {£#, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Advanced and press p (right) to enter
the menu.

4 - Select TV Speakers and press p (right) to
enter the menu.

5- Select TV Speakers On, TV Speakers

Off, EasyLink, or EasylLink Autostart .

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

To switch to speakers directly...

1- While watching TV, press £t.

2 - Select Speakers and select TV or
System.

3 - Press 4 (left) repeatedly if necessary, to close
the menu.

Audio

Wireless Speakers

What You Need

You can connect a wireless speaker — a subwoofer or
a sound bar — to this TV.

A range of selected Philips wireless speaker products
can connect and play the TV sound. Consult the
Philips website for suited wireless audio products for
this TV - www.philips.com/tv

To play the TV sound on a wireless speaker, you must
pair the wireless speaker with the TV. You can pair up
to 10 wireless speakers but you can only play the
sound on one wireless audio speaker at a time. If you
connect a subwoofer, the sound is played on the TV
and the subwoofer. If you connect a sound bar the
sound is played on the sound bar only.

Select a Speaker

To connect a wireless speaker...

1- Press %, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Wireless Speakers > Connecta
Speaker and press OK.

4 - Press < (left) repeatedly if necessary, to close
the menu.

Remove a Speaker

To remove a wireless speaker...

1- Press %, select All Settings and press OK.
2 - Select Sound and press p (right) to enter the
menu.

3 - Select Wireless Speakers > Remove a
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Speaker and press OK.
4 - Press < (left) repeatedly if necessary, to close
the menu.

Subwoofer Volume

To adjust the volume of wireless speaker...

1- Press {%, select All Settings and press OK.

2 - Select Sound and press p (right) to enter the
menu.

3 - Select Wireless Speakers > Subwoofer
Volume and press OK.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Problems

Lost connection

- Position the wireless speaker within a range of 5
meters from the TV.

- Places with a high amount of wireless activity -
apartments with lots of wireless routers - can hamper
the wireless connection. Keep the router and wireless
speaker as close to the TV as possible.

Audio and video mismatch

- Some wireless speakers systems might have audio
and video sync problems. We recommend using
Philips wireless audio products.

TV Placement

As part of the first installation, this setting is set to
either Ona TV stand or On the Wall. If you have
changed the placement of the TV since then, adjust
this setting accordingly for best sound reproduction.

1- Press f£#, select All Settings and press OK.

2 - Select TV Settings and press p (right) to enter
the menu.

3 - Select TV Placement and press OK.

4 - Select OnaTVstand or Onthe Wall.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

15.3

Ambilight


http://www.philips.com/tv

Ambilight Style

You can set a style for Ambilight. There are several
dynamic styles and one static style — a constant
colour. For the static style you can select the colour
yourself. Alternatively, you can switch Ambilight off.

To set the Ambilight Style...

1- Press @ (Ambilight).

2 - Select on the Ambilight Style you prefer. If you
select Static a colour palette appears. Select on a
colour in the palette to set the Static colour. To switch
Ambilight off, select Off.

Next to the setting Off, the available styles are...

- Standard
- Natural

- Immersive
- Vivid

- Game

- Comfort
- Relax

- Static

Ambilight Settings

Ambilight Brightness

With Ambilight Brightness, you can set the level of
brightness of the Ambilight.

To adjust the level...

1- Press %, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Brightness and press OK.

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Ambilight Brightness, at bottom side

To adjust the Ambilight brightness level at bottom
side...

1- Press {%, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Brightness Bottom Side and press OK.
4 - Pressthe arrows A (up)or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.
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Ambilight Saturation

With Ambilight Saturation, you can set the level of
colour saturation of the Ambilight.

To adjust the level...

1- Press {%, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Saturation and press OK.

4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Static Ambilight Colour

To adjust the level...

1- Press {¢, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Static Ambilight Colour and press OK.
4 - Press the arrows A (up) or w (down) to adjust
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Advanced Ambilight Settings

Wall Colour

With Wall Colour, you can neutralise the influence of
a coloured wall on the Ambilight colours. Select the
colour of the wall behind the TV and the TV will
modify the Ambilight colours to appear as they are
intended.

To select the colour of the wall . . .

1- Press ¢, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Advanced > Wall Colour and press OK.
4 - In the colour palette, select the colour that
matches the colour of the wall behind the TV.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

TV Switch Off

With TV Switch Off, you can set Ambilight to switch

off immediately or slowly fade out when you switch

off the TV. The slow fade out gives you some time to
switch on the lights in your living room.

To select the way how Ambilight switches off...

1- Press ¢, select All Settings and press OK.



2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Advanced > TV Switch Off and

press OK.

4 - Select Fade Out to Off or
Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Immediate Switch

Lounge Light Mood

When the TV is on Standby, you can switch Ambilight
on and create a Lounge Light effect in your room.

To select the a preset mood colour for Lounge Light..

1- Press £, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Advanced > Lounge Lightand

press OK.

4 - Select the mood you want.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

With the Philips TV Remote App on your smartphone
or tablet, you can set up a Lounge Light Mood colour
sequence yourself. In the list of moods, select TV
Remote App to use your latest Lounge Light creation
as Lounge Light Mood. With the TV in Standby and
your smartphone or tablet connected to the same
home network, you can change the current Lounge
Light Mood setting on your mobile device.

Lounge Light+hue

If you installed Ambilight+hue, you can let the hue
bulbs follow Lounge Light from Ambilight. The Philips
hue lamps will expand the Lounge Light effect across
the room. The hue bulbs are switched on and
automatically set to follow Lounge Light when you
configure Ambilight+hue. If you do not want the hue
bulbs to follow Lounge Light, you can switch the
bulbs off.

To switch the hue bulbs off..

1- Press %, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Advanced > Lounge Light+hue and
press OK.

4 - Select Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.
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Ambilight + Hue

Configure

With Configure, you can setup your Philips Hue bulbs
to follow the colours of Ambilight.

To setup your Philips Hue bulbs..

1- Press £, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Ambilight+hue > Configure, and

press OK.

4 - Select Start.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Switch Off

To switch off Ambilight+hue...

1- Press ¢, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Ambilight+hue > Switch Off, and
press OK.

4 - Select Off, then press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Immersion

With Immersion, you can adjust how accurate the
Hue bulbs follow the Ambilight.

To adjust Ambilight+hue immersion...

1- Press £, select All Settings and press OK.

2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Ambilight+hue >
press OK.

4 - Press the arrows A (up) or
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Immersion, and

v (down) to adjust

View Configuration

With View Configuration, you can view current setup
of the Ambilight+hue, network, the Bridge and bulbs.

To view Ambilight+hue configuration...

1- Press {%, select All Settings and press OK.
2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Ambilight+hue > View Configuration,



and press OK.

4 - Select Off, then press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Reset Configuration

To reset Ambilight+hue...

1- Press {%, select All Settings and press OK.
2 - Select Ambilight and press p (right) to enter
the menu.

3 - Select Ambilight+hue >
and press OK.

4 - Press < (left) repeatedly if necessary, to close
the menu.

Reset Configuration,

Light Sensor

To save energy, the built-in ambient light sensor
lowers the brightness of the TV screen when the
surrounding light darkens. The built-in light sensor
automatically adjusts the picture, together with
Ambilight, to the lighting conditions of the room.

To activate the light sensor...

1- Press {£¢, select All Settings and press OK.

2 - Select Eco Settings and press p (right) to
enter the menu.

3 - Select Light Sensor. Theicon & isshownin
front of Light Sensor when it is active.

4 - Press o (left) repeatedly if necessary, to close
the menu.

15.4

Eco Settings

Energy Saving

Eco settings & bundles the settings that help the
environment.

Energy Saving

If you select Energy Saving, the TV switches to Picture
Style - Standard automatically, the most ideal energy
conscious setting for the picture and Ambilight.

To set the TV in Energy Saving..

1- Press f£#, select All Settings and press OK.

2 - Select Eco Settings and press p (right) to
enter the menu.

3 - Select Energy Saving, the Picture Style is set to
Standard automatically.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Screen Off

If you only listen to music, you can switch off the TV
screen to save energy.

To only switch off the TV screen...

1- Press ¢, select All Settings and press OK.

2 - Select Eco Settings and press p (right) to
enter the menu.

3 - Select Screen Off.

4 - Press < (left) repeatedly if necessary, to close
the menu.

To switch the screen back on, press any key on the
remote control.
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Switch off timer

If the TV receives a TV signal but you don't press a
key on the remote control during a 4 hour period, the
TV switches off automatically to save energy. Also, if
the TV does not receive a TV signal nor a remote
control command for 10 minutes, the TV switches off
automatically.

If you use the TV as a monitor or use a digital receiver
to watch TV (a Set-Top Box - STB) and you do not
use the remote control of the TV, you should
deactivate this automatic switch off.

To deactivate the Switch Off Timer ...

1- Press £, select All Settings and press OK.

2 - Select Eco Settings and press p (right) to
enter the menu.

3 - Select Switch Off Timer. Select inside the slider
bar to adjust the value. The value 0 (Off) deactivates
the automatic switch off.

4 - Press < (left) repeatedly if necessary, to close
the menu.

Theicon & is shown in front of Switch Off Timer
when it is active.

15.5
General Settings

EasyLink

General Settings

To switch off EasyLink completely..

1- Press {£¢, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select EasyLink, press p (right) and

select EasylLink one step further.



4 - Select Off.
5 - Press 4 (left) repeatedly if necessary, to close
the menu.

EasyLink Remote Control

To switch off EasyLink remote control...

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select EasylLink > Easylink Remote

Control, and press OK.

4 - Select Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

HDMI Ultra HD

This TV can display Ultra HD signals. Some devices -
connected with HDMI - do not recognise a TV with
Ultra HD and might not work correctly or show
distorted picture or sound. To avoid the
malfunctioning of such a device, you can set the
signal quality to a level the device can handle. If the
device is not using Ultra HD signals, you can switch
off Ultra HD for this HDMI connection.

The setting UHD 4:4:4/4:2:2 allows UHD YCbCr 4:4:4
/ 4:2:2 signals. The setting UHD 4:2:0 allows UHD
YCbCr 4:2:0 signals.

To set the signal quality...

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Advanced > HDMI Ultra HD and

press OK.

4 - Select UHD 4:4:4/4:2:2, UHD 4:2:0 or

UHD Off and press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Android Settings

Access Android Settings menu to view or adjust the
settings for using Android Apps.

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Android Settings, and press OK.

4 - Press & BACK f necessary, to close the menu.
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USB Hard Drive

To set up and format a USB Hard Drive...

1- Press {¢, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select USB Hard Drive, and press OK.

4 - Select Start, then follow the instructions on
screen.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Philips Logo Brightness

You can switch off or adjust the brightness of the
Philips logo on the front of the TV.

To adjust or switch off...

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Philips Logo Brightness, and

press p (right) to enter the menu.

4 - Select Minimum, Medium, Maximum,

or Off to switch off the lighting of the logo, then
press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Remote Control Keyboard

To set the keyboard layout to Azerty...

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Remote Control Keyboard and

press OK.

4 - Select Azerty or Qwerty and press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

USB Keyboard Settings

To install the USB keyboard, switch on the TV and
connect the USB keyboard to one of

the USB connections on the TV. When the TV
detects the keyboard for the first time, you can select
your keyboard lay-out and test your selection. If you
select a Cyrillic or Greek keyboard layout first, you
can select a secondary Latin keyboard layout.

To change the keyboard layout setting when a layout
was selected...

1- Press f%, select All Settings and press OK.
2 - Select General Settings and press p (right) to



enter the menu.
3 - Select USB Keyboard Settings, and press OK to
start the keyboard setup.

HbbTV

If a TV channel offers HobTV pages, you must first

switch on HbbTV in the TV settings to view the pages.

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select HbbTV, and press OK.

4 - Select On or Off.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

If you want to avoid access to HbbTV pages on a
specific channel, you can block the HbbTV pages for
this channel only.

1- Tune to the channel of which you want to block
the HbbTV pages.

2 - Press = OPTIONS and select HBB TV on This
Channel and press OK.

3 - Select Off and press OK.

Switch Off Timer

To deactivate the Switch Off Timer ...

1- Press %, select All Settings and press OK.

2 - Select Eco Settings and press p (right) to
enter the menu.

3 - Select Switch Off Timer. Select inside the slider
bar to adjust the value. The value 0 (Off) deactivates
the automatic switch off.

4 - Press < (left) repeatedly if necessary, to close
the menu.

Theicon & is shown in front of Switch Off Timer
when it is active.

Home or Shop

If the TV is installed in a shop, you can set the TV to
display an in store promotion banner. Picture
Styleis setto Vivid automatically. Switch Off
Timer is switched off.

To set the TV to Shop location...

1- Press {¢, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Location>  Shop, and press OK.

4 - Press < (left) repeatedly if necessary, to close
the menu.

If you use the TV at home, set the TV in Home
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location.

Shop Setup

If the TV is setto Shop, you can set the availablility of
a specific demo for in store use.

1- Press f%, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Shop Setup and press p (right) to enter
the menu.

4 - Select Off or
store demo

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Feature Promotion Banner as in

TV Placement

As part of the first installation, this setting is set to
either Ona TV stand or On the Wall. If you have
changed the placement of the TV since then, adjust
this setting accordingly for best sound reproduction.

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select TV Placement and press OK.

4 - Select OnaTVstand or On the Wall.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

TV Guide

For more information, press == Keywords and look
up TV Guide, data and information.

Channel Logos

In some countries, the TV can show the channel
logos.

If you do not want these logos to appear, you can
switch them off.

To switch off the logos..

1- Press £, select All Settings and press OK.

2 - Select Channel Logos and press p (right) to
enter the menu.

3 - Select Off and press OK.

4 - Press < (left) repeatedly if necessary, to close
the menu.



Factory Settings

You can set the TV back to the original TV settings
(the factory settings) for picture, sound and Ambilight.

To switch back to the original settings...

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Factory Settings and press OK.

4 - Press < (left) repeatedly if necessary, to close
the menu.

Child Lock

Parental Rating

To set a minumum age to watch rated programmes...

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Child Lock > Parental Rating, and
select one of the age in the list.

4 - Press < (left) repeatedly if necessary, to close
the menu.

App Lock

To lock App Gallery apps unsuited for children...

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Child Lock > App Lock and press
4 - Select Onor Off, then press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

OK.

Set Code / Change Code

The Child Lock PIN code is used to lock or unlock
channels or programmes.

To set the lock code or to change the current code..

1- Press {%, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Child Lock> Set Code
Code OK

4 - Enter a 4 digit code of your choice. If a code is set
already, enter the current Child Lock code and then
enter the new code twice.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Change

The new code is set.

Forgotten your Child Lock PIN code?

58

If you forgot your PIN code, you can override the
current code and enter a new code.

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Child Lock > Change Code and

press OK.

4 - Enter the overriding code 8888.

5 - Now enter a new Child Lock PIN code and enter it
again to confirm.

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

The new code is set.

Reinstall TV

You can redo a full TV installation. The TV is
completely reinstalled.

To redo a full TV installation...

1- Press {%, select All Settings and press OK.

2 - Select General Settings and select Reinstall
TV.

3 - Follow the instructions on screen. The installation
may take a few minutes.

15.6
Clock, Region and Language

Menu Language

To change the language of the TV menus and
messages...

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Language > Menu Language and
press OK.

4 - Select on the language you need.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Language preferences

Audio Language Settings

Digital TV channels can broadcast audio with several
spoken languages for a programme. You can set a
preferred primary and secondary audio language. If
audio in one of these languages is available, the TV
will switch to this audio.

If none of the preferred audio languages is available,



you can select another audio language which is
available.

To set the primary and secondary audio language...

1- Press %, select All Settings and press OK.

2 - Selec General Settings and press p (right) to
enter the menu.

3 - Select Languages > Primary

Audio or Secondary Audio and press OK.

4 - Select on the language you need.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

To select an audio language when none of your
preferred audio language is available..

1- Press == OPTIONS .
2 - Select Audio Language and select on the audio
language you want temporarily.

Subtitles

Switch On

To switch on Subtitles, press SUBTITLE.

You can switch subtitles On, Off or On During
Mute.

Or to show subtitles automatically when the
broadcasted programme is not in language — the
language set for the TV — select Automatic. This
setting will also show Subtitles automatically when
you mute the sound.

Subtitle Language Settings

Digital channels can offer several subtitle languages
for a programme. You can set a preferred primary and
secondary subtitle language. If subtitles in one of
these languages are available, the TV will show the
subtitles you selected.

If none of the preferred subtitle languages are
available, you can select another subtitle language
which is available.

To set the primary and secondary subtitle language..

1- Press %, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Languages> Primary

Subtitles or Secondary Subtitles and press OK.

4 - Select on the language you need.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

To select a subtitle language when none of your
preferred languages are available..

1- Press == OPTIONS .
2 - Select Subtitle Language and select on the
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language you want temporarily.

Subtitles from Text

If you tune to an analogue channel, you need to
make the subtitles available for each channel
manually.

1- Switch to a channel and press TEXT to open
Text.

2 - Enter the page number for subtitles, usually 888.
3 - Press TEXT again, to close Text.

If you select On in the Subtitle menu when watching
this analogue channel, subtitles will be shown if
available.

To know if a channel is analogue or digital, switch to
the channel and open Channel
Infoin == OPTIONS.

Text / Teletex Languages

Text Pages

To open Text/Teletext press TEXT, while you are
watching TV channels.
To close Text, press TEXT again.

Select a Text page
To select a page . ..

1- Enter the page number with the number keys.
2 - Use the arrow keys to navigate.

3 - Press a colour key to select a colour-coded
subject at the bottom of the screen.

Text sub-pages

A Text page number can hold several subpages. The
subpage numbers are shown on a bar next to the
main page number.

To select a subpage, press qor p.

T.O.P. Text pages

Some broadcasters offer T.O.P. Text.
To open T.O.P. Text pages within Text,
press == OPTIONS and select T.O.P. overview.

Favourite pages

The TV makes a list of the last 10 Text pages you
opened. You can easily reopen them again in the
Favourite Text pages column.

1- In Text, select the star in the top left corner of
the screen to show the column of favourite pages.

2 - Press w (down)or A (up)to select a page
number and press OK to open the page.

You can clear the list with the option Clear favourite
pages.

Search Text



You can select a word and scan Text for all
occurences of this word.

1- Open a Text page and press OK.

2 - Select a word or number with the arrow keys.

3 - Press OK again to jump immediately to the next
occurence of this word or number.

4 - Press OK again to jump to the subsequent
occurence.

5 - To stop searching, press A (up) until nothing is
selected.

Text from a connected device

Some devices that receive TV channels can also offer
Text.
To open Text from a connected device . . .

1- Press = select the device and press OK.

2 - While watching a channel on the device,

press == OPTIONS , select Show device keys and
select the B3 key and press OK.

3 - Press & BACK to hide the device keys.

4 - To close Text, press & BACK again.

Digital Text (UK only)
Some digital broadcasters offer dedicated Digital Text
or interactive TV on their digital TV channels. This

includes normal Text using the number, colour and
arrow keys to select and navigate.

To close Digital Text, press & BACK.

Text Options

In Text/Teletext, press == OPTIONS to select the
following...

- Freeze page

To stop the automatic rotation of subpages.

- Dual screen / Full screen

To show the TV channel and Text alongside each
other.

- T.O.P. overview

To open T.O.P. Text.

- Enlarge

To enlarge the Text page for comfortable reading.
- Reveal

To unhide hidden information on a page.

- Cycle subpages

To cycle subpages when these are available.

- Language

To switch the group of characters that Text uses to
display correctly.

- Text 2.5

To activate the Text 2.5 for more colours and better
graphics.
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Text Setup

Text language

Some digital TV broadcasters have several Text
languages available.
To set your primary and secondary Text language . . .

1- Press {%, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Language >
Text and press OK.

4 - Select your preferred Text languages.

5- Press 4« (left) repeatedly if necessary, to close
the menu.

Text 2.5

Primary Text or Secondary

If available, Text 2.5 offers more colours and better
graphics. Text 2.5 is activated as a standard factory
setting.

To switch off Text 2.5...

1- Press TEXT.

2 - With Text/Teletext open on screen,

press == OPTIONS.

3 - Select Text25> Off.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Clock

Date and Time

Automatic

To know what time it is, press €. The Home
Menu always shows what time it is.

In some countries, digital broadcasts do not send UTC
- Coordinated Universal Time information. The
daylight saving change might be ignored and the TV
might show an incorrect time.

When you record programmes - scheduled in the TV
Guide, we recommend not to change the time and
date manually. In some countries, for some network
operators, the Clock setting is hidden to avoid an
incorrect clock setting.

To correct the TV clock automatically...

1- Press {%, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Clock> Auto Clock Mode, and

select Country dependent.

4 - Select Daylight saving and select the
appropriate setting.

5- Press 4 (left) repeatedly if necessary, to close
the menu.



Manual

To set the TV clock manually...

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Clock> Auto Clock Mode, and

select Manual.

4 - Select Dateand Time to adjust.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Time Zone

To set the time zone...

1- Press £, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Clock> Time Zone, and press OK.

4 - Select one of the time zones.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

Sleep Timer

With the Sleep Timer, you can set the TV to switch to
Standby automatically after a preset time.

To set the Sleep Timer...

1- Press {£%, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Sleep Timer and press p (right). With
the slider bar you can set the time to up to 180
minutes in increments of 5 minutes. If setto O
minutes, the Sleep Timer is switched off. You can
always switch off your TV earlier or reset the time
during the countdown.

4 - Press o (left) repeatedly if necessary, to close
the menu.

15.7
Universal Access

Switch On

With Universal Access switched on, the TV is
prepared for use for the deaf, hard of hearing, blind or
partially sighted people.

Switch on

If you did not switch on Universal Access during the
installation, you can still switch it on in Universal
Access menu.

To switch on Accessibility...
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1- Press f£#, select All Settings and press OK.

2 - Select Universal Access and press p (right) to
enter the menu.

3 - Select Universal Access one step further.

4 - Select Onand press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

With Universal Access switched on, the
option Universal Access is added in the Options
menu.

Hard of Hearing

Some digital TV channels broadcast special audio and
subtitles adapted for the hard of hearing or deaf
people. With Hearing impaired switched on, the TV
automatically switches to the adapted audio and
subtitles, if available. Before you can switch

on Hearing impaired, you have to switch

on Universal Access.

To switch on Hearing impaired...

1- Press ¢, select All Settings and press OK.

2 - Select Universal Access and press p (right) to
enter the menu.

3 - Select Hearing impaired and press p (right) to
enter the menu.

4 - Select Onand press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

To switch on Hearing impaired while watching TV...

1 - While watching a TV channel,

press == OPTIONS , select Universal Access and
press OK.

2 - Select Hearing impaired, and select On.

To check whether a hearing impaired audio language
is available, press == OPTIONS , select Audio
Language and look for an audio language marked
witha »+.

If Accessibility does not appear in the Options menu,
switch on Universal Access in setup menu.

Audio Description

Switch On

Digital TV channels can broadcast special audio
commentary describing what is happening on
screen.

To be able to set the visually impaired audio and
effects, you have to switch on Audio

Description first.

Also, before you can switch on Audio Description,
you have to switch on Universal Access in setup
menu.



With Audio Description, a narrator's commentary is
added to the normal audio.
To switch on the commentary (if available)...

To switch on Audio Description...

1- Press {%, select All Settings and press OK.

2 - Select Universal Access and press p (right) to
enter the menu.

3 - Select Audio Description and press p (right) to
enter the menu.

4 - Select Audio Description one step further

5- Select Onand press OK.

6 - Press 4 (left) repeatedly if necessary, to close
the menu.

To switch on Audio Description while watching TV...

1 - While watching a TV channel,

press == OPTIONS , select Universal Access and
press OK.

2 - Select Audio Description, and select On.

You can check if an audio commentary is available.
In the Options menu, select Audio Language and
look for an audio language marked with a @t.

Mixed Volume

You can mix the volume of the normal audio with the
audio commentary.

To mix the volume...

1- Press f£#, select All Settings and press OK.

2 - Select Universal Access and press p (right) to
enter the menu.

3 - Select Audio Description > Mixed Volume and
press OK.

4 - Press the arrows A (up) or
the value.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

v (down) to adjust

If an audio language with added audio commentary is
available, you can also find this setting

in == OPTIONS > Universal Access > Mixed
Volume.

Audio Effect

Some audio commentary can hold extra audio
effects, like stereo or fading sound.

To switch on Audio effects (if available)..

1- Press ¢, select All Settings and press OK.

2 - Select Universal Access and press p (right) to
enter the menu.

3 - Select Audio Description > Audio Effects and
press OK.

4 - Press o (left) repeatedly if necessary, to close
the menu.
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Speech

The audio commentary can also hold subtitles for the
words which are spoken.

To switch on these subtitles (if available) . ..

1- Press {%, select All Settings and press OK.

2 - Select Universal Access and press p (right) to
enter the menu.

3 - Select Audio Description > Speech and press
OK.

4 - Select Descriptive or Subtitles and press OK.
5- Press 4 (left) repeatedly if necessary, to close
the menu.

15.8
Wireless and Networks

Network

Connect to your home network, wired or wireless. Or
adjust the network settings.

For more information, press == Keywords and look
up Network, connect or Network, settings.

Bluetooth

Search for Devices

To make a Bluetooth connection..

1- Press £, select All Settings and press OK.
2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Bluetooth > Search Bluetooth
Device and press OK.

4 - Follow the instructions on screen.

Remove Device

To remove a Bluetooth connection...

1- Press £, select All Settings and press OK.
2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Bluetooth > Remove Device and
press OK.

Switch on a Bluetooth device

To switch on or off Bluetooth connection on your TV...

1- Press {%, select All Settings and press OK.
2 - Select Wireless and Networks and

press p (right) to enter the menu.

3 - Select Bluetooth > Bluetooth On/Off and



press OK.

4 - Select On and press OK.

5- Press 4 (left) repeatedly if necessary, to close
the menu.

15.9

Android Settings

Access Android Settings menu to view or adjust the
settings for using Android Apps.

1- Press {%, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Android Settings, and press OK.

4 - Press & BACK if necessary, to close the menu.
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16

Channel Installation

16.1
Antenna/Cable Installation

Update Channels

Automatic Channel Update

If you receive digital channels, you can set the TV to
automatically update these channels.

Once a day, at 6 AM, the TV updates the channels
and stores new channels. New channels are stored in
the Channels List and are marked witha .
Channels without a signal are removed. The TV must
be in Standby to automatically update channels. You
can switch off Automatic Channel Update.

To switch off the automatic update..

1- Press %, select All Settings and press OK.

2 - Select Antenna/Cable Installation > Automatic
Channel Update and select Off.

3 - Press o (left) repeatedly if necessary, to close
the menu.

When new channels are found or if channels are
updated or removed, a message is shown at TV start
up. To avoid this message to appear after every
channel update, you can switch it off.

To switch off the message...

1- Press 4%

2 - Select Antenna/Cable Installation > Channel
Update Message and select Off.

3 - Press 4 (left) repeatedly if necessary, to close
the menu.

In certain countries, the Automatic channel update is
done while watching TV or on any moment when the
TV is in Standby.

Manual Channel Update

You can always start an channel update yourself.
To start a channel update manually...

1- Press %, select All Settings and press OK.

2 - Select Antenna/Cable Installation > Search for
Channels, then press OK.

3 - Select Start and press OK.

4 - Follow the instructions on screen. The update
may take a few minutes.
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Reinstall Channels

Reinstall Channels

You can reinstall all channels and leave all other TV
settings untouched.

If a child lock code is set, you will need to enter this
code before you can reinstall channels.

To reinstall channels...

1- Press {%, select All Settings and press OK.

2 - Select Antenna/Cable Installation > Search for
Channels and select Start.

3 - Select Reinstall Channels, then press OK.

4 - Follow the instructions on screen. The installation
may take a few minutes.

Reinstall TV

You can redo a full TV installation. The TV is
completely reinstalled.

To redo a full TV installation...

1- Press %, select All Settings and press OK.

2 - Select General Settings and select Reinstall TV.
3 - Follow the instructions on screen. The installation
may take a few minutes.

Factory Settings

You can set the TV back to the original TV settings
(the factory settings) for picture, sound and Ambilight.

To switch back to the original settings...

1- Press {¢, select All Settings and press OK.

2 - Select General Settings and press p (right) to
enter the menu.

3 - Select Factory Settings and press OK.

4 - Press o (left) repeatedly if necessary, to close
the menu.

Channel List Copy

Introduction

Channel List Copy is intended for dealers and expert
users. In some countries, Channel List Copy is only
available for copying satellite channels.

With Channel List Copy, you can copy the channels
installed on one TV onto another Philips TV of the
same range. With Channel List Copy, you avoid the
time-consuming channel search by uploading a
predefined channel list on a TV. Use a USB flash drive
of minimum 1 GB.

Conditions



- Both TVs are from the same year range.

- Both TVs have the same hardware type. Check the
hardware type on the TV type plate on the back of
the TV. Typically notedas Q . . . LA

- Both TVs have compatible software versions.

Current software version
You can check the current version of the TV software

within £ > Update Software > Current Software
Info.

Copy Channel List

To copy a channel list...

1- Switch on the TV. This TV should have channels
installed.

2 - Plugina USB flash drive.

3 - Press %, select All Settings and press OK.

4 - Select General Settings and press p (right) to
enter the menu.

5 - Select Channel List Copy and select Copy to
USB. You might be asked to enter the Child Lock PIN
code to copy the channel list.

6 - When copying is done, unplug the USB flash
drive.

7 - Press 4 (left) repeatedly if necessary, to close
the menu.

Now you can upload the copied channel list onto
another Philips TV.

Upload Channel List

To not Installed TVs

Depending on whether your TV is already installed or
not, you must use a different method to upload a
channel list.

To a TV that is not yet installed

1- Plugin the power plug to start the installation and
select language and country. You can skip the
channel search. Finish the installation.

2 - Plugin the USB flash drive that holds the channel
list of the other TV.

3 - To start the channel list upload, press .

4 - Select General Settings and press p (right) to
enter the menu.

5 - Select Channel List Copy and select Copy to
TV. You might be asked to enter the Child Lock PIN
code of this TV.

6 - The TV notifies you if the channel list is copied to
the TV successfully. Unplug the USB flash drive.
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To Installed TVs

Depending on whether your TV is already installed or
not, you must use a different method to upload a
channel list.

To an already installed TV

1- Verify the country setting of the TV. (To verify this
setting, press $¢. Select Antenna/Cable
Installation and select Reinstall channels.

Press 4 and later Cancel to leave the installation.)
If the country is correct continue with step 2.

If the country is not correct, you need to start a
reinstallation. To start the reinstallation,

press {£¢. Select Antenna/Cable Installation and
select Reinstall channels. Select the correct country
and skip the channels search. Finish the installation.
When done, continue with step 2.

2 - Plug in the USB flash drive that holds the channel
list of the other TV.

3 - To start the channel list upload, press  &%.

4 - Select General Settings and press p (right) to
enter the menu.

5 - Select Channel List Copy and select Copy to
TV. You might be asked to enter the Child Lock PIN
code of this TV.

6 - The TV notifies you if the channel list is copied to
the TV successfully. Unplug the USB flash drive.

DVB-T or DVB-C

DVB-T or DVB-C Reception

During the channel installation, just before you search
for channels, you selected Antenna (DVB-T) or Cable
(DVB-C). Antenna DVB-T searches for terrestrial
analogue channels and digital DVB-T channels. Cable
DVB-C searches for analogue and digital channels
available from a cable DVB-C operator.

DVB-C Channel Installation

For ease of use, all DVB-C settings are set to
automatic.

If your DVB-C operator gave you specific DVB-C
values, the network ID or network frequency, enter
these values when the TV asks for them during
installation.

Channel Number Conflicts

In some countries, different TV channels
(broadcasters) might have the same channel number.
While installing, the TV shows the list with channel
number conflicts. You need to select which TV
channel you want to install on a channel number with
multiple TV channels.



DVB Settings

Network Frequency Mode

If you intend to use the fast Quick Scan method

in Frequency Scan to search for channels,

select Automatic. The TV will use 1 of the predefined
network frequencies (or HC - homing channel) as
used by most cable operator in your country.

If you received a specific network frequency value to
search for channels, select Manual.

Network Frequency

With the Network Frequency Mode setto Manual,
you can enter the network frequency value received
from your cable operator here. To enter the value, use
the number keys.

Frequency Scan

Select the method of searching for channels. You can
select the faster Quick Scan method and use the
predefined settings used by most cable operator in
your country.

If this results in having no channels installed or if
some channels are missing, you can select the
extended Full Scan method. This method will take
more time to search for and install channels.

Frequency Step Size

The TV searches for channels in steps of 8MHz.

If this results in having no channels installed or if
some channels are missing, you can search in smaller
steps of TMHz. Using the TMHZz steps will take more
time to search for and install channels.

Digital Channels

If you know your cable operator is not offering digital
channels, you can skip searching for digital channels.

Analogue Channels

If you know your cable operator is not offering
analogue channels, you can skip searching for
analogue channels.
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Free / Scrambled

If you have a subscription and a CAM - Conditional
Access Module for pay TV services, select Free +
Scrambled. If you did not subscribe to pay TV
channels or services, you can select Free
Channels Only .

For more information, press the colour
key == Keywords and lookup CAM, Conditional
Access Module.

Reception Quality

You can check the quality and signal strength of a
digital channel. If you have your own antenna, you
can reposition the antenna to try and improve the
reception.

To check the reception quality of a digital channel...

1- Tune to the channel.

2 - Press .

3 - Select General Settings and press p (right) to
enter the menu.

4 - Select Antenna/Cable Installation and select
Digital: Test Reception .

The digital frequency is shown for this channel. If the
reception is poor, you can reposition your antenna.
To check the signal quality of this frequency again,
select Search and press OK.

To enter a specific digital frequency yourself, use the
remote control digit keys. Alternatively, select the
frequency, position the arrows on a number

with qand p and change the number

with A and w. To check the frequency,

select Search.

If you use DVB-C to receive channels, the

options Symbol Rate Mode and Predefined
Symbol Rates are available. For Symbol Rate Mode,
select Automatic, unless your cable operator gave
you a specific symbol rate value. To enter the symbol
rate value, use the number keys.

Manual Installation

Analogue TV channels can be manually installed,
channel by channel.

To install analogue channels manually...

1- Press {¢, select All Settings and press OK.

2 - Select TV Settings and press p (right) to enter
the menu.

3 - Select Antenna/Cable Installation and select
Analogue: Manual Installation .

- System
To set up the TV system, select System.
Select your country or the part of the world where



YyOu are Nnow.

- Search Channel

To find a channel, select Search Channel.

Select Search. You can also enter a frequency
yourself. If the reception is poor, press Search again.
If you want to store the channel, select Done.

- Store

You can store the channel on the current channel
number or as a new channel number.

Select Store Current Channel or Store as New
Channel.

You can redo these steps until you have found all
available analogue TV channels.

16.2
Satellite Installation

Installing Satellites

About Installing Satellites

This TV has two built-in satellite DVB-S/DVB-S2
tuners.

Up to 4 Satellites

You can install up to 4 satellites (4 LNBs) on this TV.
Select the exact number of satellites you wish to
install at the start of the installation. This will speed up
the installation.

Unicable

You can use a Unicable system to connect the
antenna dish to the TV. You can select Unicable for 1
or for 2 satellites at the start of the installation.

MDU - Multi-Dwelling-Unit

The built-in satellite tuners support MDU on the Astra
satellites and for Digiturk on the Eutelsat satellite.
MDU on Turksat is not supported.

Start the Installation

Make sure your satellite dish is connected correctly
and is perfectly aligned before you start the
installation.

To start the satellite installation...

1- Press f£#, select All Settings and press OK.

2 - Select Channels> Satellite Installation and
press OK. Enter your PIN code if necessary.

3 - Select Search for Satellite and press OK.

4 - Select Search and press OK. TV will search for
satellites.

5 - Select Install and press OK. The TV shows the
current satellite installation setup.

If you want to change this setup, select Settings.
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If you don't want to change the setup, select Search.
Go to step 5.

6 - In Installation System, select the number of
satellites you want to install or select one of the
Unicable systems. When you select Unicable, you
can choose the User Band Numbers and enter the
User Band Frequencies for each tuner. In some
countries, you can adjust some expert settings for
each LNB in More Settings.

7 - The TV will search for the satellites available on
the alignment of your antenna dish. This may take a
few minutes. If a satellite is found, its name and
reception strength are shown on screen.

8 - When the TV found the satellites you need,
select Install.

9 - If a satellite offers Channel Packages, the TV will
show the available packages for that satellite. Select
the package you need. Some packages offer

a Quick or Fullinstall for their available channels,
select one or the other. The TV will install the satellite
channels and radio stations.

10 - To store the satellite setup and installed
channels and radio stations, select Finish.

Satellite CAMs

If you use a CAM — a Conditional Access Module with
a smart card — to watch satellite channels, we
recommend to do the satellite installation with the
CAM inserted in the TV.

Most CAMs are used to descramble channels.

Newest generation CAMs (Cl+ 1.3 with Operator
Profile), can install all the satellite channels by
themselves on your TV. The CAM will invite you to
install its satellite(s) and channels. These CAMs not
only install and descramble the channels but also
handle regular channel updates.

Channel Packages

Satellites can offer channel packages that bundle free
channels (free-to-air) and offer a sorting that suits a
country. Some satellites offer subscription packages -
a collection of channels you pay for.

If you choose a subscription package, the TV might
ask you to select a Quick or Full installation.

Select Quick to install the channels of the package
only or select Full to install the package and all
other available channels too. We recommend a Quick
installation for subscription packages. If you have
additional satellites that are not part of your
subscription package, we recommend a Full
installation. All installed channels are putin the
channels list All.



Unicable Setup

The Unicable System

You can use a Single Cable system, MDU or Unicable
system to connect the antenna dish to the TV. A
Single Cable system uses one cable to connect the
satellite dish to all satellite tuners in its system. A
Single Cable system is typically used in apartment
buildings. If you use a Unicable system, the TV will ask
you to assign a user band number and corresponding
frequency during the installation. You can install 1 or 2
satellites with Unicable on this TV.

If you notice some missing channels after a Unicable
installation, another installation might have been
done at the same moment on the Unicable system.
Do the installation again to install the missing
channels.

User Band Number

In a Unicable system, each connected satellite tuner
must be numbered (e.g. 0,1, 2 or 3 etc.).

You can find the available user bands and their
number on the Unicable switchbox. User band is
sometimes shortened as UB. There are Unicable
switchboxes that offer 4 or 8 user bands. If you select
Unicable in the settings, the TV will ask you to assign
the unigue user band number for each built-in
satellite tuners. A satellite tuner cannot have the same
user band number as another satellite tuner in the
Unicable system.

User Band Frequency

Next to the unique user band number, the built-in
satellite receiver needs the frequency of the selected
user band number. These frequencies are mostly
shown next to the user band number on a Unicable
switchbox.

Automatic Channel Update

If you receive digital satellite channels, you can set
the TV to automatically update these channels.

Once a day, at 6 AM, the TV updates the channels
and stores new channels. New channels are stored in
the Channels List and are marked witha x .
Channels without a signal are removed and if a
satellite operator reorders its channel package, the
channel list of the TV will be updated. The TV must
be in Standby to automatically update channels. You
can switch off Automatic Channel Update.

To switch off the automatic update..
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1- Press f£#, select All Settings and press OK.

2 - Select Satellite Installation > Automatic
Channel Update and select Off.

3 - Press 4 (left) repeatedly if necessary, to close
the menu.

You can set the TV to only update the channels of a
specific satellite.

To mark satellites for updating...

1- Press £, select All Settings and press OK.

2 - Select Satellite Installation and

select Automatic Update Option. In the list of
satellites, select a satellite to mark or unmark.

3 - Press 4 (left) repeatedly if necessary, to close
the menu.

In certain countries, the automatic channel update is
done while watching TV or on any moment when the
TV is in Standby:.

Manual Channel Update

You can always start an channel update yourself.
To start a channel update manually...

1- Press {£¢, select All Settings and press OK.
2 - Select Satellite Installation > Search for
Channels and select Update Channels.

3 - Follow the instructions on screen. The update
may take a few minutes.

Add a Satellite

You can add an additional satellite to your current
satellite installation. The installed satellites and their
channels remain untouched. Some satellite operators
do not allow adding a satellite.

The additional satellite should be seen as an extra, it
is not your main satellite subscription or not the main
satellite of which you use its channel package.
Typically, you would add a 4th satellite when you
have 3 satellites already installed. If you have 4
satellites installed, you might consider removing one
first to be able to add a new satellite.

Setup

If you currently have only 1 or 2 satellites installed, the
current installation settings might not allow adding an
extra satellite. If you need to change the installation
settings, you must redo the complete satellite
installation. You cannot use Add satellite if a change
of settings is needed.

To add a satellite..

1- Press £, select All Settings and press OK.
2 - Select Satellite Installation > Search for
satellite and select Add Satellite. The current



satellites are shown.

3 - Select Search. The TV will search for new
satellites.

4 - If the TV has found one or more satellites,
select Install. The TV installs the channels of the
found satellites.

5 - To store the channels and radio stations,
select Finish.

Remove a Satellite

You can remove one or more satellites from your
current satellite installation. You remove the satellite
and its channels. Some satellite operators do not
allow removing a satellite.

To remove satellites...

1- Press f£t, select All Settings and press OK.

2 - Select Satellite Installation > Search for
satellite and select Remove Satellite. The current
satellites are shown.

3 - Select on the satellite(s) to mark or unmark them
to remove.

4 - Select Remove. The satellites are removed.

5 - Select Exitto close Remove Satellite.

Manual Installation

Manual Installation is intended for expert users.

You can use Manual Installation to quickly add new
channels from a satellite transponder. You need to
know the frequency and polarization of the
transponder. The TV will install all channels of that
transponder. If the transponder was installed before,
all its channels - the former and the new ones - are
moved to the end of the channel list All.

You cannot use Manual installation if you need to
change the number of satellites. If this is needed, you
have to do a complete installation with Install
Satellites.

To install a transponder...

1- Press ¢, select All Settings and press OK.

2 - Select Satellite Installation and select Manual
Installation.

3 - If you have more than 1 satellite installed, select
the satellite/LNB for which you want to add channels.
4 - Set the Polarization you need. If you set

the Symbol Rate Mode to Manual, you can enter
the symbol rate in Symbol Rate manually. Enter
the Frequency and start searching for the
transponder.

5 - If atransponder is found, select Store to store
the new transponder on the selected LNB.

6 - Select Exitto leave the manual installation.

LNB Settings

In some countries, you can adjust some expert
settings for each LNB.

LNB Power
By default, LNB Power is set to On.

22 kHz Tone
By default, the Tone is set to Auto.

Low LO Frequency / High LO Frequency

The local oscillator frequencies are set to standard
values. Adjust the values only in case of exceptional
equipment that needs different values.

Problems

The TV cannot find the satellites | want or the TV
installs the same satellite twice

- Make sure that the correct number of satellites is set
in Settings at the start of the installation. You can set
the TV to search for One, Two or 3/4 satellites.

A dual head LNB cannot find a second satellite

- If the TV finds one satellite but cannot find a second
one, turn the dish a few degrees. Align the dish to get
the strongest signal on the first satellite. Check the
signal strength indicator of the first satellite on screen.
With the first satellite set at the strongest signal, select
Search again to find the second satellite.

- Make sure the settings are set to Two Satellites.

Changing the installation settings did not solve my
problem

- All settings, satellites and channels are only stored
at the end of the installation when you finish.

All satellite channels are gone

- If you use a Unicable system, make sure you
assigned two unique user band numbers for both
built-in tuners in the Unicable settings. It might be
that another satellite receiver in your Unicable system
is using the same user band number.

Some satellite channels seem to have disappeared
from the channel list

- If some channels seem to be gone or displaced, the
broadcaster might have changed the transponder
location of these channels. To restore the channel

positions in the channel list, you can try an update of
the channel package.

| cannot remove a satellite

- Subscription packages do not allow removing a
satellite. To remove the satellite, you have to do a



complete installation again and select another
package.

Sometimes the reception is poor

- Check if the satellite dish is solidly mounted. Strong
winds can move the dish.
- Snow and rain can degrade the reception.
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17

Software

17.1

Update Software

Update from USB

It might be necessary to update the TV software. You
need a computer with an high-speed Internet
connection and a USB flash drive to upload the
software on the TV. Use a USB flash drive with at least
500MB free space. Make sure that write protection is
switched off.

To update the TV software...

1- Press f£#, select All Settings and press OK.
2 - Select Update Software and press p (right).

Identify the TV

1- Insert the USB flash drive into one of the USB
connections of the TV.

2 - Select Start. An identification file is written on
the USB flash drive.

Download the software

1- Insert the USB flash drive into your computer.

2 - Onthe USB flash drive, locate the

file update.htm and double click it.

3 - Select Send ID.

4 - If new software is available, download the .zip
file.

5 - After the download, unzip the file and copy the
file autorun.upg onto the USB flash drive. Do not
place this file in a folder.

Update the TV software

1- Insert the USB flash drive into the TV again. The
update starts automatically. Please wait. Do

not press a key on the remote control and do not
remove the USB flash drive.

2 - At the end of the update, the TV switches off and
back on again. The message Operation

successful (in English) appears on screen. You can
use the TV again.

If a power cut occurs during the update, never
remove the USB flash drive from the TV. When the
power returns, the update will continue.

To prevent an accidental update of the TV software,
delete the autorun.upg file from the USB flash drive.
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Update from Internet

If the TV is connected to the Internet, you may receive
a message to update the TV software. You need a
high-speed (broadband) Internet connection. If you
receive this message, we recommend you to carry out
the update.

With the message on screen, select Update and
follow the instructions on screen.

When the update is complete, the TV switches off and
back on again automatically. Wait for the TV to
switch itself back on.

To look for a software update yourself...

1- Press £, select All Settings and press OK.

2 - Select Update Software > Search for
Updates and press OK.

3 - Select Internetand press p (right). Follow the
instructions on screen.

4 - Press < (left) repeatedly if necessary, to close
the menu.

17.2
Software Version

To view the current TV software version...

1- Press %, select All Settings and press OK.

2 - Select Update Software > Current Software
Info and press OK.

3 - See Version..

4 - Press < (left) repeatedly if necessary, to close
the menu.
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Open Source Software

This television contains open source software. TP
Vision Europe B.V. hereby offers to deliver, upon
request, a copy of the complete corresponding
source code for the copyrighted open source
software packages used in this product for which such
offer is requested by the respective licences.

This offer is valid up to three years after product
purchase to anyone in receipt of this information.
To obtain the source code, please write in English to .

Intellectual Property Dept.
TP Vision Europe B.V.
Prins Bernhardplein 200
1097 JB Amsterdam

The Netherlands
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Open Source License

README for the source code of the parts of TP Vision
Netherlands B.V. TV software that fall under open
source licenses.

This is a document describing the distribution of the
source code used on the TP Vision Netherlands B.V.
TV, which fall either under the GNU General Public
License (the GPL), or the GNU Lesser General Public
License (the LGPL), or any other open source license.
Instructions to obtain copies of this software can be
found in the Directions For Use.

TP Vision Netherlands B.V. MAKES NO WARRANTIES
WHATSOEVER, EITHER EXPRESS OR IMPLIED,
INCLUDING ANY WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE, REGARDING THIS SOFTWARE. TP Vision
Netherlands B.V. offers no support for this software.
The preceding does not affect your warranties and
statutory rights regarding any TP Vision Netherlands
B.V. product(s) you purchased. It only applies to this
source code made available to you.

Android (5.1.0)

This tv contains the Android Lollipop Software.
Android is a Linux-based operating system designed
primarily for touch screen mobile devices such as
smartphones and tablet computers. This software will
also be reused in TPVision Android based TV's. The
original download site for this software is :
https://android.googlesource.com/This piece of
software is made available under the terms and
conditions of the Apache license version 2, which can
be found below. Android APACHE License Version 2
(http://source.android.com/source/licenses.html)

Toolbox (N/A)

The original download site for this software is :
https://android.googlesource.com/This piece of
software is made available under the terms and
conditions of the Apache license version 2, which can
be found below. Android APACHE License Version 2
(http://source.android.com/source/licenses.html)

linux kernel (3.10.46)

This TV contains the Linux Kernel. The original
download site for this software is :

http://www kernel.org/.This piece of software is made
available under the terms and conditions of the GPL
v2 license, which can be found below. Additionally,
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following exception applies : "NOTE! This copyright
does *not* cover user programs that use kernel
services by normal system calls - this is merely
considered normal use of the kernel, and does *not*
fall under the heading of "derived work". Also note
that the GPL below is copyrighted by the Free
Software Foundation, but the instance of code that it
refers to (the linux kernel) is copyrighted by me and
others who actually wrote it. Also note that the only
valid version of the GPL as far as the kernel is
concerned is _this_ particular version of the license (ie
v2, not v2.2 or v3.x or whatever), unless explicitly
otherwise stated. Linus Torvalds”

libcurl (7.21.7)

libcurl is a free and easy-to-use client-side URL
transfer library, supporting DICT, FILE, FTP, FTPS,
Gopher, HTTP, HTTPS, IMAP, IMAPS, LDAP, LDAPS,
POP3, POP3S, RTMP, RTSP, SCP, SFTP, SMTP,
SMTPS, Telnet and TFTP. libcurl supports SSL
certificates, HTTP POST, HTTP PUT, FTP uploading,
HTTP form based upload, proxies, cookies,
user+password authentication (Basic, Digest, NTLM,
Negotiate, Kerberos), file transfer resume, http proxy
tunneling and more! The original download site for
this software is :
http://curl.haxx.se/libcurl/COPYRIGHT AND
PERMISSION NOTICE Copyright (c) 1996 - 2010,
Daniel Stenberg, daniel@haxx.se. All rights reserved.
Permission to use, copy, modify, and distribute this
software for any purpose with or without fee is
hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT
WARRANTY OF ANY KIND, EXPRESS ORIMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY,FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT OF THIRD
PARTY RIGHTS. INNO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM,DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OROTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH
THE SOFTWARE OR THE USEOR OTHER DEALINGS
IN THE SOFTWARE. Except as contained in this
notice, the name of a copyright holder shall not be
used in advertising or otherwise to promote the sale,
use or other dealings in this Software without prior
written authorization of the copyright holder.

libfreetype (2.4.2)

FreeType is a software development library, available
in source and binary forms, used to render text on to
bitmaps and provides support for other font-related
operations

The original download site for this software is : https:/
/github.com/julienr/libfreetype-androidFreetype



License

libjpeg (8a)

This package contains C software to implement JPEG
image encoding, decoding, and transcoding. This
software is based in part on the work of the
Independent JPEG Group.-—---—-—-—-——=————————- The
authors make NO WARRANTY or representation,
either express or implied, with respect to this
software, its quality, accuracy, merchantability, or
fitness for a particular purpose. This software is
provided "AS IS", and you, its user, assume the entire
risk as to its quality and accuracy. This software is
copyright (C) 1991-1998, Thomas G. Lane. All Rights
Reserved except as specified below. Permission is
hereby granted to use, copy, modify, and distribute
this software (or portions thereof) for any purpose,
without fee, subject to the seconditions:(1) If any part
of the source code for this software is distributed,
then this README file must be included, with this
copyright and no-warranty notice unaltered; and any
additions, deletions, or changes to the original files
must be clearly indicated in accompanying
documentation.(2) If only executable code is
distributed, then the accompanying documentation
must state that "this software is based in part on the
work of the Independent JPEG Group".(3) Permission
for use of this software is granted only if the user
accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for
damages of any kind. These conditions apply to any
software derived from or based on the IJG code, not
just to the unmodified library. If you use our work, you
ought to acknowledge us. Permission is NOT granted
for the use of any IJG author's name or company
name in advertising or publicity relating to this
software or products derived from it. This software
may be referred to only as "the Independent JPEG
Group'ssoftware". We specifically permit and
encourage the use of this software as the basis of
commercial products, provided that all warranty or
liability claims are assumed by the product vendor.

libpng (1.4.1)

libpng is the official Portable Network Graphics (PNG)
reference library (originally called pnglib). Itis a
platform-independent library that contains C
functions for handling PNG images. It supports almost
all of PNG's features, is extensible. The original
download site for this software is :
https://github.com/julienr/libpng-androidlibpng
license

openssl (1.0.1j)

OpenSSL is an open-source implementation of the
SSL and TLS protocols. The core library, written in the
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C programming language, implements the basic
cryptographic functions and provides various utility
functions. The original download site for this software
is : http://openssl.org/OpenSSL license

Zlib compression library (1.2.7)

zlib is a general purpose data compression library. All
the code is thread safe. The data format used by the
zlib library is described by RFCs (Request for
Comments) 1950 to 1952 in the files
http://tools.ietf.org/html/rfc1950 (zlib format), rfc1951
(deflate format) and rfc1952 (gzip format) Developed
by Jean-loup Gailly and Mark Adler(C) 1995-2012
Jean-loup Gailly and Mark Adler This software is
provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable
for any damages arising from the use of this software.
Permission is granted to anyone to use this software
for any purpose, including commercial applications,
and to alter it and redistribute it freely, subject to the
following restrictions: 1. The origin of this software
must not be misrepresented; you must not claim that
you wrote the original software. If you use this
software in a product, an acknowledgmentin the
product documentation would be appreciated but is
not required. 2. Altered source versions must be
plainly marked as such, and must not be
misrepresented as being the original software. 3. This
notice may not be removed or altered from any
source distribution. Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

dvbsnoop (1.2)

dvbsnoop is a DVB / MPEG stream analyzer program.
For generating CRC32 values required for composing
PAT, PMT, EIT sections

The original download site for this software is : https:/
/github.com/a4tunado/dvbsnoop/blob/master/src/
misc/crc32.cGPL v2
http://dvbsnoop.sourceforge.net/dvbsnoop.html

ezxml (0.8.6)

ezXML is a C library for parsing XML documents. The
original download site for this software is :
http://ezxml.sourceforge.net.Copyright 2004, 2005
Aaron Voisine. This piece of software is made
available under the terms and conditions of the MIT
license, which can be found below.

Protobuf (2.0a)

Protocol Buffers are a way of encoding structured
data in an efficient yet extensible format. Google uses
Protocol Buffers for almost all of its internal RPC
protocols and file formats. The original download site



for this software is :
http://code.google.com/p/protobufCopyright 2008,
Google Inc.All rights reserved. Redistribution and use
in source and binary forms, with or without
modification, are permitted provided that the
following conditions are met: * Redistributions of
source code must retain the above copyright notice,
this list of conditions and the following disclaimer. *
Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or
other materials provided with the distribution. *
Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote
products derived from this software without specific
prior written permission. THIS SOFTWARE IS
PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS"AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT
NOTLIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FORA
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHTOWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL,SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOTLIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE,DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANYTHEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT(INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USEOF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. Code generated by the Protocol
Buffer compiler is owned by the owner of the input
file used when generating it. This code is not
standalone and requires a support library to be linked
with it. This support library is itself covered by the
above license.

guava (11.0.2)

The Guava project contains several of Google's core
libraries that we rely on in our Java-based projects:
collections, caching, primitives support, concurrency
libraries, common annotations, string processing, |/0O,
and so forth. The original download site for this
software is : http://code.google.com/This piece of
software is made available under the terms and
conditions of the Apache License version 2.

gSoap (2.7.15)

The gSOAP toolkit is an open source C and C++
software development toolkit for SOAP/XML Web
services and generic (non-SOAP) C/C++ XML data
bindings. Part of the software embedded in this
product is gSOAP software. Portions created by
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gSOAP are Copyright 2001-2009 Robert A. van
Engelen, Genivia inc. All Rights Reserved. THE
SOFTWARE IN THIS PRODUCT WAS IN PART
PROVIDED BY GENIVIA INC AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

restlet (2.1.4)

Restlet is a lightweight, comprehensive, open source
REST framework for the Java platform. Restlet is
suitable for both server and client Web applications. It
supports major Internet transport, data format, and
service description standards like HTTP and HTTPS,
SMTP, XML, JSON, Atom, and WADL. The original
download site for this software is :
http://restlet.orgThis piece of software is made
available under the terms and conditions of the
Apache License version 2.

Opera Web Browser (SDK 3.5)

This TV contains Opera Browser Software.

dlmalloc (2.7.2)
Opera uses Doug Lea's memory allocator

The original download site for this software is :
http://gee.cs.oswego.edu/dl/html/malloc.html

double-conversion

Opera uses double-conversion library by Florian
Loitsch, faster double : string conversions (dtoa and
strtod).The original download site for this software is :
http://code.google.com/p/double-
conversionCopyright 2006-2011, the V8 project
authors. All rights reserved. Redistribution and use in
source and binary forms, with or without modification,
are permitted provided that the following conditions
aremet: * Redistributions of source code must retain
the above copyright notice, this list of conditions and
the following disclaimer. * Redistributions in binary
form must reproduce the above copyright notice, this



list of conditions and the following disclaimer in the
documentation and/or other materials provided with
the distribution. * Neither the name of Google Inc. nor
the names of its contributors may be used to endorse
or promote products derived from this software
without specific prior written permission. THIS
SOFTWARE IS PROVIDED BY THE COPYRIGHT
HOLDERS AND CONTRIBUTORS"AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
BUT NOTLIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FORA
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHTOWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL,SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOTLIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE,DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANYTHEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT(INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USEOF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

EMX (0.9¢)

Opera uses EMX, which is an OS/2 port of the gcc
suite. Opera uses modified versions of the sprintf and
sscanf methods from this C library.* The emx libraries
are not distributed under the GPL. Linking an *
application with the emx libraries does not cause the
executable * to be covered by the GNU General
Public License. You are allowed * to change and copy
the emx library sources if you keep the copyright *
message intact. If you improve the emx libraries,
please send your * enhancements to the emx author
(you should copyright your * enhancements similar to
the existing emx libraries).

freetype (2.4.8)

Opera uses freetype FreeType 2 is a software-font
engine that is designed to be small, efficient, highly
customizable and portable, while capable of
producing high-quality output (glyph images). The
original download site for this software is : http://ww
w.freetype.org/freetype2/index.htmlFreetype License

HKSCS (2008)

Opera uses HKSCS: The Government of the Hong
Kong Special Administrative Region HKSCS mappings

The original download site for this software is :
http://www.ogcio.gov.hkBefore downloading the
Software or Document provided on this Web page,
you should read the following terms (Terms of Use).

75

By downloading the Software and Document, you are
deemed to agree to these terms.1. The Government of
the Hong Kong Special Administrative Region
(HKSARG) has the right to amend or vary the terms
under this Terms of Use from time to time at its sole
discretion.2. By using the Software and Document,
you irrevocably agree that the HKSARG may from
time to time vary this Terms of Use without further
notice to you and you also irrevocably agree to be
bound by the most updated version of the Terms of
Use.3. You have the sole responsibility of obtaining
the most updated version of the Terms of Use which
is available in the "Digital 21" Web site (http://www.og
cio.gov.hk/en/business/tech_promotion/ccli/terms/t
erms.htm).4. By accepting this Terms of Use, HKSARG
shall grant you a non-exclusive license to use the
Software and Document for any purpose, subject to
clause 5 below.5. You are not allowed to make copies
of the Software and Document except it is incidental
to and necessary for the normal use of the Software.
You are not allowed to adapt or modify the Software
and Document or to distribute, sell, rent, or make
available to the public the Software and Document,
including copies or an adaptation of them.6. The
Software and Document are protected by copyright.
The licensors of the Government of Hong Kong
Special Administrative Region are the owners of all
copyright works in the Software and Document. All
rights reserved.7. You understand and agree that use
of the Software and Document are at your sole risk,
that any material and/or data downloaded or
otherwise obtained in relation to the Software and
Document is at your discretion and risk and that you
will be solely responsible for any damage caused to
your computer system or loss of data or any other
loss that results from the download and use of the
Software and Document in any manner whatsoever.8.
In relation to the Software and Document, HKSARG
hereby disclaims all warranties and conditions,
including all implied warranties and conditions of
merchantability, fitness for a particular purpose and
non-infringement.9. HKSARG will not be liable for any
direct, indirect, incidental, special or consequential
loss of any kind resulting from the use of or the
inability to use the Software and Document even if
HKSARG has been advised of the possibility of such
l0ss.10. You agree not to sue HKSARG and agree to
indemnify, defend and hold harmless HKSARG, its
officers and employees from any and all third party
claims, liability, damages and/or costs (including, but
not limited to, legal fees) arising from your use of the
Software and Document, your violation of the Terms
of Use or infringement of any intellectual property or
other right of any person or entity.11. The Terms of Use
will be governed by and construed in accordance
with the laws of Hong Kong.12. Any waiver of any
provision of the Terms of Use will be effective only if
in writing and signed by HKSARG or its
representative.13. If for any reason a court of
competent jurisdiction finds any provision or portion



of the Terms of Use to be unenforceable, the
remainder of the Terms of Use will continue in full
force and effect.14. The Terms of Use constitute the
entire agreement between the parties with respect to
the subject matter hereof and supersedes and
replaces all prior or contemporaneous
understandings or agreements, written or oral,
regarding such subject matter.15.In addition to the
licence granted in Clause 4, HKSARG hereby grants
you a non-exclusive limited licence to reproduce and
distribute the Software and Document with the
following conditions:(i) not for financial gain unless it
is incidental;(ii) reproduction and distribution of the
Software and Document in complete and unmodified
form; and(iii) when you distribute the Software and
Document, you agree to attach the Terms of Use and
a statement that the latest version of the Terms of
Use is available from the "Office of the Government
Chief Information Officer" Web site (http://www.ogcio
.gov.hk/en/business/tech_promotion/ccli/terms/term
s.htm).

IANA (Dec 30 2013)

Opera uses Internet Assigned Numbers Authority:
Character encoding tag names and numbers. The
original download site for this software is :
https://www.iana.org

ICU (3)

Opera uses ICU : International Components for
Unicode: Mapping table for GB18030The original
download site for this software is : http://site.icu-proj
ect.org/http://source.icu-
project.org/repos/icu/icu/trunk/license.html

MozTW (1.0)

Opera uses MoxTW : MozTW project: Big5-2003
mapping tables. The original download site for this
software is : https://moztw.orgThis piece of software
is made available under the terms and conditions of
CCPL

NPAPI (0.27)

Opera uses NPAPI : Netscape 4 Plugin API: npapi.h,
npfunctions.h, npruntime.h and nptypes.h. Distributed
as part of the Netscape 4 Plugin SDK.The original
download site for this software is : wiki.mozilla.orgThis
piece of software is made available under the terms
and conditions of mozilla licencse as described
below.

Unicode (4.0)

Opera uses Unicode : Data from the Unicode
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character database. The original download site for
this software is : www.unicode.orghttp://www.unicod
e.org/copyright.html

Webp (0.2.0)

Opera uses Webp : libwebp is a library for decoding
images in the WebP format. Products may use it to
decode WebP images. The turbo servers will
eventually re-decode images to WebP.The original
download site for this software is :
https://developers.google.com/speed/webp/?csw=1
https://chromium.googlesource.com/webm/libwebp/
Additional IP Rights Grant (Patents)"This
implementation” means the copyrightable works
distributed byGoogle as part of the WebM
Project.Google hereby grants to you a perpetual,
worldwide, non-exclusive, no-charge, royalty-free,
irrevocable (except as stated in this section)patent
license to make, have made, use, offer to sell, sell,
import, transfer, and otherwise run, modify and
propagate the contents of this implementation of
VP8, where such license applies only to those patent
claims, both currently owned by Google and acquired
in the future, licensable by Google that are
necessarily infringed by this implementation of VP8.
This grant does not include claims that would be
infringed only as a consequence of further
modification of this implementation. If you or your
agent or exclusive licensee institute or order or agree
to the institution of patent litigation against any entity
(including a cross-claim or counterclaim in a lawsuit)
alleging that this implementation of VP8 or any code
incorporated within this implementation of VP8
constitutes direct or contributory patent infringement,
or inducement of patent infringement, then any
patent rights granted to you under this License for this
implementation of VP8shall terminate as of the date
such litigation is filed.

FaceBook SDK (3.0.1)

This TV contains Facebook SDK. The Facebook SDK
for Android is the easiest way to integrate your
Android app with Facebook's platform. The SDK
provides support for Login with Facebook
authentication, reading and writing to Facebook APIs
and support for Ul elements such as pickers and
dialogs. The original download site for this software is
- https://developer.facebook.com/docs/androidThis
piece of software is made available under the terms
and conditions of the Apache License version 2.

iptables (1.4.7)

iptables is a user space application program that
allows a system administrator to configure the tables
provided by the Linux kernel firewall (implemented as
different Netfilter modules) and the chains and rules it



stores. Different kernel modules and programs are
currently used for different protocols; iptables applies
to IPv4The original download site for this software is :
https://android.googlesource.comThis piece of
software is made available under the terms and
conditions of the GPL v2.

libyuv (814)

libyuv is an open source project that includes YUV
conversion and scaling functionality. The original
download site for this software is :
http://code.google.com/p/libyuvThis piece of
software is made available under the terms and
conditions BSD.

Audio Codec FLAC (1.2.1)

This TV uses FLAC in libddlacodec.so.FLAC stands for
Free Lossless Audio Codec, an audio format similar to
MP3, but lossless, meaning that audio is compressed
in FLAC without any loss in quality. The original
download site for this software is :

http://www xiph.orgThis piece of software is made
available under the terms and conditions of the BSD
license, which can be found below.

Audio Codec SRC (1.8.1)

This TV uses Audio Codec SRC which is used by
libamphal.so. The original download site for this
software is :
https://ccrma.stanford.edu/Njos/resample/This piece
of software is made available under the terms and
conditions of the LGPL v2, which can be found below.

Audio Codec Vorbis (1.3.3)

This TV uses Audio Codec Vorbis which is used by
libamphal.so. The original download site for this
software is : http://www.xiph.orgThis piece of
software is made available under the terms and
conditions of BSD Style.

Flick Runtime Library (2.1)

This TV uses Flick Runtime Library. The original
download site for this software is :
http://www.cs.utah.edu/flux/This piece of software is
made available under the terms and conditions of the
BSD Style License.

ffmpeg (2.1.3)

This TV uses FFmpeg. FFmpeg is a complete, cross-
platform solution to record, convert and stream audio
and video. The original download site for this
software is : http://ffmpeg.orgThis piece of software is
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made available under the terms and conditions of the
GPL v2 license, which can be found below.

tinyxml (2.4.0)

This TV uses tinyxml.TinyXML is a simple, small,
efficient, C++ XML parser that can be easily
integrating into other programs. The original
download site for this software is :
http://www.grinninglizard.com/tinyxml/This software
is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable
for any damages arising from the use of this software.
Permission is granted to anyone to use this software
for any purpose, including commercial applications,
and to alter it and redistribute it freely, subject to the
following restrictions:1. The origin of this software
must not be misrepresented; you must not claim that
you wrote the original software. If you use this
software in a product, an acknowledgment in the
product documentation would be appreciated but is
not required.2. Altered source versions must be
plainly marked as such, and must not be
misrepresented as being the original software.3. This
notice may not be removed or altered from any
source distribution..

jimtcl (0.73)

jimtcl is an opensource small-footprint
implementation of the Tcl programming language

The original download site for this software is : http://j
im.tcl.tk/index.html/doc/www/www/index.htmlThis
piece of software is made available under the terms
and conditions of the JIM TCL license.

DRM (NA)

Marvell Bootloader (NA)
Developed by Marvell Semiconductors

This piece of software is made available under the
terms and conditions of the GPL v2 license, which can
be found below.

DirectFB (1.6.1)

DirectFB is a thin library that provides hardware
graphics acceleration. The original download site for
this software is : http://www.directfb.org/This piece of
software is made available under the terms and
conditions of the LGPL v2.1 license, which can be
found below.

fusion (8.10.3)



Fusion provides an implementation of abstractions
needed for multi-threaded/multi-process
programming: .The original download site for this
software is : http://www.directfb.org/This piece of
software is made available under the terms and
conditions of the LGPL v2.1 license, which can be
found below.

ntfs-3g (2011.4.12)

Ntfs-3g is an open source for cross platform NTFS file
system support. The original download site for this
software is : http://www.tuxera.com/community This
piece of software is made available under the terms
and conditions of the LGPL v2.1 license, which can be
found below.

live555 (NA)

Live555 provides RTP/RTCP/RTSP client. The original
download site for this software is :
http://www.live555.comThis piece of software is
made available under the terms and conditions of the
LGPL v2.1 license, which can be found below.

Bluetooth Stack (Bluedroid)

This TV uses Bluetooth stack. The original download
site for this software is :This piece of software is made
available under the terms and conditions of Android
Apache License Version 2.

D-BUS (1.2.1)

D-Bus is a simple system for inter process
communication and coordination. The original
download site for this software is :

http://dbus freedesktop.orgThis piece of software is
made available under the terms and conditions of
GPL V2.

EXIF (NA)

Exif JPEG header manipulation tool. The original
download site for this software is :
http://www.sentex.net/Nmwandel/jhead/Portions of
this source code are in the public domain

Copyright (c) 2008, The Android Open Source Project
All rights reserved. Redistribution and use in source
and binary forms, with or without modification, are
permitted provided that the following conditions are
met: * Redistributions of source code must retain the
above copyright notice, this list of conditions and the
following disclaimer. * Redistributions in binary form
must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the
documentation and/or other materials provided with
the distribution. * Neither the name of The Android
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Open Source Project nor the names of its contributors
may be used to endorse or promote products derived
from this software without specific prior written
permission. THIS SOFTWARE IS PROVIDED BY THE
COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOTLIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND
FITNESSFOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THECOPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT,INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING,BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSSOF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSEDAND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY,OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUTOF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OFSUCH DAMAGE.

EXPAT (2.1.0)

EXPAT is a XML Parser. The original download site for
this software is :
http://expat.sourceforge.netCopyright (c) 1998, 1999,
2000 Thai Open Source Software Center Ltd and
Clark Cooper Copyright (c) 2001, 2002, 2003, 2004,
2005, 2006 Expat maintainers. Permission is hereby
granted, free of charge, to any person obtaining a
copy of this software and associated documentation
files (the"Software"), to deal in the Software without
restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to
do so, subject to the following conditions: The above
copyright notice and this permission notice shall be
included in all copies or substantial portions of the
Software. THE SOFTWARE IS PROVIDED "AS IS",
WITHOUT WARRANTY OF ANY KIND,EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OFMERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT.IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANYCLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THESOFTWARE
OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

neven face recognition library (NA)

This TV uses neven face recognition library which is
used for face recognition

This piece of software is made available under the



terms and conditions of Android Apache License
version 2.

Unicode (4.8.1.1)

This TV uses Unicode which specifies the
representation of text

The original download site for this software is :
http://icu-project.orglCU License - ICU 1.8.1 and later
COPYRIGHT AND PERMISSION NOTICE Copyright (c)
1995-2008 International Business Machines
Corporation and others All rights reserved. Permission
is hereby granted, free of charge, to any person
obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the
Software without restriction, including without
limitation the rights to use, copy, modify, merge,
publish, distribute, and/or sell copies of the Software,
and to permit persons to whom the Software is
furnished to do so, provided that the above copyright
notice(s) and this permission notice appear in all
copies of the Software and that both the above
copyright notice(s) and this permission notice appear
in supporting documentation. THE SOFTWARE IS
PROVIDED "AS IS", WITHOUT WARRANTY OF ANY
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT OF THIRD
PARTY RIGHTS. IN NO EVENT SHALL THE
COPYRIGHT HOLDER OR HOLDERS INCLUDED IN
THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY
SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES,
OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER
IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE. Except as contained in this notice,
the name of a copyright holder shall not be used in
advertising or otherwise to promote the sale, use or
other dealings in this Software without prior written
authorization of the copyright holder. All trademarks
and registered trademarks mentioned herein are the
property of their respective owners.

IPRoute2 (NA)

IPRoute? is used for TCP/IP, Networking and Traffic
control. The original download site for this software is
- http://www linuxfoundation.org/collaborate/workgr
oups/networking/iproute2This piece of software is
made available under the terms and conditions of
GPL V2.

mtpd (NA)
mtpd is used for VPN Network. The original download

79

site for this software is :
http://libmtp.sourceforge.net/This piece of software is
made available under the terms and conditions of
Apache License version 2.0.

MDNS Responder (NA)

MDNS Responder. The mDNSResponder project is a
component of Bonjour,Apple's ease-of-use IP
networking initiative. The original download site for
this software is : http://www.opensource.apple.com/t
arballs/mDNSResponder/This piece of software is
made available under the terms and conditions of
Apache License version 2.0.

NFC (NA)

NFC Semiconductor's NFC Library. Near Field
Communication (NFC) is a set of short-range wireless
technologies, typically requiring a distance of 4cm or
less to initiate a connection. NFC allows you to share
small payloads of data between an NFC tag and an
Android-powered device, or between two Android-
powered devices. This piece of software is made
available under the terms and conditions of Apache
License version 2.0.

Skia (NA)

Skia is a complete 2D graphic library for drawing Text,
Geometries, and Images. The original download site
for this software is :
http://code.google.com/p/skia/Copyright (c) 2011
Google Inc. All rights reserved. Redistribution and use
in source and binary forms, with or without
modification, are permitted provided that the
following conditions are met: * Redistributions of
source code must retain the above copyright notice,
this list of conditions and the following disclaimer. *
Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or
other materials provided with the distribution. *
Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote
products derived from this software without specific
prior written permission. THIS SOFTWARE IS
PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS"AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT
NOTLIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FORA
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHTOWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL,SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOTLIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE,DATA, OR



PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANYTHEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT(INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USEOF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

Sonic Audio Synthesis library (NA)

The original download site for this software is :
http://www.sonivoxmi.com/This piece of software is
made available under the terms and conditions of
Apache License version 2.0.

Salite (3071100)

The original download site for this software is :
www.sqglite.org.This piece of software is made
available under the terms and conditions of Apache
License version 2.0.

Nuance Speech Recognition engine (NA)

The original download site for this software is :
http://www.nuance.com/This piece of software is
made available under the terms and conditions of
Apache License version 2.0.

C++Standard Template Library library (5)

This TV uses Implementation of the C++ Standard
Template Library. The original download site for this
software is : http://stlport.sourceforge.netBoris
Fomitchev grants Licensee a non-exclusive, non-
transferable, royalty-free license to use STLport and
its documentation without fee. By downloading,
using, or copying STLport or any portion thereof,
Licensee agrees to abide by the intellectual property
laws and all other applicable laws of the United
States of America, and to all of the terms and
conditions of this Agreement. Licensee shall maintain
the following copyright and permission notices on
STLport sources and its documentation unchanged
:Copyright 1999,2000 Boris Fomitchev This material is
provided "as is", with absolutely no warranty
expressed or implied. Any use is at your own risk.
Permission to use or copy this software for any
purpose is hereby granted without fee, provided the
above notices are retained on all copies. Permission
to modify the code and to distribute modified code is
granted, provided the above notices are retained, and
a notice that the code was modified is included with
the above copyright notice. The Licensee may
distribute binaries compiled with STLport (whether
original or modified) without any royalties or
restrictions. The Licensee may distribute original or
modified STLport sources, provided that: The

conditions indicated in the above permission notice
are met; The following copyright notices are retained
when present, and conditions provided in
accompanying permission notices are met :Copyright
1994 Hewlett-Packard Company Copyright 1996,97
Silicon Graphics Computer Systems, Inc. Copyright
1997 Moscow Center for SPARC Technology.
Permission to use, copy, modify, distribute and sell
this software and its documentation for any purpose
is hereby granted without fee, provided that the
above copyright notice appear in all copies and that
both that copyright notice and this permission notice
appear in supporting documentation. Hewlett-
Packard Company makes no representations about
the suitability of this software for any purpose. It is
provided "as is" without express or implied warranty.
Permission to use, copy, modify, distribute and sell
this software and its documentation for any purpose
is hereby granted without fee, provided that the
above copyright notice appear in all copies and that
both that copyright notice and this permission notice
appear in supporting documentation. Silicon Graphics
makes no representations about the suitability of this
software for any purpose. It is provided "as is" without
express or implied warranty. Permission to use, copy,
modify, distribute and sell this software and its
documentation for any purpose is hereby granted
without fee, provided that the above copyright notice
appear in all copies and that both that copyright
notice and this permission notice appear in
supporting documentation. Moscow Center for
SPARC Technology makes no representations about
the suitability of this software for any purpose. It is
provided "as is" without express or implied warranty

svox (NA)

The original download site for this software is :
http://www.nuance.com/This piece of software is
made available under the terms and conditions of
Apache License version 2.0.

tinyalsa (NA)

This TV uses tinyalsa: a small library to interface with
ALSA in the Linux kernel The original download site
for this software is :
http://github.com/tinyalsaCopyright 2011, The
Android Open Source Project Redistribution and use
in source and binary forms, with or without
modification, are permitted provided that the
following conditions are met: * Redistributions of
source code must retain the above copyright notice,
this list of conditions and the following disclaimer. *
Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or
other materials provided with the distribution. *
Neither the name of The Android Open Source



Project nor the names of its contributors may be used
to endorse or promote products derived from this
software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY The Android Open
Source Project "AS IS" ANDANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THEIMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSEARE DISCLAIMED. IN NO
EVENT SHALL The Android Open Source Project BE
LIABLEFOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR
CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS ORSERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION)
HOWEVERCAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT,
STRICTLIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAYOUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCHDAMAGE.

Vorbis Decompression Library (NA)

This TV uses Tremolo ARM-optimized Ogg Vorbis
decompression library. Vorbis is a general purpose
audio and music encoding format contemporary to
MPEG-4's AAC and TwinVQ, the next generation
beyond MPEG audio layer 3The original download
site for this software is :
http://wss.co.uk/pinknoise/tremoCopyright (c)
2002-2008 Xiph.org Foundation Redistribution and
use in source and binary forms, with or without
modification, are permitted provided that the
following conditions are met:- Redistributions of
source code must retain the above copyright notice,
this list of conditions and the following disclaimer.-
Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or
other materials provided with the distribution.-
Neither the name of the Xiph.org Foundation nor the
names of its contributors may be used to endorse or
promote products derived from this software without
specific prior written permission. THIS SOFTWARE IS
PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORSAS IS AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT
NOTLIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FORA
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE FOUNDATIONOR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL,SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOTLIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE,DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
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CAUSED AND ON ANYTHEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT(INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USEOF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

wpa_supplicant_Daemon (v0.8)

Library used by legacy HAL to talk to wpa_supplicant
daemonThe original download site for this software is
- http://hostap.epitest.fi/wpa_supplicant/This piece of
software is made available under the terms and
conditions of GPL version 2.

gson (2.3)

Gson is a Java library that can be used to convert
Java Objects into their JSON representation. It can
also be used to convert a JSON string to an
equivalent Java object. Gson can work with arbitrary
Java objects including pre-existing objects that you
do not have source-code of. The original download
site for this software is :
https://code.google.com/p/google-gson/This piece
of software is made available under the terms and
conditions of the Apache License 2.0

This software includes an implementation of the AES
Cipher, licensed by Brian Gladman

The original download site for this software is :
http://www.gladman.me.uk/This piece of software is
licensed by Brian Gladman

libUpNp (1.2.1)

The original download site for this software is :
http://upnp.sourceforge.net/This piece of software is
made available under the terms and conditions of the
BSD.

dnsmasq

Dnsmasq is a lightweight, easy to configure DNS
forwarder and DHCP server

The original download site for this software is : https:/
/android.googlesource.com/platform/external/dnma
sgThis piece of software is made available under the
terms and conditions of the GPL v2 license, which can
be found below.

rfkill (0.4)

rfkill is a small users pace tool to query the state of
the rfkill switches, buttons and subsystem interfaces.
Some devices come with a hard switch that lets you



kill different types of RF radios

The original download site for this software is : http://
wireless.kernel.org/en/users/Documentation/rfkill This
piece of software is made available under the terms
and conditions of the GPL v2 license, which can be
found below.

TomCrypt (1.1)

iwedia stack is using tomcrypt for sw decryptionThe
original download site for this software is : http://man
pages.ubuntu.com/manpages/saucy/man3/libtomcry
pt.3.htmlThis piece of software is made available
under the terms and conditions of the DO WHAT THE
FUCK YOU WANT TO PUBLIC LICENSE

AsyncHttpclient (1.4.6)

The original download site for this software is :
http://loopj.com/android-async-http/This piece of
software is made available under the terms and
conditions of the APACHE LICENSE 2.0

TP Vision Netherlands B.V. is grateful to the groups
and individuals above for their contributions.

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation,
Inc.

51 Franklin Street, Fifth Floor, Boston, MA
02110-1301, USA

Everyone is permitted to copy and distribute verbatim
copies

of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take
away your freedom to share and change it. By
contrast, the GNU General Public License is intended
to guarantee your freedom to share and change free
software--to make sure the software is free for all its
users. This General Public License applies to most of
the Free Software Foundation's software and to any
other program whose authors commit to using it.
(Some other Free Software Foundation software is
covered by the GNU Lesser General Public License
instead.) You can apply it to your programs, too.
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When we speak of free software, we are referring to
freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to
distribute copies of free software (and charge for this
service if you wish), that you receive source code or
can get it if you want it, that you can change the
software or use pieces of it in new free programs; and
that you know you can do these things.

To protect your rights, we need to make restrictions
that forbid anyone to deny you these rights or to ask
you to surrender the rights. These restrictions
translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a
program, whether gratis or for a fee, you must give
the recipients all the rights that you have. You must
make sure that they, too, receive or can get the
source code. And you must show them these terms
so they know their rights.

We protect your rights with two steps: (1) copyright
the software, and (2) offer you this license which
gives you legal permission to copy, distribute and/or
modify the software.

Also, for each author's protection and ours, we want
to make certain that everyone understands that there
is no warranty for this free software. If the software is
modified by someone else and passed on, we want
its recipients to know that what they have is not the
original, so that any problems introduced by others
will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by
software patents. We wish to avoid the danger that
redistributors of a free program will individually obtain
patent licenses, in effect making the program
proprietary. To prevent this, we have made it clear
that any patent must be licensed for everyone's free
use or not licensed at all.

The precise terms and conditions for copying,
distribution and modification follow.

TERMS AND CONDITIONS FOR COPYING,
DISTRIBUTION AND MODIFICATION

Activities other than copying, distribution and
modification are not covered by this License; they are
outside its scope. The act of running the Program is
not restricted, and the output from the Program is
covered only if its contents constitute a work based
on the Program (independent of having been made
by running the Program). Whether that is true
depends on what the Program does.

You may charge a fee for the physical act of
transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.

a) You must cause the modified files to carry
prominent notices stating that you changed the files
and the date of any change.



b) You must cause any work that you distribute or
publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed
as a whole at no charge to all third parties under the
terms of this License.

c) If the modified program normally reads commands
interactively when run, you must cause it, when
started running for such interactive use in the most
ordinary way, to print or display an announcement
including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that
you provide a warranty) and that users may
redistribute the program under these conditions, and
telling the user how to view a copy of this License.
(Exception: if the Program itself is interactive but does
not normally print such an announcement, your work
based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a
whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably
considered independent and separate works in
themselves, then this License, and its terms, do not
apply to those sections when you distribute them as
separate works. But when you distribute the same
sections as part of a whole which is a work based on
the Program, the distribution of the whole must be on
the terms of this License, whose permissions for other
licensees extend to the entire whole, and thus to
each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights

or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the
distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not
based on the Program with the Program (or with a
work based on the Program) on a volume of a storage
or distribution medium does not bring the other work
under the scope of this License.

a) Accompany it with the complete corresponding
machine-readable source code, which must be
distributed under the terms of Sections 1and 2 above
on a medium customarily used for software
interchange; or,

b) Accompany it with a written offer, valid for at least
three years, to give any third party, for a charge no
more than your cost of physically performing source
distribution, a complete machine-readable copy of
the corresponding source code, to be distributed
under the terms of Sections 1and 2 above on a
medium customarily used for software interchange;
or,

c) Accompany it with the information you received as
to the offer to distribute corresponding source code.
(This alternative is allowed only for noncommercial
distribution and only if you received the program in
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object code or executable form with such an offer, in
accord with Subsection b above.)

The source code for a work means the preferred form
of the work for making modifications to it. For an
executable work, complete source code means all the
source code for all modules it contains, plus any
associated interface definition files, plus the scripts
used to control compilation and installation of the
executable. However, as a special exception, the
source code distributed need not include anything
that is normally distributed (in either source or binary
form) with the major components (compiler, kernel,
and so on) of the operating system on which the
executable runs, unless that component itself
accompanies the executable.

If distribution of executable or object code is made by
offering access to copy from a designated place, then
offering equivalent access to copy the source code
from the same place counts as distribution of the
source code, even though third parties are not
compelled to copy the source along with the object
code.

If any portion of this section is held invalid or
unenforceable under any particular circumstance, the
balance of the section is intended to apply and the
section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to
infringe any patents or other property right claims or
to contest validity of any such claims; this section has
the sole purpose of protecting the integrity of the free
software distribution system, which is implemented
by public license practices. Many people have made
generous contributions to the wide range of software
distributed through that system in reliance on
consistent application of that system:; itis up to the
author/donor to decide if he or she is willing to
distribute software through any other system and a
licensee cannot impose that choice.

This section is intended to make thoroughly clear
what is believed to be a consequence of the rest of
this License.

Each version is given a distinguishing version number.
If the Program specifies a version number of this
License which applies to it and "any later version”,
you have the option of following the terms and
conditions either of that version or of any later version
published by the Free Software Foundation. If the
Program does not specify a version number of this
License, you may choose any version ever published
by the Free Software Foundation.

NO WARRANTY



GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation,
Inc.

51 Franklin Street, Fifth Floor, Boston, MA
02110-1301 USA

Everyone is permitted to copy and distribute verbatim
copies

of this license document, but changing it is not
allowed.

[This is the first released version of the Lesser GPL. It
also counts as the successor of the GNU Library
Public License, version 2, hence the version number
21]

Preamble

The licenses for most software are designed to take
away your freedom to share and change it. By
contrast, the GNU General Public Licenses are
intended to guarantee your freedom to share and
change free software--to make sure the software is
free for all its users.

This license, the Lesser General Public License,
applies to some specially designated software
packages--typically libraries--of the Free Software
Foundation and other authors who decide to use it.
You can use it too, but we suggest you first think
carefully about whether this license or the ordinary
General Public License is the better strategy to use in
any particular case, based on the explanations below.

When we speak of free software, we are referring to
freedom of use, not price. Our General Public
Licenses are designed to make sure that you have the
freedom to distribute copies of free software (and
charge for this service if you wish); that you receive
source code or can get it if you want it; that you can
change the software and use pieces of it in new free
programs; and that you are informed that you can do
these things.

To protect your rights, we need to make restrictions
that forbid distributors to deny you these rights or to
ask you to surrender these rights. These restrictions
translate to certain responsibilities for you if you
distribute copies of the library or if you modify it.

For example, if you distribute copies of the library,
whether gratis or for a fee, you must give the
recipients all the rights that we gave you. You must
make sure that they, too, receive or can get the
source code. If you link other code with the library,
you must provide complete object files to the
recipients, so that they can relink them with the library
after making changes to the library and recompiling it.
And you must show them these terms so they know
their rights.
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We protect your rights with a two-step method: (1) we
copyright the library, and (2) we offer you this license,
which gives you legal permission to copy, distribute
and/or modify the library.

To protect each distributor, we want to make it very
clear that there is no warranty for the free library.
Also, if the library is modified by someone else and
passed on, the recipients should know that what they
have is not the original version, so that the original
author's reputation will not be affected by problems
that might be introduced by others.

Finally, software patents pose a constant threat to the
existence of any free program. We wish to make sure
that a company cannot effectively restrict the users of
a free program by obtaining a restrictive license from
a patent holder. Therefore, we insist that any patent
license obtained for a version of the library must be
consistent with the full freedom of use specified in
this license.

Most GNU software, including some libraries, is
covered by the ordinary GNU General Public License.
This license, the GNU Lesser General Public License,
applies to certain designated libraries, and is quite
different from the ordinary General Public License.
We use this license for certain libraries in order to
permit linking those libraries into non-free programs.

When a program is linked with a library, whether
statically or using a shared library, the combination of
the two is legally speaking a combined work, a
derivative of the original library. The ordinary General
Public License therefore permits such linking only if
the entire combination fits its criteria of freedom. The
Lesser General Public License permits more lax
criteria for linking other code with the library.

We call this license the "Lesser" General Public
License because it does Less to protect the user's
freedom than the ordinary General Public License. It
also provides other free software developers Less of
an advantage over competing non-free programs.
These disadvantages are the reason we use the
ordinary General Public License for many libraries.
However, the Lesser license provides advantages in
certain special circumstances.

For example, on rare occasions, there may be a
special need to encourage the widest possible use of
a certain library, so that it becomes a de-facto
standard. To achieve this, non-free programs must be
allowed to use the library. A more frequent case is
that a free library does the same job as widely used
non-free libraries. In this case, there is little to gain by
limiting the free library to free software only, so we
use the Lesser General Public License.

In other cases, permission to use a particular library in
non-free programs enables a greater number of
people to use a large body of free software. For
example, permission to use the GNU C Library in non-
free programs enables many more people to use the



whole GNU operating system, as well as its variant,
the GNU/Linux operating system.

Although the Lesser General Public License is Less
protective of the users' freedom, it does ensure that
the user of a program that is linked with the Library
has the freedom and the wherewithal to run that
program using a modified version of the Library.

The precise terms and conditions for copying,
distribution and modification follow. Pay close
attention to the difference between a "work based on
the library" and a "work that uses the library". The
former contains code derived from the library,
whereas the latter must be combined with the library
in order to run.

TERMS AND CONDITIONS FOR COPYING,
DISTRIBUTION AND MODIFICATION

A "library" means a collection of software functions
and/or data prepared so as to be conveniently linked
with application programs (which use some of those
functions and data) to form executables.

The "Library", below, refers to any such software
library or work which has been distributed under
these terms. A "work based on the Library"” means
either the Library or any derivative work under
copyright law: that is to say, a work containing the
Library or a portion of it, either verbatim or with
modifications and/or translated straightforwardly into
another language. (Hereinafter, translation is included
without limitation in the term "modification”.)

"Source code" for a work means the preferred form of
the work for making modifications to it. For a library,
complete source code means all the source code for
all modules it contains, plus any associated interface
definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and
modification are not covered by this License; they are
outside its scope. The act of running a program using
the Library is not restricted, and output from such a
program is covered only if its contents constitute a
work based on the Library (independent of the use of
the Library in a tool for writing it). Whether that is true
depends on what the Library does and what the
program that uses the Library does.

You may charge a fee for the physical act of
transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.

?a) The modified work must itself be a software
library.

?b) You must cause the files modified to carry
prominent notices stating that you changed the files
and the date of any change.

?¢) You must cause the whole of the work to be
licensed at no charge to all third parties under the
terms of this License.
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?d) If a facility in the modified Library refers to a
function or a table of data to be supplied by an
application program that uses the facility, other than
as an argument passed when the facility is invoked,
then you must make a good faith effort to ensure that,
in the event an application does not supply such
function or table, the facility still operates, and
performs whatever part of its purpose remains
meaningful.

(For example, a function in a library to compute
square roots has a purpose that is entirely well-
defined independent of the application. Therefore,
Subsection 2d requires that any application-supplied
function or table used by this function must be
optional: if the application does not supply it, the
square root function must still compute square roots.)

These requirements apply to the modified work as a
whole. If identifiable sections of that work are not
derived from the Library, and can be reasonably
considered independent and separate works in
themselves, then this License, and its terms, do not
apply to those sections when you distribute them as
separate works. But when you distribute the same
sections as part of a whole which is a work based on
the Library, the distribution of the whole must be on
the terms of this License, whose permissions for other
licensees extend to the entire whole, and thus to
each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights

or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the
distribution of derivative or collective works based on
the Library.

In addition, mere aggregation of another work not
based on the Library with the Library (or with a work
based on the Library) on a volume of a storage or
distribution medium does not bring the other work
under the scope of this License.

Once this change is made in a given copy, it is
irreversible for that copy, so the ordinary GNU
General Public License applies to all subsequent
copies and derivative works made from that copy.

This option is useful when you wish to copy part of
the code of the Library into a program that is not a
library.

If distribution of object code is made by offering
access to copy from a designated place, then offering
equivalent access to copy the source code from the
same place satisfies the requirement to distribute the
source code, even though third parties are not
compelled to copy the source along with the object
code.

However, linking a "work that uses the Library" with
the Library creates an executable that is a derivative
of the Library (because it contains portions of the
Library), rather than a "work that uses the library". The



executable is therefore covered by this License.
Section 6 states terms for distribution of such
executables.

When a "work that uses the Library" uses material
from a header file that is part of the Library, the object
code for the work may be a derivative work of the
Library even though the source code is not. Whether
this is true is especially significant if the work can be
linked without the Library, or if the work is itself a
library. The threshold for this to be true is not
precisely defined by law.

If such an object file uses only numerical parameters,
data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in
length), then the use of the object file is unrestricted,
regardless of whether it is legally a derivative work.
(Executables containing this object code plus
portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library,
you may distribute the object code for the work under
the terms of Section 6. Any executables containing
that work also fall under Section 6, whether or not
they are linked directly with the Library itself.

You must give prominent notice with each copy of the
work that the Library is used in it and that the Library
and its use are covered by this License. You must
supply a copy of this License. If the work during
execution displays copyright notices, you must
include the copyright notice for the Library among
them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these
things:

?a) Accompany the work with the complete
corresponding machine-readable source code for the
Library including whatever changes were used in the
work (which must be distributed under Sections 1and
2 above); and, if the work is an executable linked with
the Library, with the complete machine-readable
"work that uses the Library", as object code and/or
source code, so that the user can modify the Library
and then relink to produce a modified executable
containing the modified Library. (It is understood that
the user who changes the contents of definitions files
in the Library will not necessarily be able to recompile
the application to use the modified definitions.)

?b) Use a suitable shared library mechanism for
linking with the Library. A suitable mechanism is one
that (1) uses at run time a copy of the library already
present on the user's computer system, rather than
copying library functions into the executable, and (2)
will operate properly with a modified version of the
library, if the user installs one, as long as the modified
version is interface-compatible with the version that
the work was made with.

?c) Accompany the work with a written offer, valid for
at least three years, to give the same user the
materials specified in Subsection 6a, above, for a
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charge no more than the cost of performing this
distribution.

?d) If distribution of the work is made by offering
access to copy from a designated place, offer
equivalent access to copy the above specified
materials from the same place.

?e) Verify that the user has already received a copy of
these materials or that you have already sent this user
a copy.

For an executable, the required form of the "work that
uses the Library" must include any data and utility
programs needed for reproducing the executable
from it. However, as a special exception, the materials
to be distributed need not include anything that is
normally distributed (in either source or binary form)
with the major components (compiler, kernel, and so
on) of the operating system on which the executable
runs, unless that component itself accompanies the
executable.

It may happen that this requirement contradicts the
license restrictions of other proprietary libraries that
do not normally accompany the operating system.
Such a contradiction means you cannot use both
them and the Library together in an executable that
you distribute.

?a) Accompany the combined library with a copy of
the same work based on the Library, uncombined
with any other library facilities. This must be
distributed under the terms of the Sections above.

?b) Give prominent notice with the combined library
of the fact that part of it is a work based on the
Library, and explaining where to find the
accompanying uncombined form of the same work.

If any portion of this section is held invalid or
unenforceable under any particular circumstance, the
balance of the section is intended to apply, and the
section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to
infringe any patents or other property right claims or
to contest validity of any such claims; this section has
the sole purpose of protecting the integrity of the free
software distribution system which is implemented by
public license practices. Many people have made
generous contributions to the wide range of software
distributed through that system in reliance on
consistent application of that system: it is up to the
author/donor to decide if he or she is willing to
distribute software through any other system and a
licensee cannot impose that choice.

This section is intended to make thoroughly clear
what is believed to be a consequence of the rest of
this License.

Each version is given a distinguishing version number.
If the Library specifies a version number of this



License which applies to it and "any later version”,
you have the option of following the terms and
conditions either of that version or of any later version
published by the Free Software Foundation. If the
Library does not specify a license version number,
you may choose any version ever published by the
Free Software Foundation.

NO WARRANTY

BSD LICENSE

Redistribution and use in source and binary forms,
with or without modification, are permitted provided
that the following conditions are met:

THIS SOFTWARE IS PROVIDED BY THE REGENTS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE REGENTS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT LICENSE

Permission is hereby granted, free of charge, to any
person obtaining

a copy of this software and associated
documentation files (the

"Software"), to deal in the Software without
restriction, including

without limitation the rights to use, copy, modify,
merge, publish,

distribute, sublicense, and/or sell copies of the
Software, and to

permit persons to whom the Software is furnished to
do so, subject to

the following conditions:
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The above copyright notice and this permission
notice shall be included

in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT
WARRANTY OF ANY KIND,

EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF

MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT.

IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY

CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT,

TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE

SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Apache
License

Version 2.0,
January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE,
REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions
for use, reproduction,

and distribution as defined by Sections 1
through 9 of this document.

"Licensor" shall mean the copyright owner or
entity authorized by

the copyright owner that is granting the
License.

"Legal Entity" shall mean the union of the
acting entity and all

other entities that control, are controlled by, or



are under common

control with that entity. For the purposes of
this definition,

"control" means (i) the power, direct or
indirect, to cause the

direction or management of such entity,
whether by contract or

otherwise, or (ii) ownership of fifty percent
(50%) or more of the

outstanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or
Legal Entity

exercising permissions granted by this License.

"Source" form shall mean the preferred form
for making modifications,

including but not limited to software source
code, documentation

source, and configuration files.

"Object" form shall mean any form resulting
from mechanical

transformation or translation of a Source form,
including but

not limited to compiled object code,
generated documentation,

and conversions to other media types.

"Work" shall mean the work of authorship,
whether in Source or

Object form, made available under the
License, as indicated by a

copyright notice that is included in or attached
to the work

(an example is provided in the Appendix
below).

"Derivative Works" shall mean any work,
whether in Source or Object

form, that is based on (or derived from) the
Work and for which the

editorial revisions, annotations, elaborations,
or other modifications

represent, as a whole, an original work of
authorship. For the purposes
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of this License, Derivative Works shall not
include works that remain

separable from, or merely link (or bind by
name) to the interfaces of,

the Work and Derivative Works thereof.

"Contribution” shall mean any work of
authorship, including

the original version of the Work and any
modifications or additions

to that Work or Derivative Works thereof, that
is intentionally

submitted to Licensor for inclusion in the Work
by the copyright owner

or by an individual or Legal Entity authorized
to submit on behalf of

the copyright owner. For the purposes of this
definition, "submitted"

means any form of electronic, verbal, or
written communication sent

to the Licensor or its representatives, including
but not limited to

communication on electronic mailing lists,
source code control systems,

and issue tracking systems that are managed
by, or on behalf of, the

Licensor for the purpose of discussing and
improving the Work, but

excluding communication that is
conspicuously marked or otherwise

designated in writing by the copyright owner
as "Not a Contribution.”

"Contributor” shall mean Licensor and any
individual or Legal Entity

on behalf of whom a Contribution has been
received by Licensor and

subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms
and conditions of

this License, each Contributor hereby grants to
You a perpetual,

worldwide, non-exclusive, no-charge, royalty-
free, irrevocable

copyright license to reproduce, prepare
Derivative Works of,

publicly display, publicly perform, sublicense,



and distribute the

Work and such Derivative Works in Source or
Object form.

3. Grant of Patent License. Subject to the terms
and conditions of

this License, each Contributor hereby grants to
You a perpetual,

worldwide, non-exclusive, no-charge, royalty-
free, irrevocable

(except as stated in this section) patent license
to make, have made,

use, offer to sell, sell, import, and otherwise
transfer the Work,

where such license applies only to those
patent claims licensable

by such Contributor that are necessarily
infringed by their

Contribution(s) alone or by combination of
their Contribution(s)

with the Work to which such Contribution(s)
was submitted. If You

institute patent litigation against any entity
(including a

cross-claim or counterclaim in a lawsuit)
alleging that the Work

or a Contribution incorporated within the Work
constitutes direct

or contributory patent infringement, then any
patent licenses

granted to You under this License for that
Work shall terminate

as of the date such litigation is filed.

4. Redistribution. You may reproduce and
distribute copies of the

Work or Derivative Works thereof in any
medium, with or without

modifications, and in Source or Object form,
provided that You

meet the following conditions:

(2) You must give any other recipients of the
Work or

Derivative Works a copy of this License;
and

(b) You must cause any modified files to carry
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prominent notices

stating that You changed the files; and

(c) You must retain, in the Source form of any
Derivative Works

that You distribute, all copyright, patent,
trademark, and

attribution notices from the Source form
of the Work,

excluding those notices that do not
pertain to any part of

the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as
part of its

distribution, then any Derivative Works
that You distribute must

include a readable copy of the
attribution notices contained

within such NOTICE file, excluding those
notices that do not

pertain to any part of the Derivative
Works, in at least one

of the following places: within a NOTICE
text file distributed

as part of the Derivative Works; within
the Source form or

documentation, if provided along with
the Derivative Works; or,

within a display generated by the
Derivative Works, if and

wherever such third-party notices
normally appear. The contents

of the NOTICE file are for informational
purposes only and

do not modify the License. You may add
Your own attribution

notices within Derivative Works that You
distribute, alongside

or as an addendum to the NOTICE text
from the Work, provided

that such additional attribution notices
cannot be construed

as modifying the License.

You may add Your own copyright statement to
Your modifications and

may provide additional or different license



terms and conditions

for use, reproduction, or distribution of Your
modifications, or

for any such Derivative Works as a whole,
provided Your use,

reproduction, and distribution of the Work
otherwise complies with

the conditions stated in this License.

5. Submission of Contributions. Unless You
explicitly state otherwise,

any Contribution intentionally submitted for
inclusion in the Work

by You to the Licensor shall be under the
terms and conditions of

this License, without any additional terms or
conditions.

Notwithstanding the above, nothing herein
shall supersede or modify

the terms of any separate license agreement
you may have executed

with Licensor regarding such Contributions.

6. Trademarks. This License does not grant
permission to use the trade

names, trademarks, service marks, or product
names of the Licensor,

except as required for reasonable and
customary use in describing the

origin of the Work and reproducing the
content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by
applicable law or

agreed to in writing, Licensor provides the
Work (and each

Contributor provides its Contributions) on an
"AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF
ANY KIND, either express or

implied, including, without limitation, any
warranties or conditions

of TITLE, NON-INFRINGEMENT,
MERCHANTABILITY, or FITNESS FOR A

PARTICULAR PURPOSE. You are solely
responsible for determining the

appropriateness of using or redistributing the
Work and assume any
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risks associated with Your exercise of
permissions under this License.

8. Limitation of Liability. In no event and under no
legal theory,

whether in tort (including negligence),
contract, or otherwise,

unless required by applicable law (such as
deliberate and grossly

negligent acts) or agreed to in writing, shall
any Contributor be

liable to You for damages, including any
direct, indirect, special,

incidental, or consequential damages of any
character arising as a

result of this License or out of the use or
inability to use the

Work (including but not limited to damages for
loss of goodwiill,

work stoppage, computer failure or
malfunction, or any and all

other commercial damages or losses), even if
such Contributor

has been advised of the possibility of such
damages.

9. Accepting Warranty or Additional Liability. While
redistributing

the Work or Derivative Works thereof, You may
choose to offer,

and charge a fee for, acceptance of support,
warranty, indemnity,

or other liability obligations and/or rights
consistent with this

License. However, in accepting such
obligations, You may act only

on Your own behalf and on Your sole
responsibility, not on behalf

of any other Contributor, and only if You agree
to indemnify,

defend, and hold each Contributor harmless
for any liability

incurred by, or claims asserted against, such
Contributor by reason

of your accepting any such warranty or
additional liability.

END OF TERMS AND CONDITIONS



APPENDIX: How to apply the Apache License to
your work.

To apply the Apache License to your work,
attach the following

boilerplate notice, with the fields enclosed by
brackets "[]"

replaced with your own identifying
information. (Don't include

the brackets!) The text should be enclosed in
the appropriate

comment syntax for the file format. We also
recommend that a

file or class name and description of purpose
be included on the

same "printed page" as the copyright notice
for easier

identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0
(the "License");

you may not use this file except in compliance
with the License.

You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in
writing, software

distributed under the License is distributed on an
"AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY
KIND, either express or implied.

See the License for the specific language
governing permissions and

limitations under the License.

This copy of the libpng notices is provided for your

convenience. In case of

any discrepancy between this copy and the notices in
the file png.h that is

included in the libpng distribution, the latter shall
prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices
immediately following

this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.4.1,
February 25, 2010, are

Copyright (c) 2004, 2006-2007 Glenn Randers-
Pehrson, and are

distributed according to the same disclaimer and
license as libpng-1.2.5

with the following individual added to the list of
Contributing Authors

Cosmin Truta

libpng versions 1.0.7, July 1, 2000, through 1.2.5 -
October 3, 2002, are

Copyright (c) 2000-2002 Glenn Randers-Pehrson,
and are

distributed according to the same disclaimer and
license as libpng-1.0.6

with the following individuals added to the list of
Contributing Authors

Simon-Pierre Cadieux
Eric S. Raymond
Gilles Vollant

and with the following additions to the disclaimer:

There is no warranty against interference with your
enjoyment of the

library or against infringement. There is no
warranty that our

efforts or the library will fulfill any of your
particular purposes



or needs. This library is provided with all faults,
and the entire

risk of satisfactory quality, performance, accuracy,
and effort is with

the user.

libpng versions 0.97, January 1998, through 1.0.6,
March 20, 2000, are

Copyright (c) 1998, 1999 Glenn Randers-Pehrson, and
are

distributed according to the same disclaimer and
license as libpng-0.96,

with the following individuals added to the list of
Contributing Authors:

Tom Lane
Glenn Randers-Pehrson

Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May
1997, are

Copyright (c) 1996, 1997 Andreas Dilger

Distributed according to the same disclaimer and
license as libpng-0.88,

with the following individuals added to the list of
Contributing Authors:

John Bowler
Kevin Bracey
Sam Bushell
Magnus Holmgren
Greg Roelofs

Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January
1996, are

Copyright () 1995, 1996 Guy Eric Schalnat, Group 42,
Inc.

For the purposes of this copyright and license,
"Contributing Authors"

is defined as the following set of individuals:

Andreas Dilger

Dave Martindale
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Guy Eric Schalnat
Paul Schmidt
Tim Wegner

The PNG Reference Library is supplied "AS IS". The
Contributing Authors

and Group 42, Inc. disclaim all warranties, expressed
or implied,

including, without limitation, the warranties of
merchantability and of

fitness for any purpose. The Contributing Authors
and Group 42, Inc.

assume no liability for direct, indirect, incidental,
special, exemplary,

or consequential damages, which may result from the
use of the PNG

Reference Library, even if advised of the possibility of
such damage.

Permission is hereby granted to use, copy, modify,
and distribute this

source code, or portions hereof, for any purpose,
without fee, subject

to the following restrictions:

be misrepresented as being the original source.

source or altered source distribution.

The Contributing Authors and Group 42, Inc.
specifically permit, without

fee, and encourage the use of this source code as a
component to

supporting the PNG file format in commercial
products. If you use this

source code in a product, acknowledgment is not
required but would be

A "png_get_copyright" function is available, for
convenient use in "about”

boxes and the like:

printf("%s" png_get_copyright(NULL));



Also, the PNG logo (in PNG format, of course) is
supplied in the

files "pngbar.png.jpg" and "pngbar.jpg (88x31) and
"ongnow.png.jpg" (98x31).

Libpng is OSI Certified Open Source Software. OSI
Certified Open Sourceis a

certification mark of the Open Source Initiative.

Glenn Randers-Pehrson
glennrp at users.sourceforge.net
February 25, 2010

This software is based in part on the work of the
FreeType Team.

The FreeType Project
LICENSE

2006-Jan-27

Copyright 1996-2002,
2006 by

David Turner, Robert Wilhelm, and
Werner Lemberg

Introduction

The FreeType Project is distributed in several
archive packages;

some of them may contain, in addition to the
FreeType font engine,

various tools and contributions which rely on, or
relate to, the

FreeType Project.
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This license applies to all files found in such
packages, and

which do not fall under their own explicit
license. The license

affects thus the FreeType font engine,
the test programs,

documentation and makefiles, at the very least.

This license was inspired by the BSD,
Artistic, and JG

(Independent JPEG Group) licenses, which all
encourage inclusion

and use of free software in commercial and
freeware products

alike. As a consequence, its main points are that:

o We don't promise that this software works.
However, we will be

interested in any kind of bug reports. (‘as is'
distribution)

o You can use this software for whatever you
want, in parts or

full form, without having to pay us. (‘royalty-
free' usage)

o You may not pretend that you wrote this
software. If you use

it, or only parts of it, in a program, you
must acknowledge

somewhere in your documentation that
you have used the

FreeType code. (‘credits')

We specifically permit and encourage the
inclusion of this

software, with or without modifications, in
commercial products.

We disclaim all warranties covering The
FreeType Project and

assume no liability related to The FreeType Project.

Finally, many people asked us for a
preferred form for a

credit/disclaimer to use in compliance with this
license. We thus



encourage you to use the following text:

mnin

Portions of this software are copyright ?<year>
The FreeType

Project (www.freetype.org). All rights reserved.

nin

Please replace <year> with the value from the
FreeType version you

actually use.

Legal Terms

Throughout this license, the terms ‘package’,
‘FreeType Project’,

and ‘FreeType archive' refer to the set of
files originally

distributed by the authors (David Turner,
Robert Wilhelm, and

Werner Lemberg) as the ‘FreeType Project’, be they
named as alpha,

beta or final release.

‘"You' refers to the licensee, or person using the
project, where

‘using' is a generic term including compiling the
project's source

code as well as linking it to form a ‘program’' or
‘executable’.

This program is referred to as ‘a program
using the FreeType

engine’.

This license applies to all files distributed in
the original

FreeType Project, including all source
code, binaries and

documentation, unless otherwise stated in
the file in its

original, unmodified form as distributed in the
original archive.
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If you are unsure whether or not a particular file
is covered by

this license, you must contact us to verify this.

The FreeType Project is copyright (C) 1996-2000
by David Turner,

Robert Wilhelm, and Werner Lemberg. All rights
reserved except as

specified below.

THE FREETYPE PROJECT IS PROVIDED "AS IS'
WITHOUT WARRANTY OF ANY

KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO,

WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR

PURPOSE. IN NO EVENT WILL ANY OF THE
AUTHORS OR COPYRIGHT HOLDERS

BE LIABLE FOR ANY DAMAGES CAUSED BY THE
USE OR THE INABILITY TO

USE, OF THE FREETYPE PROJECT.

This license grants a worldwide, royalty-free,
perpetual and

irrevocable right and license to use, execute,
perform, compile,

display, copy, create derivative works of,
distribute and

sublicense the FreeType Project (in both source
and object code

forms) and derivative works thereof for any
purpose; and to

authorize others to exercise some or all of the
rights granted

herein, subject to the following conditions:

o Redistribution of source code must retain
this license file

('FTL.TXT") unaltered; any additions,
deletions or changes to

the original files must be clearly indicated in
accompanying

documentation. The copyright notices



of the unaltered,

original files must be preservedin all
copies of source

files.

o Redistribution in binary form must provide a
disclaimer that

states that the software is based in part of
the work of the

FreeType Team, in the distribution
documentation. We also

encourage you to put an URL to the FreeType
web page in your

documentation, though this isn't mandatory.

These conditions apply to any software derived
from or based on

the FreeType Project, not just the unmodified
files. If you use

our work, you must acknowledge us. However,
no fee need be paid

to us.

Neither the FreeType authors and contributors
nor you shall use

the name of the other for commercial, advertising,

or promotional

purposes without specific prior written permission.

We suggest, but do not require, that you use one

or more of the

following phrases to refer to this software in your
documentation

or advertising materials: ‘FreeType Project’,
‘FreeType Engine’,

‘FreeType library’, or 'FreeType Distribution'.

As you have not signed this license, you are
not required to

accept it. However, as the FreeType
Project is copyrighted

material, only this license, or another one
contracted with the

authors, grants you the right to use, distribute,
and modify it.
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Therefore, by using, distributing, or modifying

the FreeType

Project, you indicate that you understand and

accept all the terms

of this license.

There are two mailing lists related to FreeType:

o freetype@nongnu.org

Discusses general use and applications of

FreeType, as well as

future and wanted additions to the library

and distribution.

If you are looking for support, startin this

list if you

haven't found anything to help you in the

documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine

internals, design issues,

specific licenses, porting, etc.

Our home page can be found at

http://www freetype.org

---end of FTLTXT ---

The OpenSSL toolkit stays under a dual license, i.e.

both the conditions of

the OpenSSL License and the original SSLeay

license apply to the toolkit.



See below for the actual license texts. Actually both
licenses are BSD-style

Open Source licenses. In case of any license issues
related to OpenSSL

please contact openssl-core@openssl.org.

OpenSSL License

* Copyright (c) 1998-2011 The OpenSSL Project. All
rights reserved.

*

* Redistribution and use in source and binary forms,
with or without

* modification, are permitted provided that the
following conditions

*are met:

*

* 1. Redistributions of source code must retain the
above copyright

*

notice, this list of conditions and the following
disclaimer.

*

* 2. Redistributions in binary form must reproduce
the above copyright

*

notice, this list of conditions and the following
disclaimer in

*

the documentation and/or other materials
provided with the

*

distribution.

*

* 3. All advertising materials mentioning features or
use of this

*

software must display the following
acknowledgment:

*

"This product includes software developed by
the OpenSSL Project

*  for use in the OpenSSL Toolkit.
(http://www.openssl.org/)"

*

* 4. The names "OpenSSL Toolkit" and "OpenSSL
Project" must not be used to

*

endorse or promote products derived from this
software without

*

prior written permission. For written
permission, please contact
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*

openssl-core@openssl.org.

*

* 5. Products derived from this software may not be
called "OpenSSL”

*

nor may "OpenSSL" appear in their names
without prior written

*

permission of the OpenSSL Project.

*

* 6. Redistributions of any form whatsoever must
retain the following

*

acknowledgment:

*

"This product includes software developed by
the OpenSSL Project

*  for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL
PROJECT "AS IS" AND ANY

* EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR

*PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR

*|ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL,

* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT

*NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES;

* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION)

*HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT,

*STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

* This product includes cryptographic software
written by Eric Young

* (eay@cryptsoft.com). This product includes
software written by Tim

* Hudson (tih@cryptsoft.com).

*



Y/

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young
(eay@cryptsoft.com)

* All rights reserved.
* This package is an SSL implementation written
* by Eric Young (eay@cryptsoft.com).

* The implementation was written so as to conform
with Netscapes SSL.

*
* This library is free for commercial and non-
commercial use as long as

* the following conditions are aheared to. The
following conditions

* apply to all code found in this distribution, be it the
RC4, RSA,

* lhash, DES, etc., code; not just the SSL code. The
SSL documentation

*included with this distribution is covered by the
same copyright terms

* except that the holder is Tim Hudson
(tih@cryptsoft.com).

*

* Copyright remains Eric Young's, and as such any
Copyright notices in
* the code are not to be removed.

* If this package is used in a product, Eric Young
should be given attribution

* as the author of the parts of the library used.

* This can be in the form of a textual message at
program startup or

*in documentation (online or textual) provided with
the package.

*
* Redistribution and use in source and binary forms,
with or without

* modification, are permitted provided that the
following conditions

*are met:

* 1. Redistributions of source code must retain the
copyright

*

notice, this list of conditions and the following
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disclaimer.

* 2. Redistributions in binary form must reproduce
the above copyright

*

notice, this list of conditions and the following
disclaimer in the

*

documentation and/or other materials
provided with the distribution.

* 3. All advertising materials mentioning features or
use of this software

*

must display the following acknowledgement:

*

"This product includes cryptographic software
written by

*

Eric Young (eay@cryptsoft.com)”

*

The word 'cryptographic' can be left out if the
rouines from the library

*

being used are not cryptographic related :-).

* 4. 1f you include any Windows specific code (or a
derivative thereof) from

*

the apps directory (application code) you must
include an acknowledgement:

*

"This product includes software written by Tim
Hudson (tjh@cryptsoft.com)”

*

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG
"AS IS" AND

“ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE

* ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHOR OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

* DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS

* OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION)

*HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT

* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY

* OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF

*SUCH DAMAGE.

*

* The licence and distribution terms for any
publically available version or

* derivative of this code cannot be changed. i.e. this



code cannot simply be

* copied and put under another distribution licence
* [including the GNU Public Licence.]

*/

MOZILLA PUBLIC
LICENSE

Version 1.1

1.0.1. "Commercial Use" means distribution or
otherwise making the

Covered Code available to a third party.

1.1. "Contributor" means each entity that creates
or contributes to

the creation of Modifications.

1.2. "Contributor Version" means the
combination of the Original

Code, prior Modifications used by a Contributor,
and the Modifications

made by that particular Contributor.

1.3. "Covered Code" means the Original Code or
Modifications or the

combination of the Original Code and
Modifications, in each case

including portions thereof.

1.4. "Electronic Distribution Mechanism" means
a mechanism generally

accepted in the software development
community for the electronic

transfer of data.

1.5. "Executable" means Covered Code in any
form other than Source

Code.
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1.6. "Initial Developer" means the individual or
entity identified

as the Initial Developer in the Source Code
notice required by Exhibit

A

1.7. "Larger Work" means a work which
combines Covered Code or

portions thereof with code not governed by the
terms of this License.

1.8. "License" means this document.

1.8.1. "Licensable" means having the right to
grant, to the maximum

extent possible, whether at the time of the
initial grant or

subsequently acquired, any and all of the rights
conveyed herein.

1.9. "Modifications" means any addition to or
deletion from the

substance or structure of either the Original
Code or any previous

Modifications. When Covered Code is released
as a series of files, a

Modification is:

A. Any addition to or deletion from the
contents of a file

containing Original Code or previous
Modifications.

B. Any new file that contains any part of
the Original Code or

previous Modifications.

1.10. "Original Code" means Source Code of
computer software code

which is described in the Source Code notice
required by Exhibit A as

Original Code, and which, at the time of its
release under this

License is not already Covered Code governed
by this License.

1.10.1. "Patent Claims" means any patent



claim(s), now owned or

hereafter acquired, including without
limitation, method, process,

and apparatus claims, in any patent Licensable
by grantor.

1.11. "Source Code" means the preferred form of
the Covered Code for

making modifications to it, including all modules
it contains, plus

any associated interface definition files, scripts
used to control

compilation and installation of an Executable,
or source code

differential comparisons against either the
Original Code or another

well known, available Covered Code of the
Contributor's choice. The

Source Code can be in a compressed or
archival form, provided the

appropriate decompression or de-archiving
software is widely available

for no charge.

1.12."You" (or "Your") means an individual or a
legal entity

exercising rights under, and complying with all
of the terms of, this

License or a future version of this License
issued under Section 6.1.

For legal entities, "You" includes any entity
which controls, is

controlled by, or is under common control with
You. For purposes of

this definition, "control" means (a) the power,
direct or indirect,

to cause the direction or management of such
entity, whether by

contract or otherwise, or (b) ownership of more
than fifty percent

(50%) of the outstanding shares or beneficial
ownership of such

entity.

2.1. The Initial Developer Grant.

The Initial Developer hereby grants You a world-
wide, royalty-free,
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non-exclusive license, subject to third party
intellectual property

claims:

(@) under intellectual property rights
(other than patent or

trademark) Licensable by Initial
Developer to use, reproduce,

modify, display, perform, sublicense and
distribute the Original

Code (or portions thereof) with or
without Modifications, and/or

as part of a Larger Work; and

(b) under Patents Claims infringed by the
making, using or

selling of Original Code, to make, have
made, use, practice,

sell, and offer for sale, and/or otherwise
dispose of the

Original Code (or portions thereof).

(c) the licenses granted in this Section
2.1(a) and (b) are

effective on the date Initial Developer
first distributes

Original Code under the terms of this
License.

(d) Notwithstanding Section 2.1(b) above,
no patent license is

granted: 1) for code that You delete from
the Original Code; 2)

separate from the Original Code; or 3)
for infringements caused

by: i) the modification of the Original
Code orii) the

combination of the Original Code with
other software or devices.

2.2. Contributor Grant.

Subject to third party intellectual property
claims, each Contributor

hereby grants You a world-wide, royalty-free,
non-exclusive license

(@) under intellectual property rights
(other than patent or



trademark) Licensable by Contributor, to
use, reproduce, modify,

display, perform, sublicense and
distribute the Modifications

created by such Contributor (or portions
thereof) either on an

unmodified basis, with other
Modifications, as Covered Code

and/or as part of a Larger Work; and

(b) under Patent Claims infringed by the
making, using, or

selling of Modifications made by that
Contributor either alone

and/or in combination with its
Contributor Version (or portions

of such combination), to make, use, sell,
offer for sale, have

made, and/or otherwise dispose of: 1)
Modifications made by that

Contributor (or portions thereof); and 2)
the combination of

Modifications made by that Contributor
with its Contributor

Version (or portions of such
combination).

(c) the licenses granted in Sections 2.2(a)
and 2.2(b) are

effective on the date Contributor first
makes Commercial Use of

the Covered Code.

(d) Notwithstanding Section 2.2(b)
above, no patent license is

granted: 1) for any code that Contributor
has deleted from the

Contributor Version; 2) separate from
the Contributor Version;

3) for infringements caused by: i) third
party modifications of

Contributor Version orii) the
combination of Modifications made

by that Contributor with other software
(except as part of the

Contributor Version) or other devices; or
4) under Patent Claims

infringed by Covered Code in the
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absence of Modifications made by

that Contributor.

3.1. Application of License.

The Modifications which You create or to which
You contribute are

governed by the terms of this License, including
without limitation

Section 2.2. The Source Code version of
Covered Code may be

distributed only under the terms of this License
or a future version

of this License released under Section 6.1, and
You must include a

copy of this License with every copy of the
Source Code You

distribute. You may not offer or impose any
terms on any Source Code

version that alters or restricts the applicable
version of this

License or the recipients' rights hereunder.
However, You may include

an additional document offering the additional
rights described in

Section 3.5.

3.2. Availability of Source Code.

Any Modification which You create or to which
You contribute must be

made available in Source Code form under the
terms of this License

either on the same media as an Executable
version or via an accepted

Electronic Distribution Mechanism to anyone to
whom you made an

Executable version available; and if made
available via Electronic

Distribution Mechanism, must remain available
for at least twelve (12)

months after the date it initially became
available, or at least six

(6) months after a subseguent version of that
particular Modification

has been made available to such recipients.
You are responsible for

ensuring that the Source Code version remains
available even if the



Electronic Distribution Mechanism is maintained
by a third party.

3.3. Description of Modifications.

You must cause all Covered Code to which You
contribute to contain a

file documenting the changes You made to
create that Covered Code and

the date of any change. You must include a
prominent statement that

the Modification is derived, directly or indirectly,
from Original

Code provided by the Initial Developer and
including the name of the

Initial Developer in (a) the Source Code, and (b)
in any notice in an

Executable version or related documentation in
which You describe the

origin or ownership of the Covered Code.

3.4. Intellectual Property Matters
(a) Third Party Claims.

If Contributor has knowledge that a
license under a third party's

intellectual property rights is required to
exercise the rights

granted by such Contributor under
Sections 2.1or 2.2,

Contributor must include a text file with
the Source Code

distribution titled "LEGAL" which
describes the claim and the

party making the claim in sufficient detail
that a recipient will

know whom to contact. If Contributor
obtains such knowledge after

the Modification is made available as
described in Section 3.2,

Contributor shall promptly modify the
LEGAL file in all copies

Contributor makes available thereafter
and shall take other steps

(such as notifying appropriate mailing
lists or newsgroups)

reasonably calculated to inform those
who received the Covered

Code that new knowledge has been
obtained.
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(b) Contributor APIs.

If Contributor's Modifications include an
application programming

interface and Contributor has knowledge
of patent licenses which

are reasonably necessary to implement
that API, Contributor must

also include this information in the
LEGAL file.

(c) Representations.

Contributor represents that, except as
disclosed pursuant to

Section 3.4(a) above, Contributor
believes that Contributor's

Modifications are Contributor's original
creation(s) and/or

Contributor has sufficient rights to grant
the rights conveyed by

this License.

3.5. Required Notices.

You must duplicate the notice in Exhibit A in
each file of the Source

Code. Ifitis not possible to put such notice in
a particular Source

Code file due to its structure, then You must
include such notice in a

location (such as a relevant directory) where a
user would be likely

to look for such a notice. If You created one or
more Modification(s)

You may add your name as a Contributor to the
notice described in

Exhibit A. You must also duplicate this License
in any documentation

for the Source Code where You describe
recipients' rights or ownership

rights relating to Covered Code. You may
choose to offer, and to

charge a fee for, warranty, support, indemnity or
liability

obligations to one or more recipients of
Covered Code. However, You

may do so only on Your own behalf, and not on
behalf of the Initial

Developer or any Contributor. You must make it



absolutely clear than

any such warranty, support, indemnity or
liability obligation is

offered by You alone, and You hereby agree to
indemnify the Initial

Developer and every Contributor for any
liability incurred by the

Initial Developer or such Contributor as a result
of warranty,

support, indemnity or liability terms You offer.

3.6. Distribution of Executable Versions.

You may distribute Covered Code in Executable
form only if the

requirements of Section 3.1-3.5 have been met
for that Covered Code,

and if You include a notice stating that the
Source Code version of

the Covered Code is available under the terms
of this License,

including a description of how and where You
have fulfilled the

obligations of Section 3.2. The notice must be
conspicuously included

in any notice in an Executable version, related
documentation or

collateral in which You describe recipients'
rights relating to the

Covered Code. You may distribute the
Executable version of Covered

Code or ownership rights under a license of
Your choice, which may

contain terms different from this License,
provided that You are in

compliance with the terms of this License and
that the license for the

Executable version does not attempt to limit or
alter the recipient's

rights in the Source Code version from the rights
set forth in this

License. If You distribute the Executable version
under a different

license You must make it absolutely clear that
any terms which differ

from this License are offered by You alone, not
by the Initial

Developer or any Contributor. You hereby agree
to indemnify the
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Initial Developer and every Contributor for any
liability incurred by

the Initial Developer or such Contributor as a
result of any such

terms You offer.

3.7. Larger Works.

You may create a Larger Work by combining
Covered Code with other code

not governed by the terms of this License and
distribute the Larger

Work as a single product. In such a case, You
must make sure the

requirements of this License are fulfilled for the
Covered Code.

If it is impossible for You to comply with any of
the terms of this

License with respect to some or all of the
Covered Code due to

statute, judicial order, or regulation then You
must: (a) comply with

the terms of this License to the maximum extent
possible; and (b)

describe the limitations and the code they
affect. Such description

must be included in the LEGAL file described in
Section 3.4 and must

be included with all distributions of the Source
Code. Except to the

extent prohibited by statute or regulation, such
description must be

sufficiently detailed for a recipient of ordinary
skill to be able to

understand it.

This License applies to code to which the Initial
Developer has

attached the notice in Exhibit A and to related
Covered Code.

6.1. New Versions.

Netscape Communications Corporation
("Netscape") may publish revised



and/or new versions of the License from time to
time. Each version

will be given a distinguishing version number.

6.2. Effect of New Versions.

Once Covered Code has been published under
a particular version of the

License, You may always continue to use it
under the terms of that

version. You may also choose to use such
Covered Code under the terms

of any subsequent version of the License
published by Netscape. No one

other than Netscape has the right to modify the
terms applicable to

Covered Code created under this License.

6.3. Derivative Works.

If You create or use a modified version of this
License (which you may

only doin order to apply it to code which is not
already Covered Code

governed by this License), You must (a) rename
Your license so that

the phrases "Mozilla", "MOZILLAPL", "MOZPL",
"Netscape”,

"MPL", "NPL" or any confusingly similar phrase
do not appear in your

license (except to note that your license differs
from this License)

and (b) otherwise make it clear that Your
version of the license

contains terms which differ from the Mozilla
Public License and

Netscape Public License. (Filling in the name of
the Initial

Developer, Original Code or Contributor in the
notice described in

Exhibit A shall not of themselves be deemed to
be modifications of

this License.)

COVERED CODE IS PROVIDED UNDER THIS
LICENSE ON AN "AS IS" BASIS,

WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING,
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WITHOUT LIMITATION, WARRANTIES THAT
THE COVERED CODE IS FREE OF

DEFECTS, MERCHANTABLE, FIT FOR A
PARTICULAR PURPOSE OR NON-INFRINGING.

THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE COVERED CODE

IS WITH YOU. SHOULD ANY COVERED CODE
PROVE DEFECTIVE IN ANY RESPECT,

YOU (NOT THE INITIAL DEVELOPER OR ANY
OTHER CONTRIBUTOR) ASSUME THE

COST OF ANY NECESSARY SERVICING, REPAIR
OR CORRECTION. THIS DISCLAIMER

OF WARRANTY CONSTITUTES AN ESSENTIAL
PART OF THIS LICENSE. NO USE OF

ANY COVERED CODE IS AUTHORIZED
HEREUNDER EXCEPT UNDER THIS DISCLAIMER.

8.1. This License and the rights granted
hereunder will terminate

automatically if You fail to comply with terms
herein and fail to cure

such breach within 30 days of becoming aware
of the breach. All

sublicenses to the Covered Code which are
properly granted shall

survive any termination of this License.
Provisions which, by their

nature, must remain in effect beyond the
termination of this License

shall survive.

8.2. If You initiate litigation by asserting a
patent infringement

claim (excluding declatory judgment actions)
against Initial Developer

or a Contributor (the Initial Developer or
Contributor against whom

You file such action is referred to as
"Participant") alleging that:

(a) such Participant's Contributor Version
directly or indirectly

infringes any patent, then any and all rights
granted by such

Participant to You under Sections 2.1 and/or 2.2
of this License

shall, upon 60 days notice from Participant



terminate prospectively,

unless if within 60 days after receipt of notice
You either: (i)

agree in writing to pay Participant a mutually
agreeable reasonable

royalty for Your past and future use of
Modifications made by such

Participant, or (ii) withdraw Your litigation claim
with respect to

the Contributor Version against such
Participant. If within 60 days

of notice, a reasonable royalty and payment
arrangement are not

mutually agreed upon in writing by the parties
or the litigation claim

is not withdrawn, the rights granted by
Participant to You under

Sections 2.1 and/or 2.2 automatically terminate
at the expiration of

the 60 day notice period specified above.

(b) any software, hardware, or device, other
than such Participant's

Contributor Version, directly or indirectly
infringes any patent, then

any rights granted to You by such Participant
under Sections 2.1(b)

and 2.2(b) are revoked effective as of the date
You first made, used,

sold, distributed, or had made, Modifications
made by that

Participant.

8.3. If You assert a patent infringement claim
against Participant

alleging that such Participant's Contributor
Version directly or

indirectly infringes any patent where such claim
is resolved (such as

by license or settlement) prior to the initiation of
patent

infringement litigation, then the reasonable
value of the licenses

granted by such Participant under Sections 2.1
or 2.2 shall be taken

into account in determining the amount or
value of any payment or

license.
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8.4. In the event of termination under Sections
8.10r 8.2 above,

all end user license agreements (excluding
distributors and resellers)

which have been validly granted by You or any
distributor hereunder

prior to termination shall survive termination.

UNDER NO CIRCUMSTANCES AND UNDER NO
LEGAL THEORY, WHETHER TORT

(INCLUDING NEGLIGENCE), CONTRACT, OR
OTHERWISE, SHALL YOU, THE INITIAL

DEVELOPER, ANY OTHER CONTRIBUTOR, OR
ANY DISTRIBUTOR OF COVERED CODE,

OR ANY SUPPLIER OF ANY OF SUCH PARTIES,
BE LIABLE TO ANY PERSON FOR

ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES OF ANY

CHARACTER INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF GOODWILL,

WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER

COMMERCIAL DAMAGES OR LOSSES, EVEN IF
SUCH PARTY SHALL HAVE BEEN

INFORMED OF THE POSSIBILITY OF SUCH
DAMAGES. THIS LIMITATION OF

LIABILITY SHALL NOT APPLY TO LIABILITY FOR
DEATH OR PERSONAL INJURY

RESULTING FROM SUCH PARTY'S
NEGLIGENCE TO THE EXTENT APPLICABLE LAW

PROHIBITS SUCH LIMITATION. SOME
JURISDICTIONS DO NOT ALLOW THE

EXCLUSION OR LIMITATION OF INCIDENTAL
OR CONSEQUENTIAL DAMAGES, SO

THIS EXCLUSION AND LIMITATION MAY NOT
APPLY TO YOU.

The Covered Code is a "commercial item," as
that term is defined in

48 C.F.R. 2101 (Oct. 1995), consisting of
"commercial computer

software" and "commercial computer software
documentation," as such

terms are used in 48 C.F.R. 12.212 (Sept. 1995).
Consistent with 48



CF.R.12212 and 48 C.F.R. 227.7202-1 through
227.7202-4 (June 1995),

all U.S. Government End Users acquire Covered
Code with only those

rights set forth herein.

This License represents the complete
agreement concerning subject

matter hereof. If any provision of this License is
held to be

unenforceable, such provision shall be
reformed only to the extent

necessary to make it enforceable. This License
shall be governed by

California law provisions (except to the extent
applicable law, if

any, provides otherwise), excluding its conflict-
of-law provisions.

With respect to disputes in which at least one
party is a citizen of,

or an entity chartered or registered to do
business in the United

States of America, any litigation relating to this
License shall be

subject to the jurisdiction of the Federal Courts
of the Northern

District of California, with venue lying in Santa
Clara County,

California, with the losing party responsible for
costs, including

without limitation, court costs and reasonable
attorneys' fees and

expenses. The application of the United Nations
Convention on

Contracts for the International Sale of Goods is
expressly excluded.

Any law or regulation which provides that the
language of a contract

shall be construed against the drafter shall not
apply to this

License.

As between Initial Developer and the
Contributors, each party is

responsible for claims and damages arising,
directly or indirectly,

out of its utilization of rights under this License
and You agree to

work with Initial Developer and Contributors to
distribute such

responsibility on an equitable basis. Nothing
herein is intended or

shall be deemed to constitute any admission of
liability.

Initial Developer may designate portions of the
Covered Code as

"Multiple-Licensed". "Multiple-Licensed"
means that the Initial

Developer permits you to utilize portions of the
Covered Code under

Your choice of the NPL or the alternative
licenses, if any, specified

by the Initial Developer in the file described in
Exhibit A.

EXHIBIT A -Mozilla Public License.

"The contents of this file are subject to the
Mozilla Public License

Version 1.1 (the "License"); you may not use this
file exceptin

compliance with the License. You may obtain a
copy of the License at

http://www.mozilla.org/MPL/

Software distributed under the License is
distributed on an "AS IS"

basis, WITHOUT WARRANTY OF ANY KIND,
either express or implied. See the

License for the specific language governing
rights and limitations

under the License.

The Original Code is

The Initial Developer of the Original Code is

Portions created by are Copyright (C)

. All Rights Reserved.

Contributor(s):



Alternatively, the contents of this file may be
used under the terms

of the license (the |

which case the

] License"), in

provisions of [
instead of those

] License are applicable

above. If you wish to allow use of your version
of this file only

under the terms of the [_
allow others to use

] License and not to

your version of this file under the MPL, indicate
your decision by

deleting the provisions above and replace
them with the notice and

other provisions required by the [___] License.
If you do not delete

the provisions above, a recipient may use your
version of this file

under either the MPL or the [___] License."

[INOTE: The text of this Exhibit A may differ
slightly from the text of

the notices in the Source Code files of the
Original Code. You should

use the text of this Exhibit A rather than the text
found in the

Original Code Source Code for Your
Modifications]

17.5
Announcements

You can receive an announcement on new TV
software available for download or other software
related issues.

To read these announcements...

1- Press {£#, select All Settings and press OK.
2 - Select Update Software > Announcements.

3 - Select on the announcement you want to read.

4 - Press o (left) repeatedly if necessary, to close
the menu.
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18

Specifications

18.1
Environmental

European Energy Label

The European Energy Label informs you on the
energy efficiency class of this product. The greener
the energy efficiency class of this product is, the
lower the energy it consumes.

On the label, you can find the energy efficiency class,
the average power consumption of this product in use
and the average energy consumption for 1 year. You
can also find the power consumption values for this
product on the Philips website for your country

at www.philips.com/TV

Product Fiche

43PUx7100

- Energy Efficiency Class : A

- Visible Screen Size : 108 cm / 43 inch

- On Mode Power Consumption (W) : 65 W

- Annual Energy Consumption (kWh) * : 95 kWh
- Standby Power Consumption (W) **: 0.50 W

- Display Resolution (Pixels) : 3840 x 2160p

49PUx7100

- Energy Efficiency Class : A

- Visible Screen Size : 123 cm / 49 inch

- On Mode Power Consumption (W) : 75 W

- Annual Energy Consumption (kWh) *: 110 kWh
- Standby Power Consumption (W) **: 0.50 W

- Display Resolution (Pixels) : 3840 x 2160p

55PUx7100

- Energy Efficiency Class : A

- Visible Screen Size : 139 cm / 55 inch

- On Mode Power Consumption (W) : 92 W

- Annual Energy Consumption (kWh) * : 134 kWh
- Standby Power Consumption (W) **: 0.50 W

- Display Resolution (Pixels) : 3840 x 2160p

65PUx7120

- Energy Efficiency Class : A

- Visible Screen Size : 164 cm / 65 inch

- On Mode Power Consumption (W) : 133 W

- Annual Energy Consumption (kWh) *: 194 kWh
- Standby Power Consumption (W) **: 0.50 W

- Display Resolution (Pixels) : 3840 x 2160p

* Energy consumption kWh per year, based on the
power consumption of the television operating 4
hours per day for 365 days. The actual energy
consumption depends on how the television is used.

** When the TV is turned off with the remote control
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and no function is active.

End of Use

Disposal of your old product and batteries

Your product is designed and manufactured with high
quality materials and components, which can be
recycled and reused.

~,

Yad

When this crossed-out wheeled bin symbol is

attached to a product it means that the product is

covered by the European Directive 2002/96/EC.
===

Please inform yourself about the local separate

collection system for electrical and electronic
products.

Please act according to your local rules and do not
dispose of your old products with your normal
household waste. Correct disposal of your old
product helps to prevent potential negative
conseqguences for the environment and human
health.

Your product contains batteries covered by the
European Directive 2006/66/EC, which cannot be
disposed with normal household waste.

Please find out for yourself about the local rules on
separate collection of batteries because correct

disposal will help to prevent negative consequences
for the environment and human health.

18.2
Power

Product specifications are subject to change without
notice. For more specification details of this product,

see www.philips.com/support

Power

- Mains power : AC 220-240V +/-10%

- Ambient temperature : 5°C to 35°C

- Power saving features : Light sensor, Eco mode,
Picture mute (for radio), Auto switch-off timer, Eco
settings menu.


http://www.philips.com/support

For power consumption information, see chapter
Product Fiche.

The power rating stated on the product typeplate is
the power consumption for this product during
normal household use (IEC 62087 Ed.2). The
maximum power rating, stated between brackets, is
used for electrical safety (IEC 60065 Ed. 7.2).

18.3
Operating System

Android OS
5.0 Lollipop

18.4
Reception

- Aerial input : 75 ohm coaxial (IEC75)

- Tuner bands : Hyperband, S-Channel, UHF, VHF
- DVB : DVB-T (terrestrial, antenna) COFDM 2K/8K,
DVB-C (cable) QAM

- Analogue video playback : SECAM, PAL

- Digital video playback : MPEG2 SD/HD (ISO/IEC
13818-2), MPEG4 SD/HD (ISO/IEC 14496-10)

- Digital audio playback (ISO/IEC 13818-3)

- Satellite aerial input : 75 ohm F-type

- Input frequency range : 950 to 2150MHz

- Input level range : 25 to 65 dBm

- DVB-S/S2 QPSK, symbol rate 2 to 45M symbols,
SCPC and MCPC

- LNB : DISEqC 1.0, 1to 4 LNBs supported, Polarity
selection 14/18V, Band selection 22kHz, Tone burst
mode, LNB current 300mA max

18.5

Display

Type

Diagonal screen size

- 43PUx7100 : 108 cm / 43 inch
- 49PUx7100 : 123 ¢cm / 49 inch
- 55PUx7100 :139 ¢cm / 55 inch
- 65PUx7120 : 164 cm / 65 inch

Display resolution
- 3840 x 2160p
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Input Resolution

Video formats
Resolution — Refresh rate

- 480i - 60 Hz

- 480p - 60 Hz

- 576i - 50 Hz

- 576p - 50 Hz

- 720p - 50 Hz, 60 Hz

- 1080i - 50 Hz, 60 Hz

- 1080p - 24 Hz, 25 Hz, 30 HZz

- 2160p - 24 Hz, 25 Hz, 30 Hz, 50 Hz, 60 Hz

Computer formats
Resolutions (amongst others)

- 640 x 480p - 60 Hz

- 800 x 600p - 60 Hz

- 1024 x 768p - 60 Hz

- 1280 x 768p - 60 Hz

- 1360 x 765p - 60 Hz

- 1360 x 768p - 60 Hz

- 1280 x 1024p - 60 Hz

- 1920 x 1080p - 60 Hz

- 3840 x 2160p - 24 Hz, 25 Hz, 30 Hz, 50 Hz, 60 Hz

18.6
Dimensions and Weights

43PUx7100

- without TV stand:

Width 970.2 mm - Height 574.6 mm - Depth 36.7 mm
- Weight + 10.85 kg

- with TV stand:

Width 1017.7 mm - Height 626.7 mm - Depth 213.5 mm
- Weight + 11.1 kg

49PUx7100

- without TV stand:

Width 1102.8 mm - Height 638.5 mm - Depth 36.7 mm
- Weight = 13.6 kg

- with TV stand:

Width 1149 mm - Height 701 mm - Depth 255.2 mm -
Weight + 13.9 kg

55PUx7100

- without TV stand:

Width 1238.6 mm - Height 714.9 mm - Depth 36.7
mm - Weight + 16.78 kg

- with TV stand:
Width 1285.1 mm - Height 777.4 mm - Depth 272 mm -
Weight + 17.11 kg

65PUx7120



- without TV stand:
Width 1457.8 mm - Height 835.7 mm - Depth 55.3 mm
- Weight = 32.7 kg

- with TV stand:
Width 1508.9 mm - Height 898.2 mm - Depth 293 mm
- Weight + 33.5 kg

18.7
Connectivity

TV Side

- Headphones - Stereo mini-jack 3.5mm
- 2x HDMI in

- 2x USB 2.0

- Ix Common Interface slot: Cl+/CAM

TV Rear

- Audio In (DVI to HDMI) - Stereo mini-jack 3.5mm
- SCART: Audio L/R, CVBS in, RGB

- YPbPr:Y Pb Pr, Audio L/R

TV Bottom

- HDMI 1in - ARC - HDMI 2.0
- HDMI 2 in - ARC - HDMI 2.0
- Ix USB 2.0

- Audio out - Optical Toslink

- Network LAN - RJ45

- Antenna (75K)

- Satellite tuner

18.8
Sound

- 3D wOOx

- HD Stereo

- Output power (RMS) : 20W
- Dolby® Digital Plus

- DTS Premium Sound ™

189
Multimedia

Connections

-USB 2.0

- Ethernet LAN RJ-45

- Wi-Fi 802.11b/g/n (built-in)
Supported USB file systems
- FAT 16, FAT 32, NTFS

Playback formats

- Containers : 3GP, AVCHD, AVI, MPEG-PS, MPEG-TS,
MPEG-4, Matroska (MKV), Quicktime (MOV, M4V,
M4A), Windows Media (ASF/WMV/WMA)

- Video Codecs : MPEG-1, MPEG-2, MPEG-4 Part 2,
MPEG-4 Part 10 AVC (H264), VC-1, WMV9, H.265

(HEVQ)

- Audio Codecs : AAC, HE-AAC (v1/v2), AMR-NB,
Dolby Digital, Dolby Digital Plus, DTS Premium
Sound™, MPEG-1/2/2.5 Layer I/1l/lll (includes MP3),
WMA (v2 to v9.2), WMA Pro (v9/v10)

- Subtitles :

— Formats : SAMI, SubRip (SRT), SubViewer (SUB),
MicroDVD (TXT), mplayer2 (TXT), TMPlayer (TXT)

— Character encodings : UTF-8, Central Europe and
Eastern Europe (Windows-1250), Cyrillic
(Windows-1251), Greek (Windows-1253), Turkish
(Windows-1254), Western Europe (Windows-1252)

- Image Codecs : JPEG, JPS, MPO

- Limitations :

— Maximum supported total bit rate for a media file is
30Mbps.

— Maximum supported video bit rate for a media file
is 20Mbps.

— MPEG-4 AVC (H.264) is supported up to High
Profile @ L4.1.

— H.265 (HEVQ) is supported upto Main / Main 10
Profile up to Level 5.1

— VC-Tis supported up to Advanced Profile @ L3.

Wi-Fi Certified
This TV supports WiDi 4.x devices.

Supported media server software (DMS)

- PC - Microsoft Windows XP, Vista or Windows 7
— You can use any DLNA certified® media server
software.

— Microsoft - Windows Media Player

- Mac OS X

— You can use any DLNA certified® media server
software.

- Mobile devices

— Philips TV Remote app - i0OS, Android

— Interoperability and performance may vary,
depending on the capabilities of the mobile device
and the software used.

ESD regulations

This apparatus meets performance criteria B for ESD.
In case the apparatus does not recover in file sharing
mode due to electrostatic discharge, user interference
is required.



Help and Support
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Register

Register your TV and enjoy a range of benefits
including full support (including downloads),
privileged access to information about new products,
exclusive offers and discounts, the chance to win
prizes and even participate in special surveys about
new releases.

Go to www.philips.com/welcome

19.2
Troubleshooting

Channels

No digital channels found during the installation

See the technical specifications to make sure that
your TV supports DVB-T or DVB-C in your country.
Make sure that all cables are properly connected and
that the correct network is selected.

Previously installed channels are not in the channel
list

Make sure that the correct channel list is selected.

General

The TV does not switch on

- Disconnect the power cable from the power outlet.
Wait for one minute then reconnect it.

- Make sure that the power cable is securely
connected.

Creaking sound at startup or switch off

When you are switching the TV on, off or to Standby,
you hear a creaking sound from the TV chassis. The
creaking sound is due to the normal expansion and
contraction of the TV as it cools and warms up. This
does not affect performance.

TV does not respond to the remote control

The TV requires some time to start up. During this
time, the TV does not respond to the remote control
or TV controls. This is normal behaviour.

If the TV continues to be unresponsive to the remote
control, you can check if the remote control is working
by means of a mobile phone camera. Put the phone
in camera mode and point the remote control to the
camera lens. If you press any key on the remote
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control and you notice the infra red LED flicker
through the camera, the remote control is working.
The TV needs to be checked.

If you do not notice the flickering, the remote control
might be broken or its batteries are low.

This method of checking the remote control is not
possible with remote controls which are wirelessly
paired with the TV.

The TV goes back to Standby after showing the
Philips startup screen

When the TV is in Standby, a Philips startup screen is
displayed, then the TV returns to Standby mode. This
is normal behaviour. When the TV is disconnected
and reconnected to the power supply, the startup
screen is displayed at the next startup. To switch on
the TV from Standby, press on the remote control or
the TV.

The Standby light keeps on blinking

Disconnect the power cable from the power outlet.
Wait 5 minutes before you reconnect the power
cable. If the blinking reoccurs, contact Philips TV
Consumer Care.

Picture

No picture / distorted picture

- Make sure that the antenna is properly connected to
the TV.

- Make sure that the correct device is selected as the
display source.

- Make sure that the external device or source is
properly connected.

Sound but no picture
- Make sure that the picture settings are set correctly.

Poor antenna reception

- Make sure that the antenna is properly connected to
the TV.

- Loud speakers, unearthed audio devices, neon
lights, high buildings and other large objects can
influence reception quality. If possible, try to improve
the reception quality by changing the antenna
direction or moving devices away from the TV.

- If reception on only one channel is poor, fine-tune
this channel with Manual Installation.

Poor picture from a device
- Make sure that the device is connected properly.
- Make sure that the picture settings are set correctly.

Picture settings change after a while

Make sure that Location is set to Home . You can
change and save settings in this mode.

A commercial banner appears

Make sure that Locationissetto Home.

Picture does not fit the screen



Change to a different picture format.

Picture format keeps changing with different
channels

Select a non 'Auto’ picture format.

Picture position is incorrect

Picture signals from some devices may not fit the
screen correctly. Check the signal output of the
connected device.

Computer picture is not stable

Make sure that your PC uses the supported resolution
and refresh rate.

Sound

No sound or poor sound quality

If no audio signal is detected, the TV automatically
switches the audio output off — this does not indicate
malfunction.

- Make sure that the sound settings are correctly set.

- Make sure that all cables are properly connected.

- Make sure that the volume is not muted or set to
zero.

- Make sure that the TV audio output is connected to
the audio input on the Home Theatre System.

Sound should be heard from the HTS speakers.

- Some devices may require you to manually enable
HDMI audio output. If HDMI audio is already enabled,
but you still do not hear audio, try changing the digital
audio format of the device to PCM (Pulse Code
Modulation). Refer to the documentation
accompanying your device for instructions.

Connections

HDMI

- Note that HDCP (High-bandwidth Digital Content
Protection) support can delay the time taken fora TV
to display content from an HDMI device.

- If the TV does not recognise the HDMI device and
no picture is displayed, switch the source from one
device to another and back again.

- If there are intermittent sound disruptions, make
sure that output settings from the HDMI device are
correct.

- If you use an HDMI-to-DVI adapter or HDMI-to-DVI
cable, make sure that an additional audio cable is
connected to AUDIO IN (mini-jack only), if available.

EasyLink does not work

- Make sure that your HDMI devices are HDMI-CEC
compatible. EasyLink features only work with devices
that are HDMI-CEC compatible.

No volume icon shown
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- When an HDMI-CEC audio device is connected this
behaviour is normal.
Photos, videos and music from a USB device do not

show

- Make sure that the USB storage device is set to Mass
Storage Class compliant, as described in the storage
device's documentation.

- Make sure that the USB storage device is compatible
with the TV.

- Make sure that the audio and picture file formats are
supported by the TV.

Choppy playback of USB files

- The transfer performance of the USB storage device
may limit the data transfer rate to the TV which
causes poor playback.

19.3

Help

This TV offers help on screen.

Open Help

Press the == key (blue) to open Help immediately.
Help will open on the chapter that is most relevant to
what you are doing or what is selected on TV. To look
up topics alphabetically, select Keywords .

To read the Help as a book, select Book.

Before you execute the Help instructions, close Help.
To close Help, press the colour key == Close .

For some activities, like Text (Teletext), the colour
keys have specific functions and cannot open Help.

TV Help on your tablet, smartphone or computer

To carry out extended sequences of instructions more
easily, you can download the TV Help in PDF format
to read on your smartphone, tablet or

computer. Alternatively, you can print the relevant
Help page from your computer.

To download the Help (user manual) go

to www.philips.com/support

MVL_v37_20160516

19.4

Online Help

To solve any Philips TV related problem, you can
consult our online support. You can select your
language and enter your product model number.

Go to www.philips.com/support .

On the support site you can find your country's
telephone number to contact us as well as answers to
frequently asked questions (FAQs). In some countries,
you can chat with one of our collaborators and ask


http://www.philips.com/support

your question directly or send a question by email.
You can download new TV software or the manual to
read on your computer.

19.5
Repair

For support and repair, call the Consumer Care
hotline in your country. Find the telephone number in
the printed documentation that came with the TV.

Or consult our website www.philips.com/support .

TV model number and serial number

You might be asked to provide the TV product model
number and serial number. Find these numbers on
the packaging label or on the type label on the back
or bottom of the TV.

A Warning

Do not attemp to repair the TV yourself. This may
cause severe injury, irrepairable damage to your TV or
void your warranty.
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Safety and Care
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Safety

Important

Read and understand all safety instructions before
you use the TV. If damage is caused by failure to
follow instructions, the warranty does not apply.

Secure the TV from Falling Over

Always use the supplied wall bracket to secure the TV
from falling over. Mount the bracket and secure the
TV onto the bracket, even if you put the TV on the
floor.

You can find the mounting instructions in the Quick
Start Guide that came with the TV. In case you lost
this guide, you can download the guide

from www.philips.com

Use the product type number of the TV to look for the
Quick Start Guide to download.

Risk of Electric Shock or Fire

- Never expose the TV to rain or water. Never place
liguid containers, such as vases, near the TV.

If liguids are spilt on or into the TV, disconnect the TV
from the power outlet immediately.

Contact Philips TV Consumer Care to have the TV
checked before use.

- Never expose the TV, remote control or batteries to
excessive heat. Never place them near burning
candles, naked flames or other heat sources,
including direct sunlight.

- Never insert objects into the ventilation slots or other
openings on the TV.

- Never place heavy objects on the power cord.

- Avoid force coming onto power plugs. Loose power
plugs can cause arcing or fire. Ensure that no strain is
exerted on the power cord when you swivel the TV
screen.

- To disconnect the TV from the mains power, the
power plug of the TV must be disconnected. When
disconnecting the power, always pull the power plug,
never the cord. Ensure that you have full access to
the power plug, power cord and outlet socket at all
times.
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Risk of Injury or Damage to the TV

- Two people are required to lift and carry a TV that
weighs more than 25 kg or 55 Ibs.

- If you mount the TV on a stand, only use the
supplied stand. Secure the stand to the TV tightly.
Place the TV on a flat, level surface that can support
the weight of the TV and the stand.

- When wall mounted, ensure that the wall mount can
safely bear the weight of the TV set. TP Vision bears
no responsibility for improper wall mounting that
results in accident, injury or damage.

- Parts of this product are made of glass. Handle with
care to avoid injury or damage.

Risk of damage to the TV !

Before you connect the TV to the power outlet,
ensure that the power voltage matches the value
printed on the back of the TV. Never connect the TV
to the power outlet if the voltage is different.

Risk of Injury to Children

Follow these precautions to prevent the TV from
toppling over and causing injury to children:

- Never place the TV on a surface covered by a cloth
or other material that can be pulled away.

- Ensure that no part of the TV hangs over the edge of
the mounting surface.

- Never place the TV on tall furniture, such as a
bookcase, without anchoring both the furniture and
TV to the wall or a suitable support.

- Teach children about the dangers of climbing on
furniture to reach the TV.

Risk of swallowing batteries !

The remote control may contain coin-type batteries
which can easily be swallowed by small children.
Keep these batteries out of reach of children at all
times.

Risk of Overheating

Never install the TV in a confined space. Always leave
a space of at least 10 cm or 4 inches around the TV
for ventilation. Ensure curtains or other objects never
cover the ventilation slots on the TV.


http://www.philips.com

Lightning Storms

Disconnect the TV from the power outlet and antenna
before lightning storms.

During lightning storms, never touch any part of the
TV, power cord or antenna cable.

Risk of Hearing Damage

Avoid using earphones or headphones at high
volumes or for prolonged periods of time.

Low Temperatures

If the TV is transported in temperatures below 5°C or
41°F, unpack the TV and wait until the TV temperature
reaches room temperature before connecting the TV
to the power outlet.

Humidity

In rare occasions, depending on temperature and
humidity, minor condensation can occur on the inside
of the TV glass front (on some models). To prevent
this, do not expose the TV to direct sunlight, heat or
extreme humidity. If condensation occurs, it will
disappear spontaneously while the TV is playing for a
few hours.

The condensation moisture will not harm the TV or
cause malfunction.

20.2
Screen Care

- Never touch, push, rub or strike the screen with any
object.

- Unplug the TV before cleaning.

- Clean the TV and frame with a soft damp cloth and
wipe gently. Avoid touching the Ambilight LEDs on
the backside of the TV. Never use substances such as
alcohol, chemicals or household cleaners on the TV.
- To avoid deformations and colour fading, wipe off
water drops as quickly as possible.

- Avoid stationary images as much as possible.
Stationary images are images that remain onscreen
for extended periods of time. Stationary images
include onscreen menus, black bars, time displays,
etc. If you must use stationary images, reduce screen
contrast and brightness to avoid screen damage.
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Terms of Use TV

2015 © TP Vision Europe B.V. All rights reserved.

This product was brought to the market by TP Vision
Europe B.V. or one of its affiliates, hereinafter referred
to as TP Vision, which is the manufacturer of the
product. TP Vision is the warrantor in relation to the
TV with which this booklet was packaged. Philips and
the Philips Shield Emblem are registered trademarks
of Koninklijke Philips N.V.

Specifications are subject to change without notice.
Trademarks are the property of Koninklijke Philips N.V
or their respective owners. TP Vision reserves the right
to change products at any time without being obliged
to adjust earlier supplies accordingly.

The written material packaged with the TV and the
manual stored in the memory of the TV or
downloaded from the Philips website are believed to
be adequate for the intended use of the system.

The material in this manual is believed adequate for
the intended use of the system. If the product, or its
individual modules or procedures, are used for
purposes other than those specified herein,
confirmation of their validity and suitability must be
obtained. TP Vision Europe B.V. warrants that the
material itself does not infringe any United States
patents. No further warranty is expressed or implied.
TP Vision Europe B.V. cannot be held responsible
neither for any errors in the content of this document
nor for any problems as a result of the content in this
document. Errors reported to Philips will be adapted
and published on the Philips support website as soon
as possible.

Terms of warranty - Risk of injury, damage to TV or
void of warranty!

Never attempt to repair the TV yourself. Use the TV
and accessories only as intended by the
manufacturer. The caution sign printed on the back of
the TV indicates risk of electric shock. Never remove
the TV cover. Always contact Philips TV Customer
Care for service or repairs. Any operation expressly
prohibited in this manual, or any adjustments and
assembly procedures not recommended or
authorised in this manual, shall void the warranty.

Pixel characteristics

This LCD/LED product has a high number of colour
pixels. Although it has effective pixels of 99.999% or
more, black dots or bright points of light (red, green or
blue) may appear constantly on the screen. This is a
structural property of the display (within common
industry standards) and is not a malfunction.

CE compliance
This product is in compliance with the essential
requirements and other relevant provisions of
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Directives 2006/95/EC (Low Voltage), 2004/108/EC
(EMC) and 2011/65/EU (ROHS).

Compliance with EMF

TP Vision Europe B.V. manufactures and sells many
products targeted at consumers which, like any
electronic apparatus, in general have the ability to
emit and receive electromagnetic signals. One of
Philips’ leading Business Principles is to take all
necessary health and safety measures for our
products, to comply with all applicable legal
requirements and to stay well within the Electro
Magnetic Field (EMF) standards applicable at the
time of producing the products.

Philips is committed to develop, produce and market
products that cause no adverse health effects. TP
Vision confirms that, as long as its products are
handled properly for their intended use, they are safe
to use according to scientific evidence available
today. Philips plays an active role in the development
of international EMF and safety standards, enabling
Philips to anticipate further developments in
standardisation for early integration in its products.
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Terms of Use Smart
TV

You can see the terms of use, privacy policy, and also
set privacy settings of your Smart TV.

To open the terms of use of Smart TV page..

1- Press QO HOME to open the Home menu.
2 - Select gy Apps to open Apps.
3 - Select Support.
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Copyrights
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Ultra HD

The DIGITALEUROPE UHD Display Logo is a
trademark of DIGITALEUROPE.

232

HDMI

HuoIm

HIGH-DEFINITION MULTIMEDIA INTERFACE

HDMI®

The terms HDMI and HDMI High-Definition
Multimedia Interface, and the HDMI Logo are
trademarks or registered trademarks of HDMI
Licensing LLC in the United States and other
countries.

233

Dolby Digital Plus

DOLBY.
DIGITAL PLUS

Dolby®

Manufactured under license from Dolby Laboratories.

Dolby and the double-D symbol are trademarks of
Dolby Laboratories.
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234
DTS Premium Sound ™

DTS Premium Sound ™

For DTS patents, see http://patents.dts.com.
Manufactured under license from DTS Licensing
Limited. DTS, the Symbol, & DTS and the Symbol
together are registered trademarks, and DTS 2.0
Channel is a trademark of DTS, Inc. © DTS, Inc. All
Rights Reserved.

235

DLNA Certified®

(If applicable)

DLNA®, the DLNA Logo and DLNA CERTIFIED® are
trademarks, service marks, or certifi cation marks of
the Digital Living Network Alliance.

23.6
Microsoft

a8 Microsoft

Windows Media

Windows Media is either a registered trademark or
trademark of Microsoft Corporation in the United
States and/or other countries.

Microsoft PlayReady

Content owners use Microsoft PlayReady™ content
access technology to protect their intellectual
property, including copyrighted content.

This device uses PlayReady technology to access
PlayReady-protected content and/or WMDRM-
protected content. If the device fails to properly
enforce restrictions on content usage, content owners
may require Microsoft to revoke the device's ability to
consume PlayReady-protected content. Revocation
should not affect unprotected content or content
protected by other content access technologies.



Content owners may require you to upgrade
PlayReady to access their content. If you decline an
upgrade, you will not be able to access content that
requires the upgrade.
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Wi-Fi Alliance

Wi G}

CERTIFIED

Wi-Fi®, the Wi-Fi CERTIFIED logo, the Wi-Fi logo are
registered trademarks of the Wi-Fi Alliance.

238
Kensington

(If applicable)

i<

Kensington and Micro Saver are registered US
trademarks of ACCO World Corporation with issued
registrations and pending applications in other
countries throughout the world.

239

Other Trademarks

All other registered and unregistered trademarks are
the property of their respective owners.
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Index

3 DVD player 17

3D Backlight Contrast 46 DVD player, connect 17
3D, Health Warning 43 E

3D, Optimal Viewing 42 EasyLink HDMI CEC 55
A Eco Settings 55

Age Rat]ng 29 End Of use 107
Antenna connection 7 F

Antenna connection, Tips 11

Favourite Channels, remove 32
Favourite Channels, rename 32
Filter, channel list 28

Apps 39
Audio Out - Optical, tips 13
Audio Out Delay 16

Audio Out Format 15 G
Audio Out Levelling 15 Game Console, connect 17
Audio Out Offset 16 Game or Computer, setting 45
Audio Out Settings 15 Gamepad, connect 18
Audio to Video Sync 16 Gamma 48
Auto Surround 3D 50
Auto Volume Levelling 50 H
Automatic switch off 22 HbbTV 35

HDMI, ARC 11
B HDMI, DVI connection 12
Backlight Contrast 45 HDMI, EasyLink 11
Bass 50 HDMI, Ultra HD M
Batteries, remote control 26 Headphones Volume 51
Blu-ray Disc player, connect 16 Headphones, connect 17
Brightness, Philips Logo 21 Home Menu 27
C Home Theatre System, connect 15

Home Theatre System, Multichannel 15
Home Theatre System, problems 16
Home Theatre System, volume levelling 15

CAM, Conditional Access Module 13
Camcorder, connect 20

Channel 28

Channel List, about 28 |

Channel, agerating 29 Incredible Surround 50
Channel, Options 30 Incredible surround 3D 50
Channel, switch to a channel 29 Infrared sensor 26
Channel, TV guide 32 Interactive TV, about 34
Channels, watch two channels 44 Interactive TV, what you need 35
Child Lock 58 Internet memory, clear 9
Cl+ 13

Clear Internet Memory 10 |

Clear Sound 50 iTVvV 34

Colour 45

Colour, Colour enhancement 46 K
Colour, Colour temperature 46 Keyson TV 21
Colour, Custom colour temperature 47 L

Colour, Tint 46 Light Sensor 48
Common Interface Slot 13

Computer, connect 20 M

Connectivity Guide 1 Media files, from a computer or NAS 40

Contrast 45 Media files, from a USB drive 40

Contrast, 3D Video Contrast 46 Motion, Perfect Natural Motion 48

Contrast, Contrast Mode 47 MPEG Artefact Reduction 48

Contrast, Dynamic Contrast 47 Multi View 44

Contrast, Gamma 48

Contrast, Light Sensor 48 N

Contrast, Video Contrast 47 Network Installation 8

Create, favourite channel list 31 Network, Clear Internet Memory 10
Network, connect 8

D Network, settings 9

Digital Text 33 Network, Static IP 9

DMR, Digital Media Renderer 10 Network, Switch on Wi-Fi 10
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Network, TV Network Name 10
Network, View Settings 9
Network, Wi-Fi Smart Screen 10
Network, Wired 9

Network, Wireless 8

Network, WoWLAN 9

Network, WPS 8

Noise Reduction 48

Now on TV 36

O

On and Off 21

Open, channel list 28
Options on a Channel 30

P

Pairing the Remote Control 25
Parental Rating 29

Perfect Natural Motion 48

Philips Logo, Brightness 21

Photo camera, connect 19

Picture In Picture 44

Picture Style 45

Picture, Backlight Contrast 45
Picture, Colour 45

Picture, Picture format 48

Picture, Picture format, advanced 49
Picture, Picture format, basic 48
Picture, quick settings 49

Picture, Sharpness 45

Power connection 6

Programmes, Recommendations 36

R

Recording, TV Guide data 32

Red Button 34

Remote Control, accents and symbols 25
Remote Control, Azerty 25

Remote control, batteries 26

Remote Control, Cyrillic 25

Remote Control, keyboard 25

Remote Control, Pairing 25

Remote Control, Qwerty 25

Remote Control, Qwerty and Azerty 24
Remote Control, Qwerty and Cyrillic 24
Remote Control, uppercase 25

S

Safety instructions 113

Satellite connection 7

SCART connection, tips 13
Search, channel list 28

Set Top Box, connect 14
Sharpness 45

Sharpness, MPEG Artefact Reduction 48
Sharpness, Noise reduction 48
Sharpness, Ultra Resolution 48
SimplyShare (computer or NAS) 40
Sleep Timer 21

Smart Card, CAM 13

Sound Style 49

Sound, Auto Surround 3D 50
Sound, Auto Volume Levelling 50
Sound, Bass 50

Sound, Clear Sound 50

Sound, Headphones Volume 51
Sound, Incredible surround 3D 50
Sound, surround mode 50

Sound, Treble 50
Standby 21
Surround Mode 50
Switch Off Timer 22
Switching On 21

Synchronise Audio and Video 16

T
Teletext 33
Text 33
Treble 50
TV Guide 32

TV Guide, data and information 32

TV network name 9
TV on Demand 36
TV placement 6

U

Ultra HD, Connection M

USB Flash Drive, connect 19
USB Hard Drive, connect 18
USB Hard Drive, disk space 18
USB Hard Drive, Installation 18
USB Keyboard 19

USB Keyboard, connect 19

\

Video on Demand 37
Video Selection 31
Viewing distance 6

W

Watch TV 29

Wi-Fi 8

Wi-Fi Smart Screen 10
Wired Network 9
Wireless Network 8
WoWLAN 9

Y
YPbPr connection, tips 13

120



>

User Man

ual FAQ Chat Forum Call Email Warranty

www.philips.com/support

Bbvarapusa

[pua 3a KNneHTa

02 4916 273
(HaumoHaneH Homep)

Belgié/Belgique
Klantenservice/

Service Consommateurs
027007262
(0.15€/min.)

Bosna i Hercegovina
Potpora potrosacima
033 941 251

(Lokalni poziv)

Republika Srbija
Potpora potrosacima
0113216840
(Lokalni poziv)

Ceska republika
Zakaznicka podpora
228 880 895
(Mistni tarif)

Danmark
Kundeservice
3525 8314

Deutschland
Kundendienst

069 66 8010 10

(Zum Festnetztarif ihres
Anbieters)

EAAGSa

TUAKO KOTOVOAWTWY
2111983028
(AleBvAg KAfion)

Eesti

Klienditugi

668 30 61
(Kohalikud kéned)

Espana

Atencion al consumidor
913 496 582

(0,10€ + 0,08€/min.)

w e

France Malaysia Slovenija
Service Consommateurs Consumer Care Skrb za potrosnike
0157324050 1800 220 180 01 88 88 312
(colt d’un appel local sauf (Lokalni klic)
surcolt éventuel selon Nederland
opérateur réseau) Klantenservice Slovensko
0900 202 08 71 Zakaznicka podpora
Hrvatska (1€/gesprek) 0233215493
Potpora potrosacima (vnutrostatny hovor)
01777 66 01 Norge
(Lokalni poziv) Forbrukerstotte Suomi
22971914 Finland Kuluttajapalvelu
Indonesia 09 88 6250 40
Consumer Care Osterreich
0800 133 3000 Kundendienst Sverige
0150 284 2140 Kundtjanst
Ireland (0,05€/Min.) 08579290 96
Consumer Care
01524 54 45 Pecny6suka benapycb Tiirkiye
(National Call) KoHTaKT LleHTp Tiketici Hizmetleri
810 (800) 2000 00 04 0850 222 44 66
Italia (6ecnnaTHbI 3BOHOK NO
Servizio Consumatori Pecny6auke benapych co YKpaiHa
0245287014 CTaUMOHapPHbIX HOMepOoB) Cny6a NiaTpumKm
(Chiamata nazionale) CNOXKMBaYiB

KasakcraH Pecny6amkacbl
6alinaHbiC opTasblFbl
810 800 2000 00 04

Poccuiickana Pepepauma
KoHTakT UeHTp

8 (800) 220 00 04
(6ecnnaTtHbIi 3BOHOK MO

0-800-500-480
(A3BiHKM 3i cTauioHapHMX
TenedoHiB 6€3KOLITOBHI)

(cTaumoHapnbIK HeMipaepaeH Poccun) United Kingdom
KasakcrtaH Pecnybamnkacol Consumer Care
60MbIHIWA KOHbIPAY Wasly TeriH) Polska 02079490319
Wsparcie Klienta (5p/min BT landline)
Latvija 223971504
Klientu atbalsts (Potaczenie lokalne)
6616 32 63
(Vietéiais tarifs) Portugal Argentina
Assisténcia a clientes Consumer Care
Lietuva 800780 068 0800 44477 49
Klienty palaikymo tarnyba (0,03€/min. — Movel - Buenos Aires
852140293 0,28€/min.) 0810 444 7782
(Vietinais tarifais)
Romania Brasil
Luxembourg Serviciul Clienti Suporte ao Consumidor
Service Consommateurs 031630 00 42 0800 70102 45
24871100 (Tarif local) - Sao Paulo
(Appel nat./Nationale Ruf) 29380245

Schweiz/Suisse/Svizzera

Magyarorszag Kundendienst/ Service
Ugyfélszolgalat Consommateurs/Servizio
(061) 700 8151 Consumatori

(Belfoldi hivas) 0848 000 291

(0,04 CHF/Min)

All registered and unregistered trademarks are property of their respective owners.
Specifications are subject to change without notice. Philips and the Philips’ shield
emblem are trademarks of Koninklijke Philips N.V. and are used under license from
Koninklijke Philips N.V. 2015 © TP Vision Europe B.V. All rights reserved.
philips.com
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